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Main Overview
Welcome to PinPoint, an information collection and analysis package designed to allow you to extract 
and present meaningful facts and conclusions about information.

In some ways, PinPoint may be described as a database - it allows you to store information and recall 
that information for inspection in the way that databases have done before. However, PinPoint goes 
beyond simple storage and retrieval of information. Simple storage and retrieval doesnt tell you much 
about the information you hold. Whilst possible, it is difficult to ascertain facts such as how many 
people in the database fall into certain age ranges, how many days were there more than 5 hours 
sunshine in each month of the year, this year as against last year, how popular are your products? 
PinPoint is designed to answer questions such as these, and far more complex ones, and to present 
the results in interesting ways.

PinPoint can be used on its own to design a questionnaire or data collection sheet, enter collected 
information and analyse the information. Or it can complement any existing database applications you 
possess. Information can be imported from another application, such as a fully relational database, 
and then analyses performed.

What does PinPoint do?
Within PinPoint the information you need can be quickly and precisely collected and compiled into a 
database. Your information can then be rapidly ordered and analysed in many different ways to 
indicate correlations, patterns and trends, and from these analyses hypotheses can be framed and 
quickly tested and statistics derived. 

Results can be summarised in report form or graphically in graph, chart and table format, and your 
final analyses presented (making use of PinPoint's fully-fledged Windows WYSIWYG attributes) on 
screen or in print.

In PinPoint you work in familiar settings, using easily understood terms and procedures written in plain 
English. There is no arcane language to learn, and no programming is required in order to obtain 
results which can be both useful and applicable to your business, profession or project.

Navigating through PinPoint
There are four main areas in which you will work on a PinPoint 'project'. These are

Form Design and Editing.
Form Filling.
Information Analysis.
Production and Presentation of Graphs, Charts and Tables.

Form Design and Editing
Every new PinPoint project begins with the design of its 'form', or data collection sheet. PinPoint 
makes form design easy. The questions to which you need answers are written in plain English on an 
electronic piece of paper.

You have no need to be an 'expert' form designer, nor do you need to understand complex datafile 
structures to produce a well presented and workable form.

Once designed a form may be printed for use as a 'questionnaire' or for other data collection. There is 
a form at the core of every PinPoint project.

Form Filling
A completed or 'filled in' copy of a form is known in PinPoint as an 'answer sheet'. During answer sheet
compilation a copy of the form is always displayed on screen. Answers can be entered directly onto 
the screen by your respondents, or else answer data can be 'copied in' from a collection of completed 



paper forms.

Because PinPoint's forms can contain many question 'formats' together with free-form text notes and 
built-in data entry checks, precise information can entered quickly and accurately.

Information Analysis
A completed set of answer sheets is known as a 'stack'. When a stack of answer sheets has been 
compiled the sheets are placed into a 'worksheet' for analysis.

PinPoint's worksheets provide the tools for displaying completed answer sheets in tabular form; sorting
and selecting the sheets; performing statistical analyses; creating reports; and the production of 
graphs, charts and tables.

You can add new answer sheets to a stack, and edit or 'update' a project's form and any existing 
answer sheet(s) at any time.

Production and Presentation of Graphs, Charts and Tables
Whilst many interesting patterns may emerge from the 'raw' information displayed in worksheet format,
other interpretations may only become apparent when the data is further tabulated or presented 
graphically in some way.

PinPoint incorporates a powerful cross-tab generator and provides a wide choice of chart types and 
graphing options with which to present information for maximum clarity and impact.

All the same WYSIWYG drawing tools and controls as are used in form design are available to you in 
the Presentation Editor.

The Project
PinPoint stores all project information - the form, the completed answer sheets, the worksheet and all 
its attributes and any associated graphical presentations - in a single ".ppf" project file.

Copying a project from one machine to another, therefore, is just a matter of copying a single project 
file into an existing PinPoint installation.

More Help

You will find a more detailed description of each of PinPoint's work areas in the section Overviews. 
Click the Help window "Back" button to return to the Main Contents page.



 Using PinPoint Help
PinPoint is a powerful application and is very easy to learn and use, although you might find that a 
browse through Help's 'Main' and 'Area' Overviews could be informative in any event. 

But there may come a time when you get stuck (or become 'temporarily unsure of a procedure') and 
will need to access the Help system in earnest. You can do this in three ways:

Press the F1 key from any PinPoint window
Press the F1 key to go directly to the Overview of the area in which you are currently working.

Select the Help menu from any PinPoint window
Choose a command from this menu to go to

The Main Contents page. From there you can choose to go to any of the Overview pages and 
from those to detailed descriptions of procedures, menus or tools.

An Overview of the area in PinPoint in which you are currently working.
Or one or two other topics of immediate relevance.

Press the Help button in many dialogue boxes
Choose the Help button, or press F1, if you need context-specific Help on the dialogue box in 
question. You will be taken directly to the relevant page in the Help file. Most dialogue box Help pages 
contain links to other related topics.

Navigating through PinPoint Help
PinPoint Help is a Windows application, so you can use all the standard Windows techniques to move,
resize and close the Help window. For more information about all the features included in the Windows
Help system, press the F1 key from PinPoint Help's Main Contents page. When you have finished 
reading the Windows Help instructions, click the Help window "Back" button to return to the Main 
Contents page.

Using Jumps and Popups

Click on words with a solid or dotted underline to 'jump' to the Help topic they name, or to display a 
'pop up' definition of that word or phrase. 

Using Help Icons
 This icon appears 'embedded' in text throughout PinPoint's Help system. It indicates a reference to a 

related topic and is simply a graphical alternative to the usual underlined green text. Click on the 
arrowhead icon to perform the 'jump'.

The 'Tools' pages and some dialogue box pictures also contain invisible jump 'hotspots'. Move the 
mouse pointer over a picture and click when the pointer turns into a Hand.



 What's New in v3.00
PinPoint for Windows v3.00 contains the following new features and enhancements:

Click on a button for detailed information.

Pointer Tool

The hand tool has been removed from all the page editors.    The pointer tool now works in the way 
the hand used to for selecting objects - however, during marquee selections only objects entirely 
within the bounding rectangle are selected.

Editing objects

Right-clicking an object will display a menu containing copy, cut, and paste commands and property
commands for editing the selected objects.

What's new - Forms Design 

What's new - Worksheet 

What's new - Graphing and Cross-tabulations 

View states

Any paper view may be zoomed to fit sideways.

The current view state is saved with the paper (form or graphics results presentation), including 
presence of rulers, guides and grids and the current view scale.

Options 



What's new: Forms Design
The page limit is now 19 pages of standard A4 paper.

Automatic question numbering

Insert paper tool 

Publishing Forms 

Writing Questions

Writing tables of questions 

Choice answers:

With the tick box on right, the associated text can be justified to the box rather than left justified.

Tick boxes can be numbered.

A score can be defined for each choice which can then be used in calculations.

The entry order may be by row or by column.

Carry over values 

Routing

Groups 

Calculations

The following new functions are available:
DayName(value)/ShortDayName(value)
MonthName(value)/ShortMonthName(value)
WorkDay(startDate,days)
Score(anAnswer)
SumScores(firstAnswer,lastAnswer)
NumScores(firstQuestion,lastQuestion)
SumNumbers(firstAnswer,lastAnswer)
NumNumbers(firstQuestion,lastQuestion)
Trunc(value)
SheetNumber()
Length(string)
Left(string,num)
Mid(string,startat,num)
Right(string,num)

Please see the release notes for additional information.





What's new: Worksheet
Click on a button for detailed information.

The worksheet is now always 'open' - however you switch from worksheet to answer sheet view. This 
means that searches and browsing uses only those sheets currently shown on the worksheet, in the 
order they are displayed on the worksheet. (For v1.xx this only occurred when editing a sheet by 
double clicking on it).

Question groups and tables.

The worksheet makes use of question groups and tables. Groups and tables are indicated by an 
extra title area. Groups and tables can be moved, removed and put back as one - by use of groups 
and tables the worksheet may now be re-configured very quickly. You may not move a question out 
of its group or table (the whole group or table will move), but may re-order questions within groups 
and tables.

Dialogues

All dialogues show the questions in alphabetical order, you may type the name rather than having 
to select it and you may choose to show only 'active' questions or all.

Choosing sheets. This dialogue now allows multiple criteria to be defined and/or edited.

Edit menu 

Statistics

The additional statistics Lower quartile, upper quartile, interquartile range and deciles are now 
available.

Saving and loading of Worksheet configurations 

Printing the worksheet

Oversized worksheets may now be either scaled to fit or tiled.



What's New: Graphing and Cross-tabulations
Click on a button for detailed information.

Simple Table style

The column titles may now be changed and statistics calculated on the rows of the table.

Many enhancements are provided to enable complex graphs comparing analyses of the answers to 
different questions or sub-sets of sheets to be performed quickly.

Plot Graph

Choosing sheets during the plot

Vary by plotting 

Plot Graph from Question Table 

Quick Analysis 

Cross-tabulations

Percentages calculated on row and column basis can both be displayed on cross-tabulations.





The Form: Overview
Click on a button to bypass this Overview and go to:

How to...

Tools

Form Editor menus

Overview
In any information collection and analysis activity one of the most difficult tasks is deciding upon the 
data to be collected. Careful consideration of the data or questions to ask will enable you to collect the 
data required correctly or to elicit the required responses and provide the opportunity for meaningful 
analysis and conclusions. In no application of computer software is the adage Garbage in - garbage 
out more pertinent than an application such as this. 

With typical applications, one would start out by sketching out one's requirements on paper. With 
PinPoint this is not necessary since it, itself, provides the pencil and paper.

Every new PinPoint project begins with the design of its 'form', or data collection sheet. PinPoint 
makes form design easy. The questions to which you need answers are written in plain English on an 
electronic piece of paper.You have no need to be an 'expert' form designer, nor do you need to 
understand complex datafile structures to produce a well presented and workable form.

The Form Editor
When you work with a form in PinPoint you work with the Form Editor. The Editor can be thought of as 
a 'window' onto a form in which you can 

Format the page attributes of your form.
Easily set up a multi-page form.
Quickly write and edit questions in plain English.
Place and lay out pictures, graphic elements and 'free-form' text, and link and embed OLE 

objects, anywhere on your form.
Prepare your form for printing.
Import answer data from other PinPoint projects or other applications.
Edit an existing project's form and update the completed answer sheets in its stack.
'Send' a new form to the sheet editor for completion as the first answer sheet in a new stack.

Tool Tidy buttons 'automate' most of these operations and they, together with PinPoint's powerful 
WYSIWYG drawing tools and controls, make for fast and precise form design and editing.



Form Editor: Menus
Click on any button to see a list of  menu items.

File menu

Edit menu

View menu

Questionnaire menu

Arrange menu

Window menu

Hint: Wherever you are in PinPoint you can see a brief description of any menu title or item by holding down the 
left mouse button and moving the pointer over your choice.

A Quick  Help message will appear in the status bar window at the bottom left of your screen.



Form Editor: File menu

File menu  

New Project

Open...

Save Form

Save Form As New Project...

Publish Form 

Import...

Print Form...

Printer setup...

Exit Alt + F4

Work history



Form Editor: Edit menu

Edit menu  

Undo

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Paste Link

Insert object...

Delete Shift + Del

Select all Ctrl + A

Clear

Links...

Object



Form Editor: Questionnaire menu

Questionnaire menu  

Make a question group

Number questions

Show routing

Paper setup

Add page

Delete last page



Form Editor: View menu

View menu  

Horizontal ruler

Vertical ruler

Grid...

Show printable area

Zoom...

Answer Sheets

Options 



Form Editor: Arrange menu

Arrange menu  

Align

Bring to front Ctrl + =

Send to back Ctrl + -

Group Ctrl + G

Ungroup Ctrl + U

Snap to grid

Show guidelines



Form Editor: Window menu

Window menu  

Tile

Cascade

Arrange Icons

Close All

Work in progress





Answer Sheets: Overview
Click on a button to bypass this Overview and go to:

How to...

Tools

Sheet Editor menus

Overview
A completed or 'filled in' copy of a project's form is known in PinPoint as an 'answer sheet'. A collection 
of completed sheets is known as a 'stack'.

Answer sheets are completed by entering data or choosing the values from an on-screen copy of the 
form. Data is entered into sheets:

Directly onto the screen.
Or it is copied in from a collection of completed paper forms.
Or it can be imported from other PinPoint projects or other applications. Imported data records 

can be 'mapped' to your project's form and then appended to the stack as a set of additional answer 
sheets.

Order of Entry

The order of entry of answers is determined automatically from the location of the answer entry areas 
on the page, from left to right and down the page.

The Sheet Editor
When you work with answer sheets in PinPoint you work with the Sheet Editor. The Editor can be 
thought of as a 'window' onto a stack of answer sheets. In it you can add new sheets to a stack, locate 
specific answer sheets and edit or 'update' existing sheets.

For speed and ease-of-use, the Sheet Editor's Tool Tidy buttons 'automate' many sheet editing and 
location operations.

The benefits of Good Design
Because the answer sheet 'interface' is based on the familiar concept of a form, the process of 
completing an answer sheet is easily understood. However some additional thought at the form design
stage can help to promote accurate data entry. PinPoint's forms can contain

Many formats of question and answer types, including ordered and multiple choice answers.
Free-form text notes (which can include training notes on data entry, special exemptions, data 

entry procedures and the like).
Pictures and graphic images.
Built-in checks to ensure that answer data is entered when and where required.

These attributes, used judiciously in combination with the power of PinPoint's sheet editing controls, 
will ensure that information can be entered and a stack of completed sheets compiled both easily and 
quickly.

More Help
To see a more detailed description of any of the procedures, tools and menu commands used when 
working with PinPoint's answer sheets and stacks, click on a button at the top of this page.



Sheet Editor: Menus
Click on any button to see a list of  menu items.

File menu

Edit menu

View menu

Sheet menu

Window menu

Hint: Wherever you are in PinPoint you can see a brief description of any menu title or item by holding down the 
left mouse button and moving the pointer over your choice.

A Quick  Help message will appear in the status bar at the bottom left of your screen.



Sheet Editor: File menu

File menu  

New Project

Open...

Import...

Print sheet...

Printer setup...

Exit Alt + F4

Work history



Sheet Editor: Edit menu

Edit menu  

Undo

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Paste Link

Insert object...

Delete Shirt + Del

Select all Ctrl + A

Clear

Bring to front Ctrl + =

Send to back Ctrl + -

Links...

Object



Sheet Editor: View menu

View menu  

Show printable area

Zoom...

Form

Worksheet

Options 



Sheet Editor: Sheet menu

Sheet menu  

Save Ctrl + S

New

Copy

Delete

Next Ctrl + N

Previous Ctrl + P

First Ctrl + F

Last Ctrl + L

Turn to...

Search...

Show routing

Worksheet



Sheet Editor: Window menu

Window menu  

Tile

Cascade

Arrange Icons

Close All

Work in progress





Analysis Worksheets: Overview
The Worksheet for a project is displayed whenever a project folder containing answer sheets is 
opened.

Click on a button to bypass this Overview and go to:

How to...

Tools

Worksheet menus

Overview
Once you have entered all your information, or quickly imported it from another application, the 
Worksheet presents a list of all the Answer Sheets in your Project. The answers to each of the 
questions on each of the sheets are shown in tabular form.

The worksheet is a flexible and efficient environment in which you can investigate your information to 
draw meaningful conclusions. It provides the tools to view the data as a whole, sort it, identify and 
correct anomalies, choose those sheets matching single or multiple conditions and perform a range of 
statistical analyses.

Cross tabulations and Graphs of results can be created and printed directly from PinPoint. Alternatively
they may be copied to another application, such as a word processor, for inclusion in a report. Answer 
Sheets and analysis results may also be copied to the clipboard and pasted into other applications for 
further analysis.

More Help
To see a more detailed description of any of the procedures, tools and menu commands used when 
working with PinPoint's analysis worksheets, click on a button at the top of this page.



Analysis Worksheets: Menus
Click on any button to see a list of  menu items.

File menu

Edit menu 

View menu

Tools menu

Window menu

Hint: Wherever you are in PinPoint you can see a brief description of any menu title or item by holding down the 
left mouse button and moving the pointer over your choice.

A Quick  Help message will appear in the status bar at the bottom left of your screen.



Analysis Worksheets: File menu

File menu  

New Project

Open...

Open presentation...

Save Sheets As...

Save Setup as Default...

Import...

Print Sheets With Form

Print Worksheet...

Printer setup...

Exit Alt + F4

Work history



Analysis Worksheets: View menu

View menu  

Font

Show Printable Area

Put back

Answer Sheets

Options 



Analysis Worksheets: Tools menu

Tools menu  

Sort sheets

Add condition

Remove conditions and sorting

Statistics

Add new column

Plot graph

Plot Graph From Question Table

Quick Analysis

Generate cross-tabs

Load/Save Setups



Analysis Worksheets: Window menu

Window menu  

Tile

Cascade

Arrange Icons

Close All

Work in progress





Graphics Presentation: Overview
Click on a button to bypass this Overview and go directly to:

How to...

Tools

Presentation Editor menus

Overview
The aim of presenting data pictorially is to communicate information clearly and with impact.

PinPoint's cross-tab generator and graphing engine are very powerful and, if properly used, can 
produce a great variety of detailed 'views' of information which may not be not easily visible from 'raw' 
worksheet data alone. 

Once produced, graphs and tables can be edited quickly and easily, and then further enhanced with 
text, images, lines, arrows, bitmaps and OLE objects for maximum clarity and relevance.

The Presentation Editor
When you work with graphs, charts and tables in PinPoint you work with the Presentation Editor. The 
Editor can be thought of as a 'window' onto your electronic page in which you can

Format your presentation page.
Easily set up a multi-page presentation.
Quickly plot, edit and compile graphs and charts and generate tables.
Place pictures, graphics, OLE objects and 'free-form' text anywhere in your presentation.
Prepare your presentation for printing or for export to another PinPoint project or another 

Windows application.
Save your presentation, with its originating project, for working on again at a later date or for 

future reference.

The flexibility and power of PinPoint's table generator and graphing engine, in combination with all the 
same WYSIWYG drawing tools and controls as are available in the form design Area, will very quickly 
allow you to assemble, test and present clear and intelligible graphical results.

More Help
To see a more detailed description of any of the procedures, tools and menu commands used when 
working in PinPoint's graphics presentation Area, click on a button at the top of this page.



Presentation Editor: Menus
Click on any button to see a list of  menu items.

File menu

Edit menu

View menu

Paper menu

Arrange menu

Window menu

Hint: Wherever you are in PinPoint you can see a brief description of any menu title or item by holding down the 
left mouse button and moving the pointer over your choice.

A Quick  Help message will appear in the status bar window at the bottom left of your screen.



Presentation Editor: File menu

File menu  

New Project

Open...

Open Presentation...

Delete this Presentation

Save Presentation

Save Presentation As...

Print Presentation...

Printer setup...

Exit Alt + F4

Work history



Presentation Editor: Edit menu

Edit menu  

Undo

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Paste Link

Insert object...

Delete Shirt + Del

Select all Ctrl + A

Clear

Links...

Object



Presentation Editor: View menu

View menu  

Horizontal ruler

Vertical ruler

Grid...

Show printable area

Zoom...

Options 



Presentation Editor: Paper menu

Paper menu  

Paper setup...

Add page

Delete last page



Presentation Editor: Arrange menu

Arrange menu  

Align

Bring to front Ctrl + =

Send to back Ctrl + -

Group Ctrl + G

Ungroup Ctrl + U

Snap to grid

Show guidelines



Presentation Editor: Window menu

Window menu  

Tile

Cascade

Arrange Icons

Close All

Work in progress





Page Editors and Tools: Overview
Page editor and tool buttons are used extensively throughout PinPoint. Some are unique, others 
provide a useful shortcut to clicking through menu items.The Tool Tidy's contents will change to reflect 
the options available to you in each area.

Click on any button to see a description of its use and function.

Note that a button which appears dimmed or "greyed" is not available for use - you may need to select
another item before using this command.

Hint: Wherever you are in Pinpoint just move the cursor over any button in the Tool Tidy to see a brief description 
of its function appear in the secondary window at the bottom left of your screen.



Form Editor: Tool Tidy
The Tool Tidy looks like this whenever a Form Editor window is 'active'.

Click on any button to see a description of its use and function.

Note that a button which appears dimmed or "greyed" is not available for use - you may need to select
another item before using this command.



Sheet Editor: Tool Tidy
The Tool Tidy looks like this whenever a Sheet Editor window is 'active'.

Click on any button to see a description of its use and function.

Note that a button which appears dimmed or "greyed" is not available for use - you may need to select
another item before using this command.



Analysis worksheets: Tool Tidy
The Tool Tidy looks like this whenever a Worksheet window is 'active'.

Click on any button to see a description of its use and function.

Note that a button which appears dimmed or "greyed" is not available for use - you may need to select
another item before using this command.



Graphics Editor: Tool Tidy
The Tool Tidy looks like this whenever a Graphics Editor window is 'active'.

Click on any button to see a description of its use and function.

Note that a button which appears dimmed or "greyed" is not available for use - you may need to select
another item before using this command.



The Pen
The Pen is used to write and edit text on PinPoint's 'electronic' pages. Click on the Pen to pick it up.

To set the Pen style, double-click on the Pen to open its  style dialogue box. The Pen can write in any
font that is available on your currently selected printer in the size, style and colour of your choice. 
However, to achieve the closest approximation to how the text appears on the screen and how it will 
appear when printed, you shuold restrict the fonts you use to TrueType fonts or those supplied by 
some other suitable utility such as ATM.

To write and edit text
Click the Pen to place the edit cursor on the page and type in your text.

To move around the text: Use the ARROW KEYS to move one character or line at a time. Hold 
down CTRL and use the ARROW KEYS to move a whole word at a time.

To overwrite text: Press INSERT and type the new text which will overwrite the current text. To 
start inserting text again, rather than overwriting, press INSERT again.

To delete a character: Press DELETE to delete the character in front of the caret, or 
BACKSPACE to delete the character behind the caret.

To delete a block of text: Hold down SHIFT and use the arrow keys to move backwards or 
forwards through the text highlighting it, then press CTRL+X or SHIFT+DEL (or from the Edit 
menu, choose Cut or Delete).

To cut or copy a block of text: Hold down SHIFT and use the arrow keys to move backwards or
forwards through the text highlighting it, then press CTRL+X or CTRL+C (or from the Edit 
menu, choose Cut or Copy).

To paste text on clipboard: With text on the clipboard, press CTRL+V.

Tip
You can also select text to cut or copy by clicking at the start of the block to cut or copy and 
dragging to the end of the block.

Reformatting Text

When text is written, it continues on a single line until you press ENTER or reach the edge of the 
paper. 

Further text will then be formatted between these left and right margins (the left margin is where you 
started to write text, the right margin where you pressed ENTER).

Text can be reformatted between different margins by selecting the text object with the  Pointer tool 
and then dragging one of the resize handles.

To alter the style of text

To change the style of a single piece of text, double click on the text to open the Pen style dialogue, 
make the changes required and click the OK button.

To change the style of several pieces of text, select each of the pieces of text with the  Pointer tool, 
then choose the command 
 Text Style from the Edit menu.

Question and graph label text
Question and graph label text can be edited in the same way as any other text on the page, as an 
alternative to use the style dialogue for the whole object. However, please note that, in the case of 
graph label text, the changes will be lost if any other modifications are made to the graph.



Quick tool selection:    F3



The Question Tool
The Question tool is an essential part of PinPoint. It is used during form design to 'write' and edit 
questions, and has no equivalent elsewhere. Click on the tool to pick it up.

To write a question
Pick up the Question tool and drag-select the approximate page area that the question is to occupy.

Release the mouse button and the  Question dialogue box will open.
To edit a question

Pick up the Question tool and double-click on the selected question. The Question dialogue box will re-
open.

Click  here for more detailed information on writing and editing questions and the use of the Question 
tool.

Quick tool selection:    F2



The Question Table Tool
The Question Table tool is used to ............. Click on the tool to pick it up.

To do something
Body text.................................

ref to a dialog boxbmc a_head2.bmp} Copy question dialogue will appear for each of the copied 
questions.

To do something
Body text.................................

To do something
Body text.................................

Quick tool selection:    put it here if there is one



The Rectangle Tool
The Rectangle tool is used to draw backgrounds and borders on the page.

Double-click on the Rectangle tool to open its style dialogue box. Rectangles may be drawn
Unfilled, or filled in a choice of colours.
With or without borders of variable line 

 weights and colours.
With square or variably-rounded corners.

To draw a rectangle
Click on the Rectangle tool to pick it up. Drag-select the area that the rectangle is to occupy. Release 
the left mouse button and a rectangle will appear on-screen in the style you have chosen.

To change a rectangle's style
Double click on it with the Rectangle tool. The Rectangle style dialogue box will re-open.

Quick tool selection:    F4



The Pencil
The Pencil is used to draw lines and arrows on PinPoint's 'electronic' pages.

Double-click on the Pencil to open its style dialogue box. Lines may be drawn
As solid, dotted, dashed or dot-dashed in various 

 weights and colours.
With or without arrowheads of varible head lengths and widths.
As arrows with or without outlines of variable line 

 weights and colours.

To draw a line
Click on the Pencil to pick it up. Drag it from the point at which the line is to begin. If you have chosen 
to draw an arrow, the arrowhead will appear when you release the left mouse button.

To change a line's style
Double click on it with the Pencil. The Line style dialogue box will re-open.

Quick tool selection:    F5



The Pointer
The Pointer is the one you will use most often, to move objects around the page or resize objects. For 
example, when designing a questionnaire, you may decide that one question should come after 
another. In this case, simply use the Pointer Tool to move the questions until they are in the correct 
order.

The Pointer Tool is also used to select objects for further editing, such as copying to the clipboard, 
grouping objects or changing properties.

Finally the Pointer Tool can be used as a quick method of copying objects, rather than using Cut and 
Paste facilities.

Selecting an object

To select an object, pick up the Pointer Tool and click on the object. It is then shown as selected by 
being surrounded by 'resize handles'.

When objects on the page overlay with each other, clicking in this way will select the topmost of the 
overlapping objects.

To select an object in the background, double click.
To select an object on the next layer down, double click again.

By continuing to double click you will select the object behind the selected object until you reach the last 
level. Once the bottom is selected, double clicking again returns you to the top object.

Resizing an object

You may draw an object or paste objects from other applications and then find that the size is not quite
right. To resize an object, point to one of the resize handles. The cursor changes into a two way arrow 
when the Pointer is over resize handles. Then drag until the outline box is the desired size.

Note: Not all objects can be resized in this way. The size of some objects is determined by their 
definition, for example, an answer area for a question. If an object cannot be resized using the Pointer 
Tool, the resized handles are greyed out. To resize such objects, double click on the object with the 
appropriate tool.

Clearing the selection

To deselect all the selected objects either 
 Click anywhere on the paper not on an object, or
 Select Clear from the Edit menu.

Selecting multiple objects

Selecting a new object automatically deselects any previously selected object. However, you may 
select several objects at one time in one of three ways:
 After selecting the first object, select additional objects by 'shift clicking', i.e. holding down the Shift key 

while you click the mouse. Shift clicking on an object a second time deselects it.
 Drag the Pointer Tool to surround all the objects to be selected. Any objects that lie completely within 

the dragged out area will be selected.
 Choose Select All from the Edit menu. This selects all the objects on the paper, whether they are 

visible or not.

Moving objects

To move objects around the page:

1. Select the objects to be moved.



2 Drag any one of the selected objects.

Outline boxes of the selected objects will move as you drag to indicate where the objects will appear 
when released.

3. When you reach the requires position, release the mouse.

Tip. When the mouse pointer nears the edge of the window, the window automatically scrolls to bring 
hidden areas of the paper into view. Alternatively, before dragging, scale down the view so that the 
whole page is visible.

Copying objects

To copy objects to other applications, you must use the standard method of Cut/Copy and Paste, either
from the Edit menu, or the right hand mouse button pop-up menu. However, if you only wish to make a
copy of some objects on the page, the Pointer Tool can be used:

1. Select the items to be copied.

2 Hold down the CTRL key and drag the objects to a new position.

3 Release the mouse button; the selected objects are then copied to the new position.

Note: When copying questions, you will be asked for the new text and reference name for each 
question before it is copied.

Quick tool selection:    F7



The Stack Tool
The Stack tool switches your view of your project to the individual answer sheets.

From a Worksheet window
Click the Stack tool to return to the Sheet Editor window. The first sheet of the current stack will be 
displayed.

From a Form Editor window
Click the Stack tool to

Save a new form and open a Sheet Editor window onto the first (blank) sheet of a new stack    OR
Save an amended form and open a Sheet Editor window onto the first sheet of an existing stack.
Before saving the form's changes PinPoint will prompt you to confirm, twice, that you wish to  

update all the answer sheets in the project's stack.

See also:
 Alter form
 Save







The Eraser
The Eraser is the visual accelerator for the Edit menu  "Delete" command. Click on the Eraser to pick it up.

Double-click on an item with the Eraser pointer to remove it from your work area without copying it to the Windows 
Clipboard. Use of the Eraser will not affect the current contents of the Clipboard.

Quick tool selection:    F9

Keyboard shortcut:    Shift + Del



The Scissors
The Scissors tool is the visual accelerator for the Edit menu  "Cut" command.

Click the Scissors to remove selected items from the page and store them in the Windows Clipboard.

Keyboard shortcut:    Ctrl + X



Paste
The Paste tool is the visual accelerator for the Edit menu  "Paste" command. Click the tool to paste the 
contents of the Windows Clipboard into your work area.

Keyboard shortcut:    Ctrl + V



The Camera
The Camera tool is the visual accelerator for the Edit menu  "Copy" command. Click the Camera to copy 
duplicates of selected items onto the Windows Clipboard and leave the original elements intact.

Keyboard shortcut:    Ctrl + C



Previous sheet
This button is the visual accelerator for the Sheet menu  "Previous" command.

Click the tool from a Sheet Editor window to turn to and display the previous sheet in the current stack.

Keyboard shortcut:    Ctrl + P



Next sheet
This button is the visual accelerator for the Sheet menu  "Next" command.

Click the tool from a Sheet Editor window to turn to and display the next sheet in the current stack.

Keyboard shortcut:    Ctrl + N



Tear Off
The Tear Off button is the visual accelerator for the Sheet menu  "New" command.

Click the tool from a Sheet Editor window to 'tear off' and display a blank form ready for completion.



Delete sheet
This button is the visual accelerator for the Sheet menu  "Delete" command.

Click the tool from a Sheet Editor window to delete the answer sheet currently on display. PinPoint will prompt you to 
confirm your choice.



Alter form
This button is the visual accelerator for the Sheet menu  "Alter form" command.

Click the tool in a Sheet Editor window to return a project's form to the Form Editor for review and amendment.
Note: Before saving changes to an amended form PinPoint will prompt you to confirm, twice, that you wish to  
update all the answer sheets in the project's stack.



Save sheet
This button is the visual accelerator for the Sheet menu  "Save" command. 

Click the button from a Sheet Editor window to save the answer sheet you are currently completing or editing.

Keyboard shortcut:    Ctrl + S    or    Press RETURN at the last field in the form



Pushdown
The Pushdown tool is the visual accelerator for the Edit and Arrange menus  "Send to back" command. Click 
on the tool to pick it up.

To select an item to push down (i.e. to send to the back) amongst several that are overlapping, click on each in 
succession with the Pushdown pointer until every element is layered as required.

Quick tool selection:    F7

Keyboard shortcut:    Ctrl + -



Tools
Page editor and tool buttons are used extensively throughout PinPoint. Some are unique, others provide a 
useful shortcut to clicking through menu items. 

The Tool Tidy's position on the screen can be changed by choosing  Options from the View menu.
For an overview of PinPoint's tool and page editor buttons, see  Tools Overview



Quick Help
Quick Help messages appear in PinPoint's status bar - the rectangular box in the bottom left of your screen 
border.

Help message display is turned on or off from the View menu "Quick Help" menu.



Keyboard shortcuts
Keyboard shortcuts - the key combination to press to directly carry out some menu commands - are listed in 
the column below.



Cascaded menus
The  arrowhead icon indicates the presence of a sub- or cascaded menu which will appear when you choose 
that menu item.

This menu lets you position the Tool Tidy horizontally or vertically in relation to the top left hand corner of your work 
area.



Cascaded menus
The  arrowhead icon indicates the presence of a sub- or cascaded menu which will appear when you choose 
that menu item.

This menu lets you align selected items to the left, right, top or bottom edges of a 'datum' element's bounding box.



Menu items
Menu items are usually commands. However they can also be characteristics you assign to a sheet or form, a 
list of open windows or files, or the names of cascading menus which list additional commands.

To choose an item from a selected menu:
Click the item.
Or type the letter that is underlined in the item name.
Or use the UP ARROW and DOWN ARROW keys to reach the item you want to choose, then press ENTER.

Click on any of the        buttons which appear under each menu title to see a description of its menu item.



Search
The Search tool is the visual accelerator for the Sheet menu  "Search..." command.

Click the tool from a Sheet Editor window to open the "Search" dialogue box and search through a stack for answer 
sheets matching specified answer data.
Note: Use the Search tool only to locate single answer sheets for review or amendment. "Search" is not designed to 
function as a substitute for PinPoint's analysis worksheets.



Analyse sheets
This button is the visual accelerator for the Sheet menu  "Analyse sheets" command.

Click the tool from a Sheet Editor window to place the currently-displayed stack of answer sheets into an analysis 
worksheet.



Reset
This button is the visual accelerator for the Tools menu  "Remove conditions and sorting" command.

Click Reset from a Worksheet window to remove all the conditions for choosing sheets and sorting previously applied
to a stack of answer sheets.



Sort sheets
This button is the visual accelerator for the Tools menu  "Sort sheets" command.

Click the tool from a Worksheet window to open the "Sort sheets" dialogue box. 
In this you can select a question on which to sort displayed answer sheets, in increasing or decreasing order and 
within or without an existing sort.



Add condition
This button is the visual accelerator for the Tools menu  "Add condition..." command.

Click the tool from a Worksheet window to open the "Choose sheets" dialogue box.
Highlight a question field by which to choose answer sheet data to display, specify your criterion and other options, 
and choose "OK" to apply the condition(s).



Statistics
This button is the visual accelerator for the Tools menu  "Statistics..." command.

Click the tool from a Worksheet window to open the "Statistics" dialogue box and perform statistical calculations upon
selected answer sheet data.



New column
This button is the visual accelerator for the Tools menu  "Add new column..." command.

Click the button from a worksheet window to open the "New Column" dialogue box and add a new column to a 
worksheet using a calculation.



Plot graph
This button is the visual accelerator for the Tools menu  "Plot graph..." command.

Click the button to open the "Plot graph" dialogue box.
From there, dialogue boxes will guide you step-by-step through the production of even the most complex graphical 
presentation



Cross-tab
This button is the visual accelerator for the Tools menu  "Generate crosstabs..." command.

Click the button to open the "Cross-tabulations" dialogue box. and generate a cross-tabulation from selected answer 
sheet data.



Zoom 100%
This button is the visual accelerator for the  "Zoom" dialogue box's '100% magnification' option.

Click alternately on this, the "Zoom Fit Window" and the "Zoom 100%" buttons to quickly check and edit the layout 
and relative positioning of the elements on your page.



Zoom Fit Window
This button is the visual accelerator for the  "Zoom" dialogue box's 'Fit window' option.

Click alternately on this, the "Zoom Fit Window" and the "Zoom 100%" buttons to quickly check and edit the layout 
and relative positioning of the elements on your page.



A simple but effective example of layering. An opaque rectangle has been copied, filled grey, offset and 
'pushed' to the back of the stack. The question field has been placed 'on top' of the other two objects.

See also:
 Bring to front
 Send to back



File Menus
From here you can 

Open an existing PinPoint project or start a new one.
Save and catalogue your work to disc.
Import data from other project files or applications.
Print forms, selected answer sheets, reports and graphics presentations.
And return to the Windows desktop when you exit PinPoint.



Edit menus
From here you can 

Cut., copy, paste and delete elements to and from the page and the Windows Clipboard.
Edit the style of selected text elements.
Undo editing and clear selections.
And establish links and embed objects using Windows' OLE.



View menus
From here you can 

Show or hide PinPoint's page rulers and 'magnetic' alignment grid.
Scale your view of the page with 'Zoom' commands.
Show the printable page area for your selected printer driver.
Configure the display of answer sheets in a Worksheet window.
And change your view of the project.



Paper menu
From here you can 

Set up the page format and orientation of your form or presentation.
And add and delete pages to and from a form or presentation.



Sheet menu
From here you can 

Save, copy, delete and create new answer sheets.
Turn to specific sheets in a stack.
Search for answer sheets by reference number or search value.
Open a Worksheet window to analyse a stack of sheets.
And return to the Form Editor to alter a project's form.



Tools menu
From here you can 

Carry out and remove single or multiple sorting of answer sheets
Add or remove answer sheet conditions.
Choose and display statistics for numeric answers.
Add a new column to a worksheet using a calculation.
And plot a graph or create a crosstab table from selected answer sheet data.



Window menus
From here you can 

Arrange open document windows and icons.
Switch between active document windows.
Focus on a specific window from a work in progress list
And close all document windows and exit to the PinPoint desktop.



Arrange menus
From here you can 

Arrange, layer, group and ungroup sets of elements.
Align elements with each other and with on-screen design guides.
Show or hide PinPoint's alignment guidelines.
And select or clear operation of the 'magnetic' alignment grid.



Questionnaire menus
From here you can 

Group similar Questions together to make a Question Group.
Number the Questions.
Show any routing that has been established.
Setup paper size, colour and orientation.
Add a page to your Form.
Delete the last page from your Form.



Selecting answer sheets from a worksheet
You can select one or more answer sheets from those displayed in a Worksheet window to print, plot or 
tabulate, or to save to a new project.

To choose sheets matching some criterion, from the Tools menu, choose  Add Condition.
Alternatively, individual sheets or groups of sheets can be selected from the worksheet display  - by clicking, 
together with a combination of CTRL and SHIFT key presses.



Answer sheet reference numbers
An unique reference number is allocated to each completed answer sheet when it is saved for the first time.

Sheet reference numbers are allocated sequentially, and never become available for re-allocation even if their 
'owner' sheet is deleted at some future time.

For this reason apparent 'gaps' may appear in a stack's sequential sheet numbering in cases where some 
sheets have been deleted and others added later.



Updating answer sheets after changing a form
When a project's form is altered, sheets which have been previously entered may need to be changed or 
'updated'.

When you choose the File menu "Save" command or click the Stack tool to save an amended form, PinPoint 
will prompt you to confirm that you do indeed wish to update the existing answer sheets.

Updating a large stack can take some time, so it may be advisable to make a back-up of your project before 
choosing to save an edited form and update all related answer sheets.



Worksheet control panel: Add a sort
Click this button to open the "Add a sort" dialogue box.

Select a question field on which to sort, in increasing or decreasing order, within the current sort.

Choose "OK" to add the sort.



Worksheet control panel: Remove the last sort
Click this button to remove the last-performed sort of a series.



Worksheet control panel: Add Condition
Click this button to open the "Choose sheets" dialogue box.

Highlight a question by which to choose sheets, specify a condition and options, and choose "OK" to apply the 
condition.



Worksheet control panel: Remove a condition
Click this button to remove a condition by which sheets are chosen.



Printer considerations
Having two projects open on PinPoint's desktop, each of which has been formatted for a different printer, can 
sometimes necessitate the reformatting of text displayed in forms and answer sheets in either or both projects.

As a general rule all your PinPoint projects should be designed for output to the same printer, and should use 
TrueType fonts. A basic set of these is provided as standard with Windows 3.1.



Screen and printer font considerations
TrueType, or other suitable Windows font handling utility, will allow you to take full advantage of PinPoint's 
WYSIWYG environment. A basic set of TrueType fonts is supplied with Windows 3.1 as standard. Many 
different typefaces are available for each utility, and both will create appropriate screen fonts which closely 
match how the font will appear when printed



Question text
Type the text of your question into this panel.

The speed and accuracy with which information can be collected will be much enhanced by question text which
is clear and relevant, and by questions which are logically ordered on the page.



Reference name
For proper identification, each question you write must be given an unique reference name. A reference name 
may be up to 19 characters long, and may be made up of more than one word providing the words are 
separated by the underscore character.

A question will be located and referred to by its unique name in other parts of PinPoint, so make sure that you 
allocate a reference name which clearly identifies its question.

If you do not write a reference name PinPoint will generate one for you automatically. In most cases this is 
suitable.

Type a name at the cursor. PinPoint will prompt you to try again if the name you choose is already in use.



Advanced Questions
Clicking on the Advanced... button will open the Advanced Question Settings dialogue. From here you can 
choose to organise related questions into Question Groups. You can also define Question Routes.



Question text style
By default a question will be written in the text style that you have attributed to the Pen tool for the Forms 
Editor.

To change the text style of an individual question, click on the "Font'" button and select your chosen new 
attributes from the Pen style dialogue box.



Must be answered
Select this option to ensure that an answer is given to a question during answer sheet completion.

With this option in effect an incomplete answer sheet cannot be saved to the stack. PinPoint will prompt you for
an answer to each 'monitored' question.



Answer text style
By default an answer will be written in the text style that you have attributed to its question text.

To change the text style of an individual answer, clear the "Same as ..." check box. Click on the 'Font' button 
and select your chosen new attributes from the Pen style dialogue box.

Both question and answer text styles may be edited individually later 'on the page'. Double-click on the selected
text with the Pen or the Pointer to re-open the Pen style dialogue box.



Fixed text entry
Select this option if your question will require an answer such as, for example, an address of 'x' lines of 'x' 
characters.

Note that the number of characters that PinPoint will allow to be entered on a line will vary depending upon the 
text style, character type and entry area style that you choose - PinPoint will actually allow as many characters 
as will 'physically' fit on the line. To ensure precise line length choose a 'comb' data entry area style.



Comment text entry
Select this option to include an entry area for a block of 'comment' answer text within your form.

The size of a comment area is defined by the original area marked out with the Question tool, less title space, 
but may be changed later using the Pointer tool. PinPoint will include comment answers in a 'search on text' 
during answer sheet location.



Entry area style
Click open the 'Entry area' list to select an answer data entry area style. Available styles include dotted and 
solid lines, a box, 'bucket', comb and full comb, or 'no style' (i.e. none).

To enhance a form's presentation you can choose to fill an answer area with a colour or shade of grey. Check 
the 'filled' box and click the 'Colour' button to open PinPoint's colour selection palette.



Picture text entry
Choose this option to include a 'validated character' answer in your form.

If, for example, you require that all telephone number answers be entered in an identical format, select 'Picture' 
and type (say)  (####)-######  into the panel.

Picture formatting characters are
# - digit only
? - any alphabetical character
& - any alphabetical character converted to upper case
@ - any character
! -    any character converted to upper case



Numeric answer format
Choose a format for your Numeric answer from the menu, or type in your own at the cursor. Answers may be 
formatted to as many decimal places as required.

Units description characters may be entered before or after the    #    digit formatting character, for example:

£ ###.##

## years

##.# cm



Numeric answer checks
Check these boxes to choose to allow negative number answers and to specify a required range of answer 
values.



Yes / No descriptions
The default descriptions for Yes/No answer types are 'Yes' and 'No'. Either answer can be changed if required. 
Type your new description at the cursor.



Entry area style
Click open the 'Style' menu to select a check box style for the choices. 

During answer sheet completion, a cross will be drawn on the check box for a choice when it is chosen. 
Available styles include dotted and solid lines, shaded and unshaded boxes, or a 'bucket'.

Check the boxes to choose to align the choice check box to the left of its choice text and whether to vertically 
align the choices. You may also choose only to allow 'Yes' answers to be recorded.

Note that for the purposes of analysis, PinPoint will interpret 'No' answers as 'not answered' when the 'show 
'Yes' answer only' option is selected.



Date answer format
Choose a format for your Date answer from the list. Note that formats in which the days and months are 
entered as numbers, the formats are taken from the short form date format description in the International 
settings section of the Control Panel.



Add a choice
Choose the 'Add' button to add a choice to a Multiple or Ordered choice question.

A text entry panel will appear. Type your choice text at the cursor, and choose 'Font' to change text style if 
required.

Click 'OK' to return to the main dialogue box. Note that your choice text has now appeared in the choice list 
panel.



Edit a choice
Select the choice from the list and then choose the 'Edit' button.

A text entry panel will appear containing your selected choice text ready for editing.Choose 'Font' to change 
text style if required.

Click 'OK' to return to the main dialogue box.



Entry area style
Click open the 'Style' list to select a tick box style for the choices. During answer sheet completion, a cross will 
be drawn on the tick box for a choice when it is chosen.

Check the options to choose to align the choice tick box to the left of its choice text, to show only the tick box 
without the description text and whether to vertically align the choices. You may also choose to allow only one 
choice to be made in answer to the question, to sort the questions by column and to justify the text..



Entry area style
Answers to ordered choice questions are numbered in order of preference during answer sheet completion. 
PinPoint will only allow entry of a number within the choice range (e.g. 0 - 10).

Click open the 'Style' list to select an entry area style, the styles available are similar to those for numeric 
answers.

Check the boxes to choose to align an entry area to the left of its choice text, to show only the entry area 
without the description text and whether vertically align entry areas.



Entry area style
Click open the 'Entry area' list to select a Date answer area style. Available styles include dotted and solid lines,
a box, 'bucket', comb and full comb, or 'no style' (i.e. none).

To enhance a form's presentation you can choose to fill a Date answer area with a colour or shade of grey. 
Check the 'filled' box and click the 'Colour' button to open PinPoint's colour selection palette.



Delete a choice
Select the choice to delete from the list and then choose the 'Delete' button.



Question
Select the question(s) from which statistics are to be derived from the "Question" list panel. Click on a 
question's reference name to select it, click again to clear your selection.



Statistics
Select the calculation(s) to be performed in the "Statistics" list box.



Show for
Select only those answer sheets currently displayed in the worksheet, or all the answer sheets in the current 
stack, or both sets, for inclusion in the analysis.



Choose "OK"
The title "Statistics" will appear at the left end of the question field title bar. A window will open between the 
Worksheet control panel and the first answer sheet row in which the results of your calculations will be 
displayed.



Hint
To modify or perform further statistical calculations, click on the "Statistics" column title to re-open the 
"Statistics" dialogue box.



 
Question list box
The unique reference names of your form's questions, other than those with ordered choice answers, are listed
in this panel.

Double-click on a name to include it in your calculation, or type it into the calculation box.



 
Calculator box
The progress of your calculation is shown here in in this panel.

To enter a calculation type in question names, function names, digits and arithmetical symbols at the cursor, or 
click the calculator and double click on reference names, or use both methods.

You can select, cut, copy and paste calculation text just as you would in any other Windows text editor.



Score
During the definition of questions and answers, a score can be applied to each choice. This function will return 
the score of the ticked choice in the given answer.

If the answer allows more than one choice, the score returned is the sum of the scores for each of the choices 
ticked.

If the given answer is not a multiple choice or yes/no answer, the function returns the value of the answer as a 
number.



 
Display style
When your calculation is complete, click "Display style..." and the display style dialogue box for the type of 
answer to the calculation (text, date or numeric) will appear.



 
Calculator
Click on the calculator to perform your calculation. Each calculator key press will be shown in the calculation 
box.



Default Pen style
The Pen's style is applied to all new text written in the current Editor.



Grid units
Check the radio buttons to specify grid units and divisions in inches or centimetres, or in feint rules based on a 
specific font. Choose "Feint rules" to open the "Font" dialogue box.

Tip: Feint rules are useful to ensure that text is evenly and suitably spaced down a form or presentation.



Grid colour
Choose "Colour" to open PinPoint's colour selection palette and attribute a colour to the on-screen grid. By 
default the grid will be displayed in the colour you have attributed to the Pen tool.



Grid show
Check the "Show" box to display the on-screen grid. 



Grid snap
Check the "Snap" box to activate the grid's 'magnetism'.

Shortcut: Choose  "Snap to grid" from the Arrange menu.



Fixed magnification
Select a radio button to display a page at one of four fixed percentages of actual size.



Custom magnification
Select the "Custom" button and type your own 'best' viewing scale at the cursor.



Fit to window 
Choose this command to scale your work,    either vertically or sideways, to obtain the maximum possible full-
page view.



Fit window sideways
Choose this command to scale your work to the maximum possible view across the page.



Edit question text
The copied question's text will appear in this panel.

Type the text of your new question at the cursor. You can select, cut, copy and paste this text just as you would 
in any other Windows text editor.

Enter your new question's unique reference name, and choose "OK".



Edit reference name
For proper identification, each question you write must be given an unique reference name.

A question will be located and referred to by its unique name in other parts of PinPoint, so make sure that you 
allocate a new reference name which clearly identifies its question.

Type your new reference name at the cursor.



Paper size
Click on the "Size" panel button to open the selection menu.

Choose from one of the paper and and envelope sizes shown (which are those available for yur currently 
chosen printer), define your own custom page size, or select a 'window sized' page.

Click on a standard paper size to select it, or type the dimensions of your custom page into the Width and 
Height boxes.



Paper orientation
Click a radio button to select Portrait or Landscape page orientation. Before printing your work, choose "Printer 
setup..." from the File menu to check matching printer orientation.

Hint: Work with the View menu's "Show printable area" command active.



Paper colour
Choose "Colour" to open PinPoint's colour selection palette and attribute a colour to your 'electronic' page. 
Paper colour is displayed as white by default.



Question
The panel shows the names of the question fields on which you may sort. Choose a question by clicking on its 
name or by typing its name into the box.

Click Show all to show all the questions in the project or only those currently displayed on the Worksheet



Sort order
Answer sheets may be sorted in increasing or decreasing order. Click on a radio button to choose a sort order.



Sort within current order
Sheets may be sorted within the order in which they are currently displayed, or, if the option is unchecked, the 
new sort will replace any current sort..



Search for ..?
Click a radio button to choose

Any text    OR
Any number only    OR
Any date only

as the answer type to search on



Search value
Type the value to be searched for into the panel.

Searches on text will find words which match your search word both in whole and in part. The wild-card 
character    #    may also be used to extend the range of possible matches.



Find first/next
Once you have defined your search criteria, choose "Find first" or press RETURN.

PinPoint will search the stack from the first sheet and will display the first match found. Click "Find next" or 
press RETURN repeatedly until you find the sheet you want to review.



New column name
For proper identification, each new column must be given an unique reference name. A reference name may 
be made up of more than one word providing the words are separated by the underscore character.

Type a name at the cursor. PinPoint will prompt you to try again if the name you choose is already in use.



Question
This panel lists the names of the questions by which you may choose answer sheets. 

Select a question by typing its name into the box or by clicking on its name.

Click on the Show all button to show all questions in the project or only those currently displayed on the 
Worksheet.



Condition
This panel lists the conditions applicable to the question you have chosen. Conditions that are not applicable 
will be shown 'greyed'.

Click on a radio button to choose a condition.



Condition value
The "Value" panel's format will change to correspond to the question type you have chosen.

Type the value(s) applicable to your condition into the panel,    OR    click on the values listed for Ordered 
choice, Multiple choice and Yes/No questions. Please see the PinPoint User's Guide for complete descriptions 
of the entry of answer values for each of the answer types.



Criteria
You may choose multiple criteria by clicking on either the <<And or the <<Or button between choices. To 
delete any chosen criterion just click it, then click Delete.



Display style
When your calculation is complete, click "Display style...". A dialogue will appear from which you may choose, 
or type in, the format for display of the results of the calculation.



2D bar
Choose this style button to plot a two-dimensional bar chart.



3D bar, one depth
Choose this style button to plot a three-dimensional bar chart.

Multiple series will be drawn on one depth.



3D bar
Choose this style button to plot a three-dimensional bar chart.



2D bar, rotated and stacked
Choose this style button to plot a rotated two-dimensional bar chart.

Multiple series will be  stacked.



3D bar, rotated and stacked
Choose this style button to plot a rotated three-dimensional bar chart.

Multiple series will be  stacked.



2D bar, rotated
Choose this style button to plot a rotated two-dimensional bar chart.



3D bar, rotated, one depth
Choose this style button to plot a rotated three-dimensional bar chart.

Multiple series will be drawn on one depth.



2D bar, stacked
Choose this style button to plot a two-dimensional bar chart.

Multiple series will be  stacked.



3D bar, stacked
Choose this style button to plot a three-dimensional bar chart.

Multiple series will be  stacked.



2D pie
Choose this style button to plot a two-dimensional pie chart.



3D pie
Choose this style button to plot a three-dimensional pie chart.



2D column
Choose this style button to plot a two-dimensional column chart.



3D column
Choose this style button to plot a three-dimensional column chart.



Line
Choose this style button to plot a Line chart.



Rotated line
Choose this style button to plot a rotated Line chart.



Ribbon
Choose this style button to plot a '3D' Line chart.



Rotated ribbon
Choose this style button to plot a rotated '3D' Line chart



2D area, stacked
Choose this style button to plot a two-dimensional area chart.

Multiple series will be  stacked.



2D area, rotated and stacked
Choose this style button to plot a rotated two-dimensional area chart.

Multiple series will be  stacked.



3D area, stacked
Choose this style button to plot a three-dimensional area chart.

Multiple series will be  stacked.



3D area
Choose this style button to plot a three-dimensional area chart.



Table
The Table style provides for drawing a simple table of the results of the analysis and are useful alongside a 
graph to clearly show the values plotted. 

Multi-column tables may be built in the same way as a multi-series graph; each series is a column of the table. 
With multi-column tables, statistics may be calculated upon the values in each row of the table.

The table is automatically generated with suitable column widths and uses the font chosen in the Plot Graph 
dialogue.

Tip: You may like to use the various facilities for copying analysis results to the clipboard if you wish to show a 
table of results in a document such as one prepared with a word processing application.



Segment fill style
Click on a button to select a fill style to apply to all segments of a Pie chart. PinPoint will allocate default colours
to a Pie chart's segments when the chart is first plotted.

Note: You can change a Pie segment's fill colour, style and outline colour and out line thickness from the 
Presentation Editor. Right-click on a segment with the Pointer and choose Pie Segment Properties from the 
pop-up menu. The  "Pie segment style" dialogue box will appear.



Options
If required, PinPoint will label each segment of a Pie chart, and will include the value of a segment's category in
the label. Check a box to select the option.



Segment fill style
Click on a button to select a fill style to apply to all segments of a Column chart.

PinPoint wil allocate Column segment fill colours by default when the chart is plotted.



Options
If required PinPoint will label each segment of a Column chart, and will include the value of a segment's 
category in the label. Check a box to select the option.



Pie segment fill style and colour
Click on a button to select a fill style to apply to the Pie segment that you are editing.

To attribute a fill colour to a segment, click the "Colour" button to open PinPoint's colour selection palette.



Pie segment outline colour and weight
Scroll the readout to select a line  weight to apply to the outline of the Pie segment that you are editing.

To attribute a colour to a segment's outline, click the "Colour" button to open PinPoint's colour selection palette.



Line weight and colour
Scroll the readout to select a line  weight to apply to a Line.

To attribute a colour to a Line, click the "Colour" button to open PinPoint's colour selection palette.



Points
Select a line Point style from one of the twelve styles shown.

Drag the horizontal scroll button to set the line Point size you require. Minimum size is set with the scroll button 
fully LEFT.



Tick marks
Select a radio button to display tick marks Inside, Outside or Across graph axes, or to show NONE.



Grid lines
Check these boxes to show either or both horizontal and vertical grid lines.



Options
In the "Options" panel you may enter a value for a 'false' y-axis origin and choose to plot against a logarithmic 
y-axis scale.



Area fill style and colour
Click on a button to select a fill style to apply to an Area.

You may choose to accept the Area fill colour shown, or click the "Colour" button to open PinPoint's colour 
selection palette and make a new selection.



Bar spacing
These three options control the spacing drawn between bars in a bar graph.

Use "Gap width" to set x-axis spacing between bars in any bar graph.
Use "Gap depth" to set z-axis spacing between bars in a multiple series full-3D graph.
Use "Overlap" to control the degree of x-axis overlap between bars in a multiple series 2D graph. A setting of

"100%" will result in the complete overlap, or 'layering', of each series' bars.



Options
In the "Options" panel you may choose to

enter your value for a 'false' y-axis origin.
plot against a logarithmic y-axis scale.
plot a histogram for numeric answer values.
sort the bars into increasing or decreasing order of magnitude.



Bars fill style
Click on a button to select a fill style to apply to all bars in any one series.

To select a series' bar colours
Check "Automatic" to allow PinPoint to attribute discrete colours to all the bars in the series
Deselect "Automatic" and accept the colour shown for all the bars in the series, or click the "Colour" button 

to open PinPoint's colour selection palette and attribute your own.



Points
Select a Point style from one of the twelve styles shown.

Drag the horizontal slider button to size Points to a multiple (on a scale of 1 - 10) of your chosen Line thickness.
Minimum size is set with the slider button fully LEFT.

Click the "Colour" button to open PinPoint's colour selection palette and attribute a colour to all Points in a 
series.



Tick labels
Choose the "Tick labels" button to open the Pen style dialogue box and change your graph's tick label font.

Initially, tick labels are written in the text style you attributed to your graph in the "Font" section of the "Plot 
graph" dialogue box. 



Axis labels
Choose the "Axis labels" button to open the Pen style dialogue box and change your graph's axis label font.

Initially, axis labels are written in the bold weight of the text style you attributed to your graph in the "Font" 
section of the "Plot graph" dialogue box. 



Labels
The axis labels are used not only for labelling the axes on graphs with axes, but also for creating the heading 
for pie and column charts and, from the x-axis label, for heading the first column in a table (subsequent 
columns are labelled with the legend text for the series shown in the column). Whether to write a label, and the 
text to use, is controlled by choosing one of the options:

None No label will be written. For tables, this option is the same as Auto.

Auto For the y-axis, the label will be based upon the analyses used to produce the graph, for the x-axis it will 
be based upon the reference names of the questions whose answers were analysed.

This Type the label text to use into the box.

Tip: To remove the heading from pie and column charts, choose None for both the x axis and y axis labels.



Series list panel
Multiple series will be drawn on paper in the order of their appearance in the "Series" list panel. By default this 
will be the order in which they were first plotted.

The first series listed in the "Series" panel is always the first to be displayed. Its style also defines the other 
series' overall display style options, and the graph's tick mark, grid line, etc. attributes.

Use the    << | >>    buttons to re-define the series listing order.



Reorder series
Use the    << | >>    buttons to re-define the series listing order, and as a consequence the order in which series 
are drawn and displayed.

Select a series and move it up or down through the series list by clicking on the button(s).



Delete series
You may have added a series to a multiple series graph only to find that you have made a mistake, or that the 
new plot simply 'doesn't work'.

To delete a series form a multiple series graph, select its description in the "Series" list panel and choose the 
"X" button.



Style gallery
When you select a series' description in the "Series" list panel, its chosen chart type will be selected in the 
gallery.

To change a series' chart type, select the series' description and then choose new chart type required from the 
gallery. Choose "OK", and the series will next be re-drawn in the chart type selected. The new plot will take the 
style attributes (i.e. 2D or 3D, etc.) of the first series in the "Series" list.

To further define the series' new style, choose Style properties... to open a properties dialogue box for the 
modified chart.



Style Properties
To define the properties of a series' new chart type, or to modify a series' existing properties, choose "Style 
Properties".

If the series selected is the first listed in the "Series" list panel, its full properties dialogue box will appear - in 
other words you may make overall property changes to the graph; use of legends, rotated axes, grid lines etc.

If the series selected is not the first to be listed, its "Add to graph" dialogue box will appear in which you may 
make property changes for the series such as colour and its legend text.



X-axis and Y-axis Ranges and Divisions

When a graph is first drawn, PinPoint will determine suitable ranges and divisioning of the numeric axes 
to give a reasonable presentation. If the graph is resized, PinPoint will determine new suitable ranges 
and divisioning for the new size of the graph, unless the graph has been modified via the Modify Graph 
dialogue, in which case it will attempt to use the values shown.

Using the From, To and Step boxes, you may modify the values to use for the axis range and divisions if
more suitable values than those determined by PinPoint are apparent to you.

To change the values, type the new required values into the boxes.

Any desired values may be entered, however, PinPoint will check to ensure that they are usable and 
reasonable:

You cannot enter a From value which is greater than the smallest value to be shown, i.e. you 
cannot "hide" points or values from the graph.

You cannot enter a step size which does not evenly divide the range of the axis.

If an invalid value is used, PinPoint will simply change it to a valid value.

Tip: Zero may be given for all the values, this will cause PinPoint to re-calculate suitable ranges and 
divisioning as when the graph was first plotted. If zero is entered for the step size, PinPoint will 
determine a suitable step size from your given range. In either of these cases, PinPoint will also return 
to automatically determining suitable values when the graph is resized.



Plot line of best fit
This option becomes available when a plot of 'numeric vs. numeric' values is chosen. Check "Plot line of best 
fit", and the best fitting LINE will be drawn through the points.

The equation of the line, in the form y=mx+c, and the linear correlation coefficient of the data are also 
displayed.



Line thickness
In all dialogue boxes throughout PinPoint, line thickness measurement is displayed by default in millimetre 
units. The spin buttons' increment/decrement value is set at 0.5mm.

You may change a line's weight by typing your own, in units of cm, mm or pt, into the "Thickness" text entry 
panel of the corresponding dialogue box.

Note: You can also scroll through line thickness selection from the keyboard. Use the TAB key to select the 
"Thickness" option, then increment or decrement the display using the UP ARROW and DOWN ARROW cursor
keys.



Stacked chart styles
In stacked multiple series charts the first series is plotted 'at the bottom' and further series are then plotted 'on 
top', in order, showing the corresponding values of different series in vertical stacks.

Each stack shows both the total reached by the combined values, and the degree of each value's contribution 
to that total.

To change 'stack order', click on a graph to open the  "Modify graph" dialogue box. Use the    << | >>    buttons 
to re-define the series order as shown in the "Series" list box.



First line contains field names
Some CSV files give field names on the first line of the file. If your source file gives field names, then ensure 
that this option is chosen.

If your source file does not give field names on the first line, PinPoint will create suitable names.

Some 'trial and error' may be necessary when using this setting owing to the variety of CSV text file formats in 
evidence.



Character set
Click on a radio button to define the character set used by your source file, if known.

Choose ANSI if the file you are importing from was written by a Windows application, choose DOS if the file 
was written by a DOS application.



From field
PinPoint displays the names of the fields found in the file being imported from in this list box.

If you are "quick" importing a file into a new project built by PinPoint, matching field names will be displayed in 
the "To Question" list box. To exclude the import of information from any field, double-click on its name and 
select    <<<<NONE>>>>    in the  "Import from field" dialogue box.

If you are importing a file into an existing project, check that the field's data is going to be imported into the desired 
question in the project. If you are unhappy with PinPoint's mapping, double-click on a source field name to open the 
"Import from field" dialogue box and map the source field to an appropriate project question field, or to NONE.



To Question
This list shows the questions that will be imported into from the matching entry in the "From field" list 
box.

If you are "quick" importing a file into a new project built by PinPoint, the "To Question" list box will display 
matching field names opposite those displayed in the "From field" list box, and on the same lines.

If you are importing a file into an existing project, the "To Question/" list box will show the names of your 
project's existing questions.

Note that the question names are shown 'greyed'. This is because they appear for information only.



Import from Field
The "Import from field" dialogue box displays a list of all the question fields available to which a source field 
may be mapped, and    <<<<NONE>>>>.

If the project has been built by PinPoint for a "quick" import, the available question field names will be identical 
to the source field names, otherwise, the list box will show the names of your project's existing question fields.

Highlight a destination question field name for your source field, and choose "OK" to return to the "Import" 
dialogue box.



Choices List
The choices list shows the descriptions of the choices available in answer to the question.

Click on a choice to select it and then choose the 'Edit' button to edit the text or font used for the text, or the 
'Delete' button to delete the choice.

Alternatively, the choice can be edited by double clicking on the choice.



 
Operators
Click on the operator buttons to insert them into the calculation.

When mixed type operands are used, both operands are converted to the same type before evaluating the 
result.

When the left operand is numeric, both operands are converted to the type of the right hand operand, otherwise
the right operand is converted to the type of the left operand. The exception to this is when the left operand is 
text and subtraction, multiplicaion or addition is used - in these cases both operands are converted to numbers.

Examples:

aDateAnswer + 5 the date 5 days on from aDateAnswer

5 + aDateAnswer the date 5 days on from aDateAnswer

"ABC" + "DEF" "ABCDEF"

"ABC" + 5 "ABC5"

"ABC" + 
aDateAnswer

"ABCdd/mm/yyyy"

Insert Paper
The Insert Paper tool creates space between objects on your Form or Presentation.    You may, for example, 
wish to insert an additional question between two existing questions.    To insert paper:

Pick up the Insert Paper tool from the Tool Tidy.    (The cursor will change to the Insert Paper cursor.)
Position the tool in one corner of the rectangular space required.
Click and drag the rectangle to define the required space, then release the mouse button.

Any objects within the marked out space will then move to its edge leaving space for new questions or drawing 
objects to be added.



Zoom to fit sideways
This tool is the visual accelarator for the  "Zoom" dialogue box's "Fit Window Sideways" option.

Click alternately on this, the "Zoom Fit Window" and the "Zoom 100%" buttons to quickly check and edit the layout 
and relative positioning of the elements on your page.



Ask for answer if...
This type of routing allows a condition to be placed on whether the current question is asked, 
depending on answers to one or more previous questions.

One or more criteria based on previous answers can be combined with the logical operators AND and
OR to specify the condition fully.

Select Ask for If, and the Ask Question dialogue appears.



Always goto question
This option forces PinPoint to jump to another question after the current one has been answered, 
regardless of the answer.

Type in, or selectfrom the drop-down list, the Reference Name of the Question you want asked next.



Goto question(s) depending on answer(s)
This option allows different questions to be asked next, depending on how the current question is 
answered.    You can also set up multiple routing to go to several different answers.

The Advanced Question Settings dialogue extends to show existing routes.

Click on Add route to obtain the Route From Question dialogue.



Ask no more questions
This option allows you to terminate the questionnaire after the current question has been answered.    
The last question already behaves in this way but this option allows the questionnaire to be ended 
earlier if appropriate.



Question Table Graph Tool
This button is the visual accelerator for the Tools menu  "Plot Graph from Question Table" command.

Click the button to open the  "Plot Graph From Table of Questions" dialogue.
This dialogue will allow you to analyse all the answers in the Question Tables quickly.    It works in the same way as 
the normal Graph tool.



Quick Graph Tool
This button is the visual accelerator for the Tools menu  "Quick Analysis..." command.

Click the button to open the  "Quick Graphs" dialogue.
This dialogue will allow you to undertake a quick analysis of the responses to all, or a large number of, questions 
before undertaking an in-depth analysis. 



Question Groups
Where a number of questions belong in the same category, such as 'Name and Address' or 'Insurance Claim 
Details', PinPoint allows you to choose to group them together.    The resulting Question Group has the 
following features:

The questions are kept together on the Form and are grouped within a box.
All the questions in that group are asked before any other questions.
In the Worksheet view, all the questions in the Group are kept together.
The Group can contain some introductory text such as an explanation or heading.

Questions are grouped in the Form editor.



Question Tables
Creating a Question Table is a convenient way of organising a large number of multiple choice questions which 
all have the same choices of answer.    Question Tables are created in the Form editor Form using the Question
Table tool.



The Load/Save Setups Tool
This button is the visual accelerator for the Tools menu     Load/Save Setups command.

Click the button to open the  Load/Save Setups palette.
This allows you to save and load different Worksheet configurations. If you have set up a sort or choosing sheet 
criteria, you can also save these. The configurations are independent of the current Worksheet, and can therefore be 
applied to any Worksheet which is opened.
Note: The Load/Save Setups Palette stays in the Worksheet foreground, and can be removed by clicking the 
Load/Save Setups button in the Tool Tidy again, or, by re-selecting Load/Save Setups from the Tools menu.



Members of Groups
Select the Group you want a chosen question to be a member of from the scrolling list of Groups., or
Define a new group by clicking on New Group. This brings up the top half of the Question Group dialogue. A

new group can then be created, or
Alter the appearance of a selected Group by clicking on Edit Group. This brings up the top half of the 

Question Group dialogue, and allows the introductory text, border style and border distance from emebers to be 
altered, ( but not the members of the Group themselves ).



Routing
PinPoint's Question routing feature allows you to specify what the next question should be depending on the 
answer to the previous one.    This can save time for respondents as irrelevant questions can be skipped.

There are four types of routing to choose from:
Ask for answer if
Always goto question
Goto question(s) depending on answer(s)
Ask no more questions 



Carry Over Values
Use the Carry over values option to carry the answer given to the question forward to the next new answer 
sheet for completion.





Form Design: "How to..."
The Form Editor allows you to: describe the data to be collected (write questions), modify them, move 
them around the paper so they are presented in the required order, and add explanatory text and/or 
pictures, until you are satisfied.

Using PinPoint, there is no need to sketch out a design for your form and the questions to be asked 
before beginning in PinPoint, since PinPoint itself provides you with all the tools for sketching. As you 
are working on the form you can continually refine it by moving, adding and removing work - in many 
ways it is easier to work in PinPoint than it is to use pencil and paper.

Creating a new form from scratch or from another file

Importing and merging data

Editing forms and working with objects

Working with Questions

Working with text

Backgrounds, borders and graphics

Publishing forms



Working With Questions
A question describes the information to be collected. A question may be framed to elicit a required 
response from another person or framed as a terse statement of the information required. For 
example, you might ask "Do you eat chicken?". Alternatively, if collating information on, for example, 
accidents at a known black spot, you might simply state "Date: ", expecting the date of the accident to 
be written in.    In PinPoint, a question consists of three parts:

1. The text of the question, framed in any way desired.

2. A short reference name for the question.

The text of a question can sometimes be quite long. To refer to the question when analysing results 
this reference name is used. If the text of the question is a single word, PinPoint will automatically 
use that word as the reference name.

3. A description of the type of answer required, or type of data to be entered. PinPoint provides the 
following answer types:

Text/general

Numeric

Yes/No

Date

Multiple choice

Ordered choice

Calculated

Note In database terminology, a question is a field and an answer type is a field type.

Writing questions

Editing questions

Creating question tables

Grouping questions

Routing questions



Working with Text
To write on the paper, for example, some instructions for completing the form, you use the  Pen (or 
Text) Tool.

The Pen tool may also be used to edit any text which is part or a question - the question text or answer 
descriptions. The tool is used in exactly the same way as when editing any other text on the paper.



Backgrounds, Borders and Graphics
The appearance of a form or analysis results presentation may be enhanced by adding backgrounds 
and borders to objects and adding pictures such as logos.

Backgrounds and borders

Backgrounds and borders are drawn using the  Rectangle tool. To draw a background to objects 
already on the page, draw a filled rectangle of the required colour covering the objects to be given a 
background and then either use the Pushdown tool, or select the rectangle using the Pointer tool and 
then,from the Arrange menu, choose Send To Back. The rectangle will then be drawn behind the 
objects creating the background. Do not use this method to draw a background for the whole page, 
choose a colour for the 
 paper instead.

To draw a border round objects, draw an unfilled rectangle round the objects.

Graphics

A host of painting and drawing applications are available with which you can draw logos, illustrations, 
etc.. Images created with such programs can be pasted onto the page to improve the appearance of a 
form or presentation.

You may also possess applications which provide utility applications (applets) which can be used to 
originate objects from within PinPoint, for example, utilities to create special text effects. Such 
applications use the services of Object Linking and Embedding (OLE).

A graphic can be placed on the page using one of several methods:
Use a suitable application to create the graphic, or load a graphic from file and then copy the 

graphic to the clipboard. Switch back to PinPoint, and then, from the Edit menu, choose 
 Paste or 
 Paste Link.

If the graphic is in a .BMP or .PCX file, drag the file from File Manager and drop it on the page.
From the Edit menu, choose 

 Insert Object and choose the type of object you wish to embed on the page. Create the object using the 
application that appears and then choose Exit from the application's file menu. You will be returned to 
PinPoint and the object you created will appear at the top left corner of the page window.



Working With Forms and Objects
A well designed and written form is more likely to be completed, and be completed accurately. The 
tools and procedures provided by PinPoint allow you to produce attractive forms quickly and simply.

Design guides
PinPoint's design guides - the guidelines, 'magnetic' grid and rulers selectable from the  View 
and 

 Arrange menus - will enable you to lay out your form with great precision.
You can choose to enable these guides from the start, or you can simply begin writing questions 

on the page and then work on form layout later. In any event it is a good idea to enable "Show printable 
area" from the View menu. The shaded box that this command draws around your page to denote the 
area in which your printer cannot print forms a good visual reference to the page area available to you.

Hint: Use the Tool Tidy's "Fit window", "Fit sideways" and "100%" buttons to zoom in and out as 
you work to keep a check on overall page layout and the relative size and position of elements 
on your form.

Editing a form

Paper setup and multi-page forms

Viewing your work area

Moving and resizing objects

Aligning objects

Layering objects



Writing Questions
Question fields are 'written' on a project's form with the Question tool.

1. Placing a question
Click on the Question tool to pick it up from the Tool Tidy, and use it to mark out (drag-select) the 
page area that your question is to occupy. The "Question Details" dialogue box will appear when 
you release the left mouse button.

Note: The precise sizing and placement of a question field's area is not important at this stage. 
Its position, and the relative size and position of question and answer text within it, can easily be 
changed later.

2. Defining a question
Your question and its text, its unique reference name, the type of answer and the data entry 
checking required, and the overall style and presentation of a question field are all written and 
defined in the "Question Details" dialogue box.

Click  here to see a detailed description of this dialogue box and its options.

Hint: Question text will appear aligned with the left edge of the area you mark out, and answer text 
with the right. Once you become used to working with the Question tool you will quickly develop a 'feel'
for marking out suitable areas for different question types.



Creating Question Tables
Creating a Question Table is a convenient way of organising a large number of multiple choice 
questions which all have the same choices of answer.    Question Tables are created on a project's 
Form using the Question Table tool.

1. Placing the table
Click on the Question Table tool to pick it up from the Tool Tidy, then use it to mark out (drag-
select) the page area that your question table is to occupy. The "Question Table" dialogue box 
will appear when you release the left mouse button.

Note: Grid and Guide Lines can be useful aids to this process.

2. Defining the questions and answers
Your questions and introductory text, the possible answers and the overall style and presentation
of the table are all written and defined in the "Question Details" dialogue box.

Click  here to see a detailed description of this dialogue box and its options.



Editing Question Tables
The Question Table can be edited by double clicking on the surrounding box (but not on one of the 
questions within the Table) with the Question Table Tool, or by selecting "Group/Table Properties" from 
the right hand mouse button pop-up menu.    The Question Table dialogue then appears on the screen 
and you can make the required changes.

It is also possible to resize the Question Table by moving one of the resize handles with the Pointer 
Tool, while the Table is selected.

Click  here to see a detailed description of this dialogue box and its options.



Grouping Questions
Where a number of questions belong in the same category, such as 'Name and Address' or 'Insurance 
Claim Details', PinPoint allows you to choose to group them together.    The resulting Question Group 
has the following features:

The questions are kept together on the Form and are grouped within a box.
All the questions in that group are asked before any other questions.
In the Worksheet view, all the questions in the Group are kept together.
The Group can contain some introductory text such as an explanation or heading.

New questions can be included in a Question Group using the following methods:

1. Click on Advanced in the Question Details dialogue to bring up the Advanced Questions 
Settings dialogue. Select which Group you want this question to be a member of from the 
scrolling list of Groups.

2. Alternatively, you can define a new group by clicking on New Group. This brings up the top 
half of the Question Group dialogue. A new group can then be created, starting with the 
current question.

3.  When an existing Group is selected, the Group's appearance can be altered by clicking on 
Edit Group. This brings up the top half of the Question Group dialogue, and allows the 
introductory text, border style and border distance from members to be altered, ( but not 
members of the Group themselves ).

To group a number of questions together, use Shift clicking to select all those questions you wish to 
make members of the same Group. Select Make Question Group from the Questionnaire Menu. The 
Question Group dialogue then appears:

1.  Enter the Reference Name you wish to give the Question Group. This is not displayed on the
Form but it is used by the Worksheet.

2.  Type in any introductory text that you wish to display at the top of the Group, above the 
questions.

3.  You may change the properties of the Group Border by clicking on Properties, which brings 
up the Rectangle Properties dialogue. The distance of this border from the text can also be 
defined in the From Members box.

4. The Non members box contains the questions that have already been written, which do not 
already belong to a Question Group. Those that were selected will appear already 
highlighted. Click on the Reference Names of those questions you want to become members 
of the new Group. ( They can be deselected by clicking on them again.)

5. When you have selected all of the questions that you want to be members of the new group, 
click on <<Add. They will then be moved to the members box.

6. Further members can be added or removed from the Group in the same way until you click on
OK. 

The questions making up the group will now be bound in a box whose borders are defined by the 
position of the question inside it. Double clicking on the box, ( but not on a question inside it ), with the 
Question Tool will return you to the Question Group dialogue,

To group the questions together use Shift clicking to select those you wish to include, then click the 
"Make a Question Group" command to open the  "Make Question Group" dialogue.

Note: Question Groups can also be created, and edited, by choosing the  "Advanced..." option in the 
"Question Details" dialogue.





Routing Questions
PinPoint's Question routing feature allows you to specify what the next question should be depending 
on the answer to the previous one.    This can save time for respondents as irrelevant questions can be
skipped.

There are four types of routing to choose from:
Ask for answer if
Always goto question
Goto question(s) depending on answer(s)
Ask no more questions 

To create and/or edit a route choose the "Advanced..." option in the "Question Details" dialogue.

Note: The routing can be shown by choosing "Show Routing" from the Questionnaire menu.    Routes 
are displayed as coloured lines and a small circle is displayed at the destination(s).    It is not advisable
to show the routing permanently as it can make the Form appear more complex than is necessary.



Editing Questions
Once a question has been placed on a form it can be edited and manipulated using the usual 
procedures or tools from the Tool Tidy:

Grouped with other objects, such as background or frame rectangles 
Arranged with other questions/fields or objects using the Align menu
Moved around the page until they appear in the correct order
Copied to quickly duplicate similar questions. When a question is copied using Cut/Copy and 

Paste, or Drag and Drop, the Question dialogue will appear so that a new question can be entered.    A 
new reference name will be generated automatically.

The question itself can be modified in one of two ways:

1. Editing question and answer text
You can edit, select, cut, copy and paste question and answer text on the page just as you would 

in any other Windows text application. Click on a piece of text with the Pen to position the edit cursor.
When a question field is written its question and answer text styles, unless changed at the time of

writing, will be those which are attributed to the Pen tool. To change the style of a field's question text or 
answer text, double-click on a it with the Pen. The Pen style dialogue box will appear.

2. Editing with the Question tool
Double-click with the Question tool on any part of a question to re-open the "Question Details" 

dialogue box. You can now change any part or attribute of the question.

Note: Take care when changing answer types. If you change from (say) a Multiple choice answer to 
another answer type and back again, the original choice information will be lost. In addition when an 
'active' project's questions are altered, sheets which have been previously entered into the stack may 
need to be changed or 'updated'.



Editing a Form
The form for a project can be edited at any time; new questions added, questions deleted or changed 
and "presentation material" such as graphics and borders added, removed or modified.

If the project contains no answer sheets, the form for the project will be opened when the project is 
opened. The form may be modified as desired and then saved by choosing Save Form from the File 
menu.

If the project contains answer sheets, then the worksheet for the project will be shown when the 
project is opened. To work on the form, use the Tool Tidy buttons, or options from the View menu to 
work on the answer sheets and then on the form.

The form may then be modified as required and then saved in the usual way. Some modifications, 
such as adding or removing questions or changing the order of questions will require that the current 
answer sheets be updated to reflect the changes. You will be asked twice to confirm that you are sure 
that the sheets should be updated to your new form.



Aligning Objects
While working on the page various aids are provided to help in neatly arranging and aligning the 
objects;  rulers, grids and 
 guidelines.

Whether you have used these aids or not, there can be times when you wish to ensure that, for example, 
the left or top edges of    a set of objects are aligned perfectly with each other - a difficult operation to 
perform by eye.
The Align sub-menu, (available from the Arrange menu), provides four commands to do this for you 
automatically. Each command you choose operates on the currently selected objects:

Lefts Aligns the objects so that the left hand edges of all the objects are aligned with the left 
hand edge of the object furthest to the left.

Tops Aligns the objects so that the top edge of all the objects are aligned with the top edge of 
the highest object.

Rights Aligns the objects so that their right hand edges are aligned with the right hand edge of 
the object furthest to the right.

Bottoms Aligns the objects so that their bottom edges are aligned with the bottom edge of the 
lowest object.



Layering Objects
As objects are added to the page they are drawn on top of previous objects. This will only become 
apparent when an opaque object overlaps other objects.

For example, if you were working with real paper, you might write some text and draw a rectangle 
round it.    If you then filled in the rectangle the text will then be obscured.    The same thing can happen
with PinPoint, except that you don't have to start again: all you have to do is change the order in which 
the objects are drawn:

1. If you wish to move an object so that it is below all other objects, use the  Pushdown tool to 
click on the object to be "pushed down";

or
2. If you wish to move an object in the middle of a stack of objects, or bring an object or objects to the 
front, select the object(s) to be moved with the Pointer tool and then, from the Arrange menu, choose:
Send to Back to draw the object(s) below all others.
Bring to Front to draw the objects(s) above all others.

Note: The Send to Back and Bring to Front commands appear on the Edit menu when working with 
answer sheets



Paper Setup and Multi-Page Forms
New forms are created as a single page of white paper of the size and orientation as decribed by the 
active printer. Many forms require more than one page. When working on a screen based form, you 
may like to use a background colour for the whole form.

The attributes of the paper may be changed at any time by choosing options from the Questionnaire 
menu.

Choose:

Paper Setup to change the size, orientation or colour of the paper.

Add Page to add a new page to the end of the form.

Delete Last Page to remove the last page from the form.



The New Form
There is a single form, or data collection sheet, at the core of every PinPoint project. To create a new 
form you begin a new project. You can begin a new project in one of several ways:

1. From 'scatch'
Before you begin, choose "Printer setup" from the File menu and check that the printer selected is

your usual default, and that its page orientation corresponds to the form layout you have planned.
From the File menu, choose New Project. A new form will be created as a single page of the size 

and orientation as decribed by the active printer.
The default may be adequate to get your project underway (you can always change it later), or 

you may decide to define your new form's page attributes from the start. To do this, choose 
 "Paper Setup" from the Questionnaire menu and make your new formatting choices in the dialogue box.

2. Based on a previous project or one of the provided examples
Many example projects are provided with PinPoint. You may like to build a new project based on 

the form in one of the examples, or based on your own previous work.
Open the project on whose form you wish to base the new work.
If the project contains no filled-in answer sheets, its form will appear, otherwise, the worksheet for

the project will appear. In this case, to use the form for the project:
From the View menu of the Worksheet, choose Answer Sheets to work on the stack of sheets. 

Then, from the View menu of the Sheet Editor, choose Form to work on the form.
From the Form Editor File menu, choose Save Form As.
Type the new name for the project into the Name box and choose the OK button.
A new project folder will be created containing only the form, the old project is automatically 

closed. You may now make any changes required before saving the form and continuing with the new 
project.

3. Open a file whose format is understood by PinPoint
If the information is in a format understood by PinPoint, PinPoint can automatically generate a 

(admittedly unattractive) form for you; from the File menu, choose 
 Open.

If the information is not in a format understood by PinPoint; use the application used to manage 
the information originally, to create a format understood by PinPoint and then use the above method.

See also:
 Saving answer sheets to a new project



Publishing Forms
If you usually undertake surveys by designing the form, printing and mailing to your respondents, 
Publish Form provides a possible alternative to the ensuing drudgery of entering all the returned and 
completed questionnaires into PinPoint.

If your respondents are equipped with PCs running Windows 3.1 or higher, Publish Form allows you to
produce an electronic copy of the form on disc, the disc can then be mailed (at no additional cost over 
mailing the questionnaire - perhaps cheaper for large forms) to your respondents. They run the 
software (there is no reason to install it on the HD, it should be run from floppy), complete the 
questions and then return the disc. 

Use Import from the file menu to import the completed questionnaires.

See also:
 Publish form dialogue 





Answer Sheet Editor: "How to..."
An Answer Sheet is a completed, or 'filled in', copy of a Form - PinPoint's equivalent of a 'data record'.  
A collection of completed sheets is known as a 'Stack'.

Completing and editing the answers is quick and easy, with the unusual feature of also being able to 
add additional text and graphics to the page, without having had to design a field to hold the 
information.

As well as completing new answer sheets, the Answer Sheet Editor also allows you to browse through 
the completed forms and locate sheets for amendment or deletion.

Opening the Sheet Editor

Completing and editing answers

Adding comments/captions and graphics

Importing and merging data

Working with the stack

Tools



Completing and Editing Answers
Manual data entry can be a slow and painful process. By using a copy of the Form, PinPoint makes 
the chore as clear and simple as possible. Textual answers must, obviously, be entered at the 
keyboard; choices can be ticked using either the keyboard or the mouse, although you may find 
uninterrupted use of the keyboard preferable.

Moving Around the Form

To move directly to an answer, click in the answer area using either the Text (Pen) or Pointer tools.

To move from an answer to the next answer, press TAB, or, if the answer has only a single line or 
choice, press ENTER or DOWN ARROW.

To move from an answer to the previous answer, press SHIFT+TAB, or, if the answer has only a single
line or choice, press UP ARROW.

Saving the Sheet

Typing ENTER at the last question on the form will automatically save the answer sheet. To save the 
answer sheet at any other time, choose  "Save". from the Sheet menu.

Note: Each question has the option Carry over values.    Selecting this option can save time if you 
have data that you know will be repeated within the stack.    If you check this option in a question 
dialogue, the answer given on the previous sheet will be carried over to the next sheet.

Editing answers

Text/general

Numeric

Yes/No and multiple choice

Date

Ordered choice

Calculated



Working With the Stack
The Sheet Editor provides tools and procedures for adding, deleting, browsing and locating sheets.

If the Sheet Editor has been opened by switching the view of the project from the Form or Worksheet, 
all of the answer sheets in the stack may be worked on. However, if the Sheet Editor has been opened
on a particular sheet by double clicking on a sheet in the Worksheet display, only those sheets 
matching the current selection criteria may be worked on.

Adding a new sheet

Turning through sheets

Searching for a sheet

Deleting a sheet

Altering the form

Analysing sheets



Editing Text/general Answers

Textual answers are entered and edited using the standard text editing techniques - the same way as 
text was written and edited with the Pen on the form.

If several lines are allowed in the answer, you may press ENTER to move to the next line, for example,
if entering an address. If you do not press ENTER, text will wrap at the end of a line to the next line 
automatically.

You may cut or copy text using the standard techniques; select the text using any of the available 
methods and then  cut or 
 copy the text to the Windows clipboard by choosing the required option from the Edit menu, or by 

clicking the required Tool Tidy button.

Text on the Windows clipboard may be pasted into a textual answer by choosing  Paste from the Edit 
menu (CTRL+V).



Editing Numeric Answers

Editing a numeric answer is quick and simple. Digits are inserted at the cursor position. To enter the 
decimal of a number either type . or press the RIGHT ARROW key.

Tip After the edit caret first appears in the answer, typing a digit will clear any current answer and 
insert the new digit. To edit an existing answer, use the ARROW KEYS to position the caret and then 
type the changes.    To clear a number you have just typed press the spacebar.



Editing Yes/No and Multiple Choice Answers 

This type of question may be completed using either the mouse or keyboard:

Mouse

To tick a choice, click on it. In the case of Yes/No answers and multiple choice answers in which only 
one choice is allowed, ticking a new choice automatically clears the previous one.

Keyboard

The required answer can also be selected by typing in its index number.    The index numbers for each 
box are displayed when the show numbers option is selected in the Question Details dialogue.

A dotted line will be drawn round the choice to be edited.

To tick the choice: Press SPACE - any other ticked choice will be cleared. To clear the 
tick, press SPACE again.

To move to the next choice: Press ENTER or DOWN ARROW.

To move to the previous choice: Press UP ARROW.



Editing Date Answers

The exact requirements for entering and editing a date depend upon the format specified in the Form 
design. However, short-cuts are available to speed entry for any format :

If no century is given for the year, the current century is assumed.

Each of the formats delimits the day, month and year by some character; typing the delimiting 
character moves the caret to the next part.

For example, if the chosen format is dd/mm/yyyy all of the following can be typed, exactly as shown 
here, to enter a date of 1st March 1994:

1/3/94
01/3/94
01/03/1994

Dates entered must be valid (a blank date is considered valid) before you can move on to the next 
answer.



Editing Ordered Choice Answers

Since the ranking value for each choice is a number, it is edited in the same way as a numeric answer.

PinPoint ensures that each ranking value is in the appropriate range.    A value of zero will be taken to 
mean that the choice is not ranked.



Editing Calculated Answers

Calculated answers cannot be edited directly. As the answer to any and each question which affects in 
the calculation is entered, the calculated answer is updated except for the following functions:

SumScores(), NumScores(), SumNumbers() and NumNumbers()..



Adding a New Answer Sheet to the Stack
When the Sheet Editor is opened and there are as yet no sheets in the stack, a blank form is shown 
ready for completion automatically.

When there are sheets in the stack, a blank form can be presented for completion (rather like tearing 
off a sheet from a pad of blank forms), either:

 Click the New Sheet tool in the Tool Tidy.

- or -

From the Sheet menu, choose  New Sheet.



Adding Comments, Captions and Graphics to an Answer 
Sheet

Many of the writing, drawing and object manipulation tools and procedures found with the Forms and 
Graphics Presentation Editors are also found on the Sheet Editor and may be used to add text, 
rectangles, lines, graphics and embedded files to an answer sheet.

Why?

When designing a questionnaire, it can be difficult to anticipate all the answers that may be given to a 
question. Respondents also often feel the need to express themselves further in answer to a question. 
Using the  Pen tool, any additional answers to a question can be written on the answer sheet.

The  Line (Pencil) tool can be used to draw an arrow or line from the additional text to the answer to 
which it applies.

If you have a particularly long piece of text to add to an answer sheet, you may like to use a suitable text 
editing application such as Write, supplied with Windows, to write the text. Save the text to a file and then 
drag the file from File Manager on to the answer sheet. An icon for the file will appear; double click the file
and Write will be started editing the contents of the file.



Turning through Sheets
You may flip through the Stack of Answer Sheets using either the mouse or the keyboard:

Click on either of the following tools to flip back and forwards through the sheets:

To turn to the previous sheet

To turn to the next sheet

Keyboard:

Previous (CTRL+P) To turn to the previous sheet

Next (CTRL+N) To turn to the next sheet

Last (CTRL+L) To turn to the last sheet

First (CTRL+F) To turn to the first sheet

Note: If the Sheet Editor has been opened from the worksheet, the sheets will be browsed in the order
in which they are currently displayed and only those sheets chosen on the Worksheet may be viewed.



Altering the Form
The form for the project may be modified at any time; new questions added, questions removed or 
amended, additional caption text added or graphical elements modified.

From the Sheet Editor's View menu, choose Form.

Note that if you have opened the Sheet Editor from a worksheet, PinPoint will prompt you
to confirm that the worksheet may be closed before the form is changed.

If a form is to be edited substantially, that is if
Any question fields are deleted
Or any new question fields are added
Or the order of questions on the page is changed
Or the answer type of questions is changed
Or new choices are added to choice type questions

then any existing answer sheets in the project's stack may need to be updated. For this reason, you 
are recommended to take a backup copy of the project before making such changes.

Save changes and update sheets?
When you have completed your alterations to the form click the  Stack tool to return to the Sheet 
Editor window. 

PinPoint will prompt you to save your changes, and will ask you to confirm, twice, that you wish to  
update all the sheets in the current stack.

If you choose "Yes" then all the completed sheets will be updated accordingly. The information currently 
held in the sheets will be preserved wherever possible.

Tool Tidy button:

 

See also:
 Save Form



Importing Data and Merging Projects
The "Import" option appears on the File menu of the Forms, Answer Sheet and Worksheet editor 
windows.

The use of Import allows you to bring information managed in another of your applications into 
PinPoint for further work, especially analysis. Using Import also allows you to merge similar projects 
together. For example, if you have a large data entry task which you have split among several people, 
you can merge each of the projects together to build a single project for the analysis work.

Note: PinPoint does not understand, and is unable to read, all the different file formats created 
by all the applications there are. However, it is able to understand the common file formats. If 
you wish to read from an un-supported format, you must use the application used to originally 
create the data to build a file of your data in one the formats understood by PinPoint. Please see
the README.TXT file supplied with PinPoint for a list of the file formats understood by PinPoint.

Import always adds the imported information as new answer sheets added to those already present.

Before Importing, you should know the type of information to be imported and design a form containing
suitable questions/fields into which the data can be imported. The reference name of the question 
should, ideally, be the same as the field name in the file being imported from. Fields being imported 
from which contain text can be imported into multiple choice answers by writing a question with 
choices whose descriptions are the text that will be come across in the fields.

Using Import

To import the information, from the File menu, choose Import. An Open File dialogue will appear; 
locate the file you wish to import from and then complete the ensuing dialogues. Help is available on 
each of the dialogues by choosing the Help button or by typing F1.

Note: As a 'quick' way of importing information, you can let PinPoint design a (admittedly unattractive) 
form for you. However, PinPoint will not design multiple choice questions/fields, it will import all textual 
information into questions/fields with answer types of Text/General. To "quick" import, from the File 
menu, choose  Open.

See also:
 New Form



Opening the Sheet Editor
To Work With All the Sheets.

From whichever view of the project you are working in, the Form Editor, or the Worksheet, you can 
switch to view the answer sheets in the Sheet Editor from the View menu by, choosing Answer Sheets.
If there are already completed sheets, the first sheet in the stack will be shown. If there are no 
completed sheets, a blank form will be shown ready for completion. In either case, the edit caret will be
positioned in the answer area of the first question. When switching from the Worksheet, the Worksheet
will be closed.

To Work With a Sub-set of Sheets

When working with the Worksheet, you may want to work on a particular sheet. The Sheet Editor can 
be opened directly on the particular sheet by double clicking on its row in the Worksheet.

The Worksheet will remain open and when you browse through the sheets, only those sheets currently
selected on the Worksheet can be seen.

To return to the Worksheet, either close the Sheet Editor or switch to the Worksheet directly by 
choosing Worksheet from the View menu.





Worksheets: "How to..."
The worksheet provides a menu bar containing the commands and procedures for manipulating the 
worksheet and a Tool Tidy giving quick access to the most frequently used facilities. The worksheet 
can be scrolled using the scroll bars with the mouse or via the keyboard using the ARROW KEYS.

Tip: Many of the dialogues displayed when a tool is chosen show a list of the questions in the project, 
from which you select the question to which the procedure should apply. The first selected column of 
the worksheet will be used as the default selection in these lists. So, a useful 'short-cut' when 
repeating procedures for the same question is to select the column title for the question by clicking on 
it.

Editing answer sheets

Worksheet configuration

Sorting sheets

Choosing and selecting sheets

Selecting individual sheets

Statistics

Performing calculations

Exporting information

Producing Graphs, Charts and Tables

Tools



Worksheet Configuration
The first time the worksheet for a project is displayed, the answers to each of the questions on the 
form are shown in columns, arranged in the order they are presented on the form.

The layout of the Worksheet may be easily modified: the display font, column width, order of the 
columns and which columns are shown may all be changed. Once you have set up a    satisfactory 
configuration you can save that setup as a default so that when the project is opened in the future, it 
will use the same layout.

Display font

Changing column widths

Moving columns

Removing columns

Saving the Worksheet Setup

Saving the worksheet saves the current configuration of the worksheet; the font used, columns 
displayed, column widths, etc.. It also saves details of any sort order defined, conditions by which 
sheets are chosen in use and statistics to be displayed.

Saving the worksheet is useful after you have initially configured it to your requirements or when, for 
example, you always wish the sheets to be displayed in a certain order, perhaps sorted alphabetically 
by name.

To save the worksheet, from the File menu, choose Save Setup as Default

See also:

Load/Save Setups



Sorting Sheets - Overview
The Sort Sheets tool (from the Tools menu,choose  Sort Sheets) allows you to sort the sheets into 
order. Sorting can provide a visual overview of your information by grouping similar information. 
Sorting can also be used before producing a graph of textual information to ensure the x axis labels 
appear in order. 

Sorts may be in ascending or descending order with up to 5 levels of nested sorting, i.e. sorting by the 
answer to a question within the answers to other questions. When performing nested sorts, additional 
sorts are added one at a time. The additional sort may be removed without disturbing the previous sort 
order, to allow you to change your mind without having to rebuild the entire sort request.

Tip: If you want to display the sheets sorted into a particular order when the worksheet is opened, 
choose the sort order required and then save the worksheet configuration as a default.

After performing a sort, the details of the sort are shown in the worksheet control panel, along with 
buttons to add an additional sort, or remove the last sort order added:

Sorting procedure



Choosing Sheets
Choosing sheets that match a particular condition, or set of conditions, is one of the major functions of 
the worksheet.

Choosing sheets may be an analysis exercise in itself since it can answer simple questions such as 
"How many of my sample work with computers?". It can also be used in conjunction with other analysis
activities such as plotting graphs or performing cross tabulations. For example, by choosing sheets 
and then plotting a graph, you can answer a question such as "For those in my sample under 35, how 
many eat chicken once a week, twice a week?, etc." 

When choosing those sheets that match a set of conditions, multiple criteria can be specified. If you 
want to see the effect of each condition separately you can choose to enter them one at a time. Any 
condition within a set of conditions can be removed, and further conditions added - at any time, there 
is no need to start all over again.

Finally, you will often apply procedures such as printing and graphing to all or the chosen sheets. 
However, there may be occasions where you wish to apply the procedure to only some selection of the
chosen sheets, and these sheets cannot be easily chosen by adding another condition. In these cases
you may directly  select the sheets to use.

Tip: If you want to always display a particular set of sheets when the worksheet is opened, define the 
conditions required and then save the worksheet configuration as a default.

To Add Conditions:

Click the Tool Tidy tool, or from the Tools menu, choose  Add Condition.
To Add Further Conditions:
Click the Tool Tidy tool, or from the Tools menu, choose  Add Condition, or click the Add Condition button
on the control panel.

To Remove a Condition:

Click the Remove Condition button next to the condition to be removed.

To Remove All Conditions
From the Tools menu, choose  Remove Conditions and Sorting, or click the Reset Worksheet tool in the 
tool tidy.
Tip: If you always wish to display a particular set of sheets when the worksheet is opened, define the 
conditions required and then save the worksheet setup as a default.



Exporting Information
PinPoint provides comprehensive and easy to use tools for analysing information.    However you may 
also like to use another application, such as a spreadsheet, to perform some analyses.

PinPoint provides various methods for exporting information for use in other applications; saving 
Answer Sheets to a file which can be imported into your other application, or copying the Answer 
Sheets to the Windows clipboard from where they can be pasted into another application.

Alternatively, you may wish to export your Answer Sheets for importing into a database application, or 
create a new PinPoint project containing just some of the sheets from the current project.

Note: The graphing facilities within PinPoint allow you to perform various frequency analyses.    The 
results of these analyses can also be copied to the clipboard.

Exporting answer sheets to a file

Copying answer sheets to the Windows clipboard

Creating a new project

See also:

Exporting Analysis Results



Changing column widths
The initial available display width of a column depends upon the font used for the worksheet and the 
type of the answer to be shown. Textual answers are then displayed in the available width, and word-
wrapped when necessary. Other answers are not word wrapped; instead, only part of the answer will 
be visible. 

Columns may be re-sized to make more efficient use of space, display the most information, or create 
the most pleasing presentation.

To change the width of a column:

1. Point to the right hand edge of the column.

The cursor will change to show that you may re-size the column.

either:
Click and drag right to expand the width of the column.

- or -
Click and drag left to reduce the width of the column.

If you reduce the width to zero, (by dragging the right margin beyond its left margin), the column will
be removed. Any other columns between the new left margin and the column being re-sized will 
also be removed).



Moving Columns
While working on the worksheet, it may be convenient to rearrange the columns. For example, if you 
wish to examine the answers to two particular questions it is easier to have those columns of answers 
next to each other.

Columns can be moved one or several at a time but columns which are part of a Question Group 
cannot be moved outside that Group's bracket (shown above the columns with the Group's name), 
only moved around within it.    The same principle applies to columns that are part of a 
Question Table. Similarly columns which are not members of a Question Group or Question Table 

cannot be dragged inside them. 

To Move a Single Column

1. Point to the title of the column to be moved.

2. Click and drag the title of the column you wish to move to the left of the column where you 
wish to place it.

3. Release the mouse button and the columns will be rearranged.

To Move a Selection of Columns

Note, if the columns to move are all members of groups, move the group or table - see below.

1. Select the columns to be moved:
Select the first column to move by clicking the column title.
If the columns to move are all next to each other, point to the last column in the group, hold down 

SHIFT and click the column title.
If the columns are not next to each other, point to each column to be moved in turn and click the 

column title while holding down CTRL.
2. Click on any of the selected columns and drag the column titles to the left of the column where 
you wish to place them.

3. Release the mouse button and the columns will be rearranged.

To Move a Question Group or Question Table

1. Point to the bracket above the Group or Table's columns.

2. Click and drag the bracket to the left of the column where you wish to place it.

3. Release the mouse button and the Group or Table will be moved.

To De-select Columns

Columns selected by this process can be de-selected by clicking on the column(s) title or bracket while
holding down CTRL. However, note that the first selected column is used as the default selection in the
question lists that appear in many of the dialogues that ensue from using a worksheet tool.



Removing Columns
Worksheets will often contain many columns which can be distracting if you are investigating one 
aspect of the information. For this reason PinPoint allows you to remove columns temporarily from a 
Worksheet display. These columns can be replaced easily when required. 

When a column has been temporarily removed its heading will not be shown in any of the lists in the 
dialogues, this makes selecting appropriate headings more straightforward. 

Note: If a calculated column is removed from the display, it is deleted and cannot be put back

To Remove a Single Column

1. Point to the title of the column to be removed.

2. Click and drag the column title out of the column titles area, either above or below the titles 
area.

The cursor will change to that of the Question tool, but with a cross through it, to indicate that the 
column will be removed.

3. Release the mouse button and the column will be removed.

To Remove Several Columns

Note, if the columns to remove are all members of groups, remove the group or table - see below.

1. Select the columns to be removed:
Select the first column to remove by clicking the column title.
If the columns you wish to remove are next to each other, point to the    last of the columns, hold 

down the SHIFT key and click on the column title. All the columns between the first and last columns you 
clicked will be selected.

If the columns to be removed are not next to each other, hold down the CTRL key, then point to 
each column in turn and click on its column title. 

2. Click on any of the selected columns and drag the column titles out of the titles area, either 
above or below.

The cursor will change to that of the Question tool, with a cross through it, to indicate that the 
selected columns will be removed.

3. Release the mouse button and the columns will be removed.

To Remove a Question Group or Question Table

1. Point to the bracket above the Group or Table's columns.

2 Click and drag the bracket out of the Group or Table name area, to a position either above or 
below it. The cursor changes to a Question tool, but with a cross through it, to indicate that 
the selected Group or Table will be removed.

3. Release the mouse and the columns are removed from view.

To Put Back Removed Columns, Groups or Tables

Using the mouse:

1. Point to anywhere in the column titles area and click the right hand mouse button. A pop-up 



menu will appear.

2. Select the Questions or Groups from the pop-up menu and 

Using the keyboard:

From the View menu choose Put Back, select Questions or Groups then select the column or 
Group to be put back on the worksheet or All to put everything back. (Tables are also listed under 
the item Groups).



Editing Answer Sheets
To switch the view of the project from the worksheet to the answer sheets in the Sheet Editor either 
click the Answer Sheets tool in the Tool Tidy, or, from the View menu, choose Answer Sheets. The 
Sheet Editor will then appear showing the first sheet in the stack.

Alternatively, if you only wish to modify or examine a particular sheet in the stack, double click on the 
row containing the sheet's answers. The Sheet Editor will then appear showing the sheet requested.

Note: Browsing or searching through the sheets turns through only those sheets currently chosen on 
the worksheet, in the order they are displayed on the worksheet.



Worksheet Display Font
The display font initially used is the default, usually 10 point Arial. More information can be made 
visible at one time by using a smaller point size. The font used for display is also that used to  print 
the worksheet and you may like to choose a different font.

From the View menu, choose Font.
The standard Font Style dialogue will appear.
Choose the font, style and size required and then choose the OK button.
Note: Both fonts provided by your printer and fonts only available on the screen are listed. If a screen 
only font is chosen and the worksheet is then printed, the closest matching font available on your printer 
will be used when printing.



Selecting Individual Sheets
A single sheet:

Click the row showing the sheet, any other selected sheets will be de-selected.

Another sheet:

Hold down CTRL and click the row showing the sheet. Clicking a selected row will de-select the sheet.

A contiguous range of sheets:

Select the first sheet in the range, hold down SHIFT and select the last sheet in the range.

Discontinuous ranges of sheets:

Select the first range of sheets. For subsequent ranges, select the first sheet in the range while holding
down CTRL and select the last sheet in the range while holding down SHIFT.



Creating a New Project
A new PinPoint project may be created, based on the same form, but containing just some of the 
answers sheets from the current project. This may be of use if, for example, you wish to provide 
someone else with a copy of a sub-set of your information.

Note: Only the form and answer sheets are copied to the new project. The worksheet configuration 
details and any presentations are not copied.

1. If only a sub-set of the answer sheets are to be copied, choose the sheets by using  
conditions or by selecting the 

 individual sheets.
2. From the File menu, choose Save Sheets As - the Save Sheets As dialogue will appear.
3. Ensure "PinPoint project" is shown in the File Types box.
4. Type the name for the new project into the File Name box.
5. Select the required drive and directory for the new project.
6. Select which answer sheets are to be copied from the Sheets group of options either; all the 
sheets, the chosen sheets or the selected sheets.

7. Choose the OK button.

The new project will then be created.



Exporting Answer Sheets to a File
Answer sheets can be written to a text file which can then be read into another application. Each 
answer sheet is written as a single line in the file, and each answer is separated by some delimiter 
character; comma in Comma Separated Value (CSV) files or TAB in Tab Separated Value (TSV) files. 
Nearly all applications, from word processors to databases, can read information stored in one of 
these formats - see your applications documentation for details on how to read such files.

All or just some of the Answer Sheets may be written to the file and all or just some of the answers for 
each of the sheets.

1. Only the answers from the currently shown columns will be written to the file so make sure 
that all the columns you want are displayed in the order and column width you require before 
proceeding.

2. If only a sub-set of the Answer Sheets are to be written, choose the sheets by using  
conditions or by selecting the 

 individual sheets.
3. From the File menu, choose Save Sheets As - the Save Sheets As dialogue will appear.

4. From the List Files of Type box, select the type of text file to write, either CSV or TSV.

5. Type the name for the file into the File Name box.

6. Select the required drive and directory for the new file.

7. Select which Answer Sheets are to be written from the Sheets group of options: all the 
sheets, the chosen sheets or the selected sheets.

8. If the file will be read by a Windows application, ensure the Windows option is chosen in the 
Character Set group of options, otherwise choose the DOS option.

9. Choose the OK button.

The chosen sheets and answers will then be written to the file. Switch to your other application and 
use its facilities to import the information:



 Load/Save Setups
The Load/Save Setups palette allows you to save and load different Worksheet configurations. If you 
have set up a sort or choosing sheet criteria, you can also save them. These configurations are 
independent of the Worksheet, and can therefore be applied to any Worksheet which is opened.

Click on the Load/Save Setups Tool in the Tool Tidy, or select  Load/Save Setups from the Tools 
menu.

The Load/Save Setups Palette appears:

You then have a choice of loading, saving and deleting three types of configuration.

Note: The Load/Save Setups Palette stays in the Worksheet foreground, and can be removed by 
clicking the Load/Save Setups button in the Tool Tidy again, or, by re-selecting Load/Save Setups from
the Tools menu.

Worksheets
If the Worksheets option button is clicked you are able to load, save and delete Worksheet 
configurations. Saving a Worksheet from here will save all the configurations that you have made to 
the current Worksheet. Deleting a Worksheet from here will not delete the whole Worksheet, only the 
Worksheet configurations that you have saved from here.

Sorts
If the Sorts button is clicked you are then able to load, save and delete any Sorts applied to the 
current Worksheet. These Sorts are saved independently and can be reloaded and applied to any 
current Worksheet in the same Project.

Sets
If the sets button is clicked you are then able to load, save and delete any Conditions for choosing 
sheets applied to the current Worksheet. These Sets of conditions are saved independently and can 
be reloaded and applied to any current Worksheet in the same Project.

To Save a Configuration

1 Set up the configuration on the current Worksheet.

2 Bring up the Load/Save palette as described above, if it is not already visible.

3 Choose whether you want to save a complete Worksheet configuration, a Sort configuration, 
or a Conditions configuration by clicking on Worksheets, Sorts or Sets respectively.

4 Point to the configuration name window in the Palette window (the pointer will turn into the 
text caret), and click.

5. Type in a name for the configuration. You may use any name up to 24 characters long; the 
more precise the better.

6. Click on Save in the palette window.

To Load a Configuration

1. Bring up the Load/Save palette as described above, if it is not already visible.

2. Choose whether you want to load a complete Worksheet configuration, a Sort configuration, 



or a Conditions configuration by clicking on Worksheets, Sorts or Sets respectively.

3. Click on the down arrow to the right of the Configuration name box to drop down a list of 
Configurations. Then click on the Configuration that you wish to load ( or apply to the current 
Worksheet in the case of Sorts or Sets). .

4. Click on Load in the palette window.

To Delete a Configuration

1. Bring up the Load/Save palette as described above, if it is not already visible.

2. Choose whether you want to load a complete Worksheet configuration, a Sort configuration, 
or a Conditions configuration by clicking on Worksheets, Sorts or Sets respectively.

3. Click on the down arrow to the right of the Configuration name box to drop down a list of 
Configurations. Then click on the Configuration that you wish to delete ( or apply to the 
current Worksheet in the case of Sorts or Sets). .

4. Click on Delete in the palette window.





Graphics Presentation: "How to..."
The Graphics Presentation Editor is a Page Editor. The standard tools for writing on the paper to add 
headings and captions, to draw borders, and manipulate objects, are all available.

As with the paper for the Form, paper for Presentations may have many sheets.

While working with the editor, you may:
Prepare a complete presentation of results, ready for printing.
Simply prepare one or two graphs with associated headings etc. to be copied to the Windows 

clipboard for pasting into another application being used to assemble a complete report.

Working with graphs

Working with crosstab tables

Working with the presentation and objects

Working with text

Backgrounds, borders and graphics

Saving, opening and deleting presentations

Tools



Working With Graphs
When a graph is first drawn, it will occupy an area on the paper approximately 10 centimetres by 10 
centimetres. You will almost certainly wish to modify the graph in some way, for example, by changing 
its size. You may also wish to alter its presentation style, labelling, legends, colours, axis ranges, etc. 
All of these can be changed. Once you are satisfied with the result you can add  headings, 
 borders, highlights and other graphics    (using the standard tools in the Tool Tidy ) to complete the 

presentation.

Almost any aspect of the presentation of a graph can be changed, except the information it presents. 
For example, a graph of frequency analysis where the absolute values are shown, cannot be changed 
into one where the percentages of total frequency are shown.

Several tools are used to work on graphs:
The Pointer Tool is used to move the graph around the paper. It is also used to re-size the graph.
The Pointer Tool is used to modify the style of presentation, legends, axis ranges, etc.
The Pen Tool can be used to modify or change the font style used for label text.
The Eraser Tool can be used to remove the graph from the page. Using the Eraser on any 

component on the graph will remove the whole graph. However, when only a legend is removed the graph
remains intact.
Working with Graphs

Moving and resizing a graph

Working with Pie charts

Editing graph labels and legend text

The Modify Graph dialogue box

Erasing a graph



 Working with Text
Any of the label text around a graph - division labels, axis labels and legend text - can be modified in 

the usual way using the  Pen (or Text) Tool.
Click in the text to display the edit caret and type any modifications required.

Note that vertical text (running from bottom to top), such as that used to label the vertical axis of 
graphs, can also be edited in this way.

Double click in the text to open the Font style dialogue and change the style of the text.

The style of vertical text can also be changed in this way, but it will remain vertical text, you cannot 
change it to horizontal text.

Any text around the graph can also be moved and re-formatted in the usual way with the  Pointer tool.
IMPORTANT
Modifications made in this way will be lost if the whole graph is modified in any way, for example if it is 
resized or its style is changed. This is because the complete graph has to be re-drawn from the original 
information. In such cases you can make various changes to label text and the fonts used by clicking on it
with the right mouse button and selecting Graph Properties from the pop-up menu to obtain the  Modify
Graph dialogue. Improved results may also be achieved by using a different or smaller font for the labels.



Working with the Presentation and Objects

Paper setup and multi-page presentations

Viewing your work area

Moving and resizing objects

Aligning objects

Layering objects

Saving a presentation

Design guides
PinPoint's design guides - the guidelines, 'magnetic' grid and rulers selectable from the  View 
and 

 Arrange menus - will enable you to lay out your presentation with great precision.
If you intend to print you presentation, it is also a good idea to enable "Show printable area" from 

the View menu. The shaded box that this command draws around your page to denote the area in which 
your printer cannot print forms a good visual reference to the page area available to you.

Hint: Use the Tool Tidy's "Fit window", "Fit Window Sideways" and "100%" buttons to zoom in 
and out as you work to keep a check on overall page layout and the relative size and position of 
elements on your presentation.



Moving and Resizing a Graph
Graphs, other than Pie charts, may be moved and resized with the  Pointer tool in the same way as 
any other objects on the page

Moving a Graph

1. Select the graph 

2. Drag it to the required position.

The graph will move as the pointer is moved.

To resize a graph:

1. Select the graph.

2. Drag one of the handles.

The graph will then be re-drawn within the new size. As a result axis ranges, divisioning and 
presentation of labels may change.



Working with Pie Charts
Pie charts are unusual in that individual slices of the pie may be manipulated. Each slice may be 
moved independently to create 'exploded' Pie charts, and the colour and fill style of each slice may be 
changed individually. However, these changes are lost (for example by selecting labelling options if the
overall Pie chart style is changed (for example by selecting labelling options), or the chart is resized.

Resizing a Pie Chart

To resize a Pie chart, use the Pointer Tool to select the whole of the Pie chart then drag one of the 
handles. Pie charts are always circular, so the chart should be resized by reducing or increasing both 
the width and height of the chart. In other words, drag diagonally towards or away from the opposite.

Tip Clicking on a slice of the chart will select that slice. To select the whole chart, hold down CTRL 
while clicking on any component of the Pie chart.

Changing the Style of a Slice
1. Position the Pointer tool on the slice you wish to change.

2. Click the right hand mouse button and choose Pie Segment Properties from the pop-up menu, 
OR hold down the ALT key and double click.

The  Pie Segment Style dialogue will appear.

3. Choose a fill style and colour.

4. For added effect, the outline of the slice can be drawn in a thick line and in any desired colour.

5. Click on OK.

Exploding Slices

Since resizing or modifying the overall style of a Pie chart causes exploded slices to be snapped back 
into the chart, slices should only be exploded once the overall presentation of the chart is satisfactory.

To explode a slice, simply use the Pointer Tool to move the slice to the desired position.



Saving a Presentation
When the paper for a presentation is first created (by plotting or drawing to 'new' paper), it is untitled 
and attached to the project which produced it. Graphs and tables derived from information from other 
projects can be added to the paper but it still remains attached to the original project.

Presentations may be saved to the project file so that they are available for future reference, or for 
adding further work at a later time.

To Save an Untitled Presentation
1. From the File menu, choose Save Presentation or Save Presentation As. The Save Presentation 

As dialogue will appear.

2. Type the name for the presentation into the Name box (maximum 24 characters, any characters 
are allowed). The name must be unique within the project.

3. Click on OK.

To Save a Presentation under a New Name
a 'copy' of a presentation can be made by saving it with a new name:

1. Select Save Presentation As from the File menu. The Save Presentation As dialogue will appear.

2. Type the name for the presentation into the Name box (maximum 24 characters, any characters 
are allowed). The name must be unique within the project.

3. Click on OK.

To Save a Modified Presentation

Once a presentation has been saved to the project file, modifications can be saved to the file simply by
choosing Save Presentation from the File menu.



Paper Setup and Multi-Page Presentations
New presentations (by plotting or drawing to "new" paper) are created as a single page of white paper 
of the size and orientation as described by the active printer. The paper is untitled and attached to the 
project from which the graph or table was produced. Graphs and tables derived from information from 
other projects can be added to the paper, but it remains attached to the original project.

When further graphs and tables are plotted or drawn on the paper, they are drawn in an area of free 
space on the paper (new graphs always occupy an area approximately 10cm by 10cm). If there is no 
free space, a new page is automatically added to the paper to accomodate the new graph or table.

Additional space may also be created on your paper using the  Insert Paper Tool.
You may change the attributes of the paper to your own requirements at any time by choosing options 
from the  Paper menu.
Choose:

Paper Setup to change the size, orientation or colour of the paper.

Add Page to add a new page to the end of the form.

Delete Last Page to remove the last page from the form.



Working With Crosstab Tables
Crosstab tables are fixed in format and very little modification can be made:

Any text in the table and its style may be modified in the usual way with the 
 Pen tool.

The table may be resized using the Pointer Tool, however, "true" resizing does not occur. For 
example, text does not reformat within a reduced width for each column. Instead, the grid lines and border
of the table are scaled proportionally, and the position of the text( but not its size) is adjusted accordingly.



Saving, Opening and Deleting Presentations
When the paper for a presentation is first created (by plotting or drawing to "new" paper), it is untitled 
and attached to the project from which the graph or table was produced. Graphs and tables derived 
from information from other projects can be added to the paper, but it remains attached to the original 
project.

Presentations may be saved to the project file so that further work can be added later or so that the 
presentation is available for future reference.

To Save an Untitled Presentation
1. From the File menu, choose Save Presentation or Save Presentation As.

The Save Presentation As dialogue will appear.

2. Type the name for the presentation into the Name box (maximum 24 characters, any characters 
are allowed). The name must be unique within the project.

3. Choose the OK button.

To Save a Presentation Under a New Name

A copy of a presentation can be made by saving it with a new name:

1. From the File menu, choose Save Presentation As.

The Save Presentation As dialogue will appear.

2. Type the new name for the copy of the presentation into the Name box (maximum 24 characters,
any characters are allowed). The name must be unique within the project.

3. Choose the OK button.

To Save a Modified Presentation

Once a presentation has been saved to the project file, modifications can be saved to the file simply by
choosing Save Presentation from the File menu.

Opening a Presentation

A previously-saved presentation in a project may be opened while viewing the worksheet or another 
presentation in the project.

1. From the File menu, choose Open Presentation.

The Open Presentation dialogue will appear in which the presentations currently filed in the 
project are shown.

2. Either double click the name of the presentation to be opened from among those listed, or type 
the name into the box and press ENTER.

Deleting a Presentation

To delete a presentation filed in a project:

1. Open the presentation.

2. From the File menu, choose Delete this Presentation.

3. You will be asked to confirm that you wish to delete the presentation. If you are sure that you 
wish to do so, choose the Yes button.

The presentation will then be removed from the project file, but it will remain open and could be saved 



again. You will only actually lose the presentation when you close the project.



Erasing a Graph
A graph may be removed using any of the standard techniques for deleting objects. For example, the Eraser 
tool can be used to remove the graph from the page.

Deleting any component object of the graph will remove the whole graph, except when a legend is removed, in 
which case the graph remains.



Editing Graph Labels and Legend Text
To alter the main axis labels or the text used for any legend applied to the graph, or to add a legend, double 
click on the graph and specify your changes in the  Modify Graph dialogue.

Minor modifications, once the overall presentation of the graph is satisfactory, may be made to these items, and the 
division label text by  editing the text with the Pen tool.





Paper Setup
This dialogue box appears when you choose  "Paper setup..." from the Paper menu.

Click on the picture for more information.



Import From Field
This dialogue box appears when you double-click on a source field name in the "From field" list box of 
the  "Import" dialogue box.

To Question



Import Dialogue
After reading the descriptions of the fields and data types present in the file being imported from, 
PinPoint attempts to match them with the questions in the project. This dialogue shows the results of 
that matching, listing the fields found to be imported from and the question the data will be imported to.
You now have an opportunity to check that PinPoint's matching is correct and make any amendments 
required.

From field

To Question

When you have 'mapped' all the fields in your source file as required, choose "OK".

The data will then be imported as required.



Import From Text File
This dialogue box appears when you choose to import a CSV or TSV text file using the  "Open..." or 
 "Import..." commands from the File menu.

First line contains field names. The first line of the file is shown to help you to make the decision.

Character set

PinPoint interprets the type of information in CSV files as follows, and in the following order:
If a field is surrounded by double quotation marks it is assumed to be a character field.
If a field contains only digits or a full stop it is assumed to be numeric.
If a field contains only digits and the date component delimiter character, and it is a valid date, it is

assumed to be a date.
If a field contains "Yes", "No", "True" or "False" it is assumed to be suitable for a Yes/No question 

field.
If the contents of the field can be matched to the choices available to a Multiple choice question 

field, it is matched to that question field.

If none of the above conditions are met, then information is assumed to be text.



Copy Question
This dialogue box appears when you  Paste or 
 "Quick Copy" a complete question into a form.

Click on the picture for more information.



Statistics
This dialogue box appears when you choose  "Statistics..." from the Worksheet Tools menu, or when 
you click on the Statistics button from a Worksheet window.

Question

Statistics

Show for

"OK"

Hint

Analysis Worksheets: How to...

To re-size or close the Statistics window



Question: Text/General Answers
Text/General answers are used where some text is to be given, for example, a persons name or a 
description of some sort.

To provide flexibility in the presentation of the form, the area in which the text is to be entered may be 
presented in one of a variety of ways, as a number of lines, a box for some comment or as a formatted
(picture) area in which you wish to control the characters that can be entered.

The lower part of the "Question" dialogue box will change to look like this when you choose the 
"Text/general" option.

Click on the picture for more information.



Question: Numeric Answers
An answer type of Numeric is used when a numerical answer is required; for a persons age or a 
measure of temperature for example.

To aid accurate completion of the form, the units of the required answer can be described and checks 
to ensure entry of values within a certain range.

The lower part of the "Question Details" dialogue box will change to look like this when you choose the
"Numeric" option.

Click on the picture for more information.



Question: Date Answers
Hopefully, the answer type Date is self explanatory    use it when a date is required in response to a 
question. PinPoint will accept any AD date up to the year 9999.

Several different formats of date entry are available. The formats in which days and months are 
entered as numbers take account of your short form date format settings of the International section of 
the Control Panel.

The lower part of the "Question" dialogue box will change to look like this when you choose the "Date" 
option.

Click on the picture for more information.



Question: Multiple Choice Answers
Multiple choice answers present the respondent with choices from which they are to choose one or 
more by ticking the box. An assortment of styles of tick box is available.

A multiple choice answer is preferable to a textual answer since the answers that can be given can be 
controlled. For example, one might ask How many times a week do you eat chicken?. If the 
respondent were allowed to write an answer in, all sorts of variations for the same answer would be 
received; 3 times, 3, Three, etc. This variation in answer would make accurate analysis very difficult.

The lower part of the "Question details" dialogue box will change to look like this when you choose the 
"Multiple choice" option.

Click on the picture for more information.



Question: Ordered Choice Answers
An answer type of Ordered Choice is one where a set of choices are to be placed in numerical order of
preference.

During analysis, the popularity of each choice can be determined; a measure of the number of times 
the choice was placed first, second, third, etc.

The lower part of the "Question" dialogue box will change to look like this when you choose the 
"Ordered choice" option.

Click on the picture for more information.



Question: Calculated Answers
Calculated answers may be useful when some value is to be determined from other answers and the 
calculated value is to be shown on the completed answer sheets.

The calculation may be either a simple formula using answer values from any questions (except 
ordered choice but including other calculations), and  functions or may be a complex expression 
using 
 IF ... THEN ... ELSE ... to calculate a result depending upon the result of some 
 test, for example testing the answer to a question.

The result of the calculation may be a number, a date, or some text depending upon the types of 
answer values used in the calculation and how they are used. The type of the result is automatically 
determined by PinPoint.

The result may displayed using one of the styles available for the type of answer to the calculation.

Note: Calculations can be performed on the project worksheet. Calculated questions need only be 
used when you wish to see the result of the calculation on each answer sheet.

The lower part of the "Question" dialogue box will change to look like this when you select the 
"Calculated" radio button.

Click on the picture for more information.



Grid
This dialogue box appears when you choose  "Grid..." from the View menu.

Click on the picture for more information.



Zoom
This dialogue box appears when you choose  "Zoom..." from the View menu.

Click on the picture for more information.



Area Chart Properties
Area graphs cannot be plotted for numeric information.

As a single series graph, an area graph is effectively a filled line graph.

For multi-series graphs, the area graph may be a filled ribbon graph or, by using stacked areas, 
illustrate cumulative values for matching responses and how each series contributes to the total.

Area fill style

Tick marks

Grid lines

Legend

Style gallery
Click on a style icon.



Bar Chart Properties
Bar graphs represent the value for each response in a series as a bar. The values are plotted against a
y-axis scale that may be linear or logarithmic and are plotted as their deviation from the y-axis origin. 
The origin of the axis may be specified to be a value other than zero. For example, if the y-axis shows 
temperatures recorded in degrees fahrenheit, one might set an origin at 32 so that the bars show the 
deviation of temperatures from freezing point.

Bar spacing

Options

Tick marks

Grid lines

Bars

Legend

Style gallery
Click on a style icon.



Column Chart Properties
Like pie charts, column charts illustrate the contribution made by each response to the whole and the 
comparison between the contributions made by different responses. The first value in the series is 
plotted at the bottom, subsequent values are stacked on top in order. A column chart can only show 
the results of analysis from a single series so there is only a primary style dialogue.

Segment fill style

Options

Style gallery
Click on a style icon.



Line Chart Properties
Line graphs plot the values for each response with connecting lines. They are useful for showing 
trends, for example a variation over time. 3D effects may be used to plot a ribbon rather than line 
graph. In either case the axes may be reversed; the x-axis becomes the vertical axis and the y-axis 
becomes the horizontal axis. This is most often useful when plotting graphs with long textual labels on 
the x-axis, reversing the axes provides more room for the labels.

Line

Points

Tick marks

Grid lines

Options

Legend

Style gallery
Click on a style icon.



Pie Chart Properties
Pie charts illustrate the contribution made by each response to the whole and the comparison between
the contributions made by different responses. A pie chart can only show the results of analysis from a 
single series so there is only a primary style dialogue.

After the chart has been plotted on the paper, any segment can be exploded from the chart to provide 
emphasis by moving the segment with the Pointer tool.

Segment fill style

Options

Style gallery
Click on a style icon.



Scatter Chart Properties
Scatter graphs plot the values for each response as a point. In general, a scatter graph looks the same
as a line graph without the connecting lines.

However, when the responses to a numeric question are plotted against the response to another 
numeric question, each value pair is plotted as a point (any class interval defined is ignored). For 
example, you might want to show the relationship between salary and length of employment or 
between weight and height. In these cases, a line of best fit can be drawn through the points. The 
equation for the line and linear correlation coefficient for the line are also shown.

Points

Tick marks

Grid lines

Plot line of best fit

Legend



Question: Yes/No Answers
An answer type of Yes/No should be used when you require a "True" or "False" answer to a question 
such as "Are you married?". If you are familiar with typical database applications, the Yes/No type 
answer is equivalent to the Boolean field type.

By default, possible answers of Yes and No are provided. These "True" and "False" descriptions may 
be changed to any required.

Click on the picture for more information.

Tip: While it is possible to write a question such as "Your sex:" with available answers of "Male" and 
"Female" as a Yes/No type question. It is recommended that this is not done since it may cause some 
confusion when analysing answers and can cause difficulty if attempting to import information from 
another source - use a multiple choice question instead.



Question Dialogue
In the Question dialogue you complete the description of the question:

1. The text of the question, framed in any way desired.

2. A short reference name for the question.

3. A description of the type of answer required, or type of data to be entered.

4. Advanced question functions.

Choose a topic for more information:

Question text

Reference name

Font

Must be answered

Carry over value 

Text/general answers

Numeric answers

Yes/No answers

Date answers

Multiple choice answers

Ordered choice answers

Calculated answers

Advanced...

See also:
 Working with Questions



Sort Sheets
This dialogue box appears when you choose  "Sort sheets..." from the Worksheet Tools menu, or 
when you click on the Sort button from a Worksheet window.

Click on the picture for more information.



Choose Sheets
Use this dialogue to describe your criteria for choosing the sheets to display on the Worksheet.

You can use the dialogue to describe a single condition or add a single condition to those already 
present. Alternatively, use the dialogue to describe the full set of conditions.

Single Condition

Conditions can be added one at a time by repeated use of the dialogue. This is useful to see the effect 
of each condition.

If there are currently no conditions, describe the condition and then click OK.

If there are already conditions, describe the new condition and then click either AND or OR.

Set of Conditions

If you know all the conditions you wish to use, they can be described one at a time in a single use of 
the dialog. For each condition:

Describe the condition and then click <<AND or <<OR to add the condition to those alredy defined.

Once all the conditions are defined, click OK.

To describe a condition:

Question

Condition

Test value

Criteria list

Analysis Worksheets: How to...

Worksheet control panel:



Search Sheets
This dialogue box appears when you choose  "Search..." from the Sheet Editor Sheet menu, or when 
you click on the Search button from a Sheet Editor window.

Click on the picture for more information.



New Column
This dialogue box appears when you choose  "Add new column..." from the Worksheet Tools menu, 
or when you click on the New Column button from a Worksheet window.

Click on the picture for more information.



Modify Graph
Using this dialogue, you may change every presentation aspect of a graph:

In a multi-series graph, the order of display of the series - use the Series List and re-order series 
buttons.

The basic presentation style of each series - choose the series from the Series List and then 
choose a new style from the gallery.

Overall presentation style of the graph such as grid lines, use of logarithmic y-axis scales, 
presence of legends etc. - choose the first series in the Series List and then choose the Style detail 
button.

Presentation style details for a series such as colour or the text to use for a the legend entry for 
the series - choose the series from the Series List and then choose the Style detail button.

The ranges to use and intervals for each axis - type the required values into the boxes.
The main labels to use for each axis - choose the Labels and Fonts button.
The font to use for labels - choose the Labels and Fonts button.

Note: Double clicking on a series in the Series list will give the properties dialogue for the series

Series list

Re-order series

Delete series

Style gallery

Style detail

Labels and fonts

X-axis and Y-axis ranges

Graphics Presentation: Editing a graph



Add Bar Chart to Graph
This dialogue box appears when you  add a bar chart to an existing graph.

Bar spacing

Bars

Legend

Note that you cannot change a chart's style gallery option, nor a graph's Tick mark, Grid line and Axis 
scaling attributes from an "Add chart" dialogue box. These are defined for all series by the style of the 
first chart to appear in the "Series" panel of the  "Modify graph" dialogue box.

To change these attributes, select the first entry listed in the "Series" panel and choose "Define styles". 
Use the    << | >>    buttons to re-define the series listing order if required.



Add Line Chart to Graph
This dialogue box appears when you  add a line chart to an existing graph.

Line

Points

Note that you cannot change a chart's style gallery option, nor a graph's Tick mark, Grid line and Axis 
scaling attributes from an "Add chart" dialogue box. These are defined for all series by the style of the 
first chart to appear in the "Series" panel of the  "Modify graph" dialogue box.

To change these attributes, select the first entry listed in the "Series" panel and choose "Define styles". 
Use the    << | >>    buttons to re-define the series listing order if required.



Add Area Chart to Graph
This dialogue box appears when you  add an area chart to an existing graph.

Area fill style

Note that you cannot change a chart's style gallery option, nor a graph's Tick mark, Grid line and Axis 
scaling attributes from an "Add chart" dialogue box. These are defined for all series by the style of the 
first chart to appear in the "Series" panel of the  "Modify graph" dialogue box.

To change these attributes, select the first entry listed in the "Series" panel and choose "Define styles". 
Use the    << | >>    buttons to re-define the series listing order if required.



Add Scatter Chart to Graph
This dialogue box appears when you  add a scatter chart to an existing graph.

Points

Plot line of best fit

Note that you cannot change a chart's style gallery option, nor a graph's Tick mark, Grid line and Axis 
scaling attributes from an "Add chart" dialogue box. These are defined for all series by the style of the 
first chart to appear in the "Series" panel of the  "Modify graph" dialogue box.

To change these attributes, select the first entry listed in the "Series" panel and choose "Define styles". 
Use the    << | >>    buttons to re-define the series listing order if required.



Graph Labels and Fonts
This dialogue box appears when choose "Labels and Fonts" from the  "Modify graph" dialogue box.

Note: The techniques described here are the preferred way of modifying axis label text and fonts rather 
than using the Pen tool, since the changes will be maintained if the graph is further modified or resized; 
changes made with the Pen tool are lost.

Tick labels

Axis labels

Label text



Variable Class Intervals
This dialogue box appears when you choose a variable class interval in the  "Plot graph" and 
 "Cross tabulations" dialogue boxes.

Click on the picture for more information.



Pie Segment Properties
This dialogue box appears when you double-click on a Pie chart segment with the Pointer tool

Fill

Outline



Legends
A legend can be added to bar, line, area and scatter graphs.

Whether a legend is present, and its style, are chosen from the primary style dialogue of the first series
in the graph. For subsequent series, the legend text for the series can be given.

To specify the use of a legend:

1. Check the Add legend option.

2. Type the text for the legend for the first series.

3. Choose whether a border is to be drawn round the legend entries and its style.



Legend Text
A legend can be added to bar, line, area and scatter graphs.

Whether a legend is present, and its style, are chosen from the primary style dialogue of the first series in the 
graph. For subsequent series, the legend text for the series can be given.

If a legend is being added, type the legend text for the series into the box.



Crosstab Titles
Before generating and printing the table, use this dialogue to specify any titles to be added to the table.
Two lines of title may be added, a main heading and sub-heading. Type any titles required into the 
boxes.

When printed, the titles will be centred above the table, which will be centred on the paper (after any 
necessary fitting of the table to the paper).



 
Functions

A set of standard functions are provided for use in calculations. The functions dialogue lists the 
functions available.

To use a function:
1. Choose the function from the list.

The right hand side of the dialogue will describe what the function does and the arguments 
required for the function.

2. If the function does what you require, choose Paste and the function will be added to your 
calculation.

Function arguments
Any type of answer value(s) may be passed to functions, the arguments are converted to the required 
type when the function is evaluated. For example, the function WeekDay() requires a date answer as 
its single argument. You could provide an actual date answer as the argument or a string: 
WeekDay(aDateQuestion) or WeekDay("28-Mar-1993").



 
IF ... THEN ... ELSE ...

A calculation can be the result of some conditional test or tests by using IF ... THEN ... ELSE... The 
calculation must start with IF as its first word.

Syntax: IF <condition> THEN <expression> ELSE <expression>

<expression> is any legal calculation and may itself be IF ... THEN ... ELSE ...

<condition> is any legal calculation. The calculation is evaluated and if the result is not zero then the 
THEN expression is evaluated, otherwise the ELSE expression is evaluated.

The value of a string is 0 if the string is empty or not answered, else it is 1.

The value of a date is 0 if the date is not answered, else it is 1.

Examples:

IF WeekDay(aDate)=1 OR WeekDay(aDate)=6 THEN "WeekEnd" ELSE "WeekDay"

IF favoritePaper=NA() THEN NA() ELSE IF Includes( favoritePaper , "Times|Guardian|Independent") 
THEN "Quality" ELSE "Tabloid"

See also:
 Calculation - Tests



 
Calculation Tests

Choosing the Test button from the Calculations dialogue enables you to write an  IF ... THEN ... ELSE
...    calculation without having to type it out fully by hand.

The dialogue is similar to that for  adding a condition for choosing sheets on the WorkSheet.
Once you have described the condition, type the result to use if the condition is TRUE into the THEN box 
and the result to use if the condition is FALSE into the ELSE box.



Date is 'today'

Choose this option to initialise the answer with the current date when a new sheet is created. The date 
may still be edited, if required.



Options
Use the options dialogue for describing your preferences when using PinPoint:

Window

You can choose to position the Tool Tidy button bar either horizontally or vertically in relation to the top 
left hand corner of your work area.

The status bar, if enabled, shows status information for any current editor and brief help on tools and 
menu options whenever the pointer is over a Tool Tidy button or menu option is highlighted.

Forms

Use 'row' numbers when numbering choices

Choices will be numbered if you select the 'Show numbers' option when writing Yes/No or multiple 
choice questions.

Select this option if you wish choices 10,11 and 12 to be shown as 0,X and Y for questions with 10-
12 choices.

Sort choices by column

Select this option to describe the default entry order for choice based answers when writing 
questions. The order can be changed for individual questions using the Question Details dialogue.

Answer Sheets

Highlight active answer

Select this option to highlight the current answer being edited by drawing a background colour for 
the answer. Click the Colour button to choose the colour you require.

Graphs

Exclude 'Not answered values'

If your choice based questions are infrequently, or never, unanswered you may wish 'Not answered'
values to be excluded by default from any graphical analyses or cross-tabulations. If this is so, 
choose this option. Note that when a worksheet has been saved, combination and exclusion 
definitions are saved with the worksheet and will be used next time the worksheet is opened.

Plot 'Not answered' last'

This option allows you to plot 'Not answered' values from choiced based answers on the right hand 
side, rather than the left hand side, of graphs.

Calculation of percentages

This option is only of meaning when analysing the results of multiple choice questions which allow 
more than one choice to be ticked. Choose this option if you wish percentages to be based upon 
the number of answer sheets (respondents) included in the analysis, otherwise the percentage will 
be based upon the total number of responses (ticks).

Abbrieviated month names

Choose this option if you wish abbrieviations to be used for month names when plotting date 
information class intervalled by months, otherwise the full month name will be used.



Default font

Choose this button to describe the font to use for each Pen in each Tool Tidy when PinPoint is 
started.

Note, only the fontname and size are recorded.



Advanced Question Settings
Use the Advanced Questions Settings dialogue to group related questions together to form a Question 
Group and/or set up Question Routing:

Question Groups

Question Routing



Question Groups Dialogue Box
Enter the Reference Name you wish to give the Question Group. This is not displayed on the 

Form but it is used by the Worksheet.
Type in any introductory text that you wish to display at the top of the Group, above the questions.
For each question required on the Question Table, click on Add. The Question dialogue then 

appears.
Type in any introductory text that you wish to display at the top of the Group, above the questions.
You may change the properties of the Group Border by clicking on Properties, which brings up 

the Rectangle Properties dialogue. The distance of this border from the text can also be defined in the 
From Members box.

The Non members box contains the questions that have already been written, which do not 
already belong to a Question Group. Those that were selected will appear already highlighted. Click on 
the Reference Names of those questions you want to become members of the new Group. ( They can be 
deselected by clicking on them again.)
 When you have selected all of the questions that you want to be members of the new group, click

on <<Add. They will then be moved to the members box.
Further members can be added or removed from the Group in the same way until you click on 

OK. 
The questions making up the group will now be bound in a box whose borders are defined by the position 
of the question inside it. Double clicking on the box, ( but not on a question inside it ), with the Question 
Tool will return you to the Question Group dialogue.



Question Groups Dialogue Box
Enter the Reference Name you wish to give the Question Group. This is not displayed on the 

Form but it is used by the Worksheet.
Type in any introductory text that you wish to display at the top of the Group, above the questions.
You may change the properties of the Group Border by clicking on Properties, which brings up 

the Rectangle Properties dialogue. The distance of this border from the text can also be defined in the 
From Members box.

The Non members box contains the questions that have already been written, which do not 
already belong to a Question Group. Those that were selected will appear already highlighted. Click on 
the Reference Names of those questions you want to become members of the new Group. ( They can be 
deselected by clicking on them again.)
 When you have selected all of the questions that you want to be members of the new group, click

on <<Add. They will then be moved to the members box.
Further members can be added or removed from the Group in the same way until you click on 

OK. 
The questions making up the group will now be bound in a box whose borders are defined by the position 
of the question inside it. Double clicking on the box, ( but not on a question inside it ), with the Question 
Tool will return you to the Question Group dialogue.



Question table dialogue box
This dialogue is displayed when the Question Table tool is used. It allows you configure the questions 
and answers that will appear on your Question Table.

Enter the Name you wish to give the Question Table. This is not displayed on the Form but it is 
used by the Worksheet.

Type in any introductory text that you require for the Question Table.
For each of the Questions required in the question table, click on Add. The Question dialogue 

then appears.
For each of the Answers required in the question table, click on Add. The Add Answers dialogue then 

appears. The Answers box contains the answers that apply to ALL of the questions, so that if, for example, you wish 
to ask 10 questions, all of whose answers are Excellent, Good, Fair, and Poor, then you need to write 10 questions 
but only 4 answers.

Add to, or change, the questions and answers using the Add, Edit and Delete buttons.
Check Allow 1 choice if multiple answers are not allowed.
Check show numbers to display question numbers on the Answer Sheets.
Select Tick box only if you would prefer the answers to appear once at the top of the table, and 

not next to each answer.
You may change the properties of the Table Border by clicking on Properties, which brings up the

Rectangle Properties dialogue. The distance of this border from the text can also be defined in the From 
Members box.

Select Arrange vertically to arrange the answer choices in columns under each question.
Click on OK to complete the Question Table.



Add Question
Type in your question, and its Reference Name. Note that if you click on ( or Tab to ) the Reference 
Name box after tying a question, a Reference Name is automatically generated, which you can 
amend if necessary. Click on OK after each question has been added.



Add Answer
Type in your Answer, choose a different font for your answer if required and click on OK after each answer 
has been added.

You may choose to allocate a score to your answer unless it is an ordered choice answer.



Number Questions dialogue box
The choices you make in this dialogue are reflected in the Sample box on the right, showing you what 
effect each choice makes on the numbering format. You may:

Select the Format required for numbering the main questions.
Select a Separator symbol for the question number ( or type in your own ). 
Select a numbering style for questions which are members of a Question Group or Question 

Table, Group/Table. For example, if a group or table has introductory text that will be numbered Q2, and 
then each question within that group will be numbered with its part number: Q2a, Q2b, etc.

Remove question numbers ( if they have been placed there by the Number Questions 
command ), by clicking on Remove instead of OK.
Note: Questions are not numbered automatically as they are written and are not automatically 
renumbered if they are moved around the form.



Ask Question dialogue box
Enter the Reference Name of the question whose answer you wish to test, to see if the current 

question should be asked. This can be done either by typing in the Reference Name ( if you know it ), or 
more simply by clicking on it from the scrolling list.

The Value box will give the possible answers to this question ( a list for multiple choice based 
answers, or a range for numerical and textual answers ). Any mathematical operators on the Ask question
screen can be used to modify or limit the answer range, as long as they are not greyed out ( and therefore
unavailable ).

Select the result from the Value box which, when combined with the mathematical operators 
above it, will give the answer which allows the current question to be asked.

Click on OK.

If any of the criteria in the Criteria box are incorrect, they can be removed by clicking on Delete.

More criteria can be added in the same way, and these can be combined with previous criteria by the 
following procedure:

Set up a new test condition as described above.
Click on the <<AND or <<OR buttons, and the new combined criteria will appear in the Criteria 

box.
Add more criteria in the same way until the condition you want is fully specified.
Click on OK.



Plot Graph Vary By dialogue box
This dialogue allows you to define the  answer catagories or 
 class intervals for the question you have chosen to vary the plot by.



Table Properties
Use this dialogue to:

Change the title column label.
Change any other column title by typing it into the Label box, then click on Change, or click on 

any column title in the list to copy it to the Label box for changing.
Add calculated columns by clicking on the type of calculation required. You may choose more 

than one.



Choose Sheets 
Any graph can be produced from an analysis of either all the Answer Sheets in the project, the 
currently chosen sheets or the set of sheets matching a new set of conditions.

This dialogue box appears when you choose Matching from the Plot Graph dialogue box. It allows 
you to choose the required sheets for the graph.

Single Condition
Describe the condition and then click OK.

Set of Conditions

For each condition:

Describe the condition and then click <<AND or <<OR to add the condition to those alredy defined.

Once all the conditions are defined, click OK.

To describe a condition:

Question

Condition

Test value

Criteria list



Quick Graphs
This dialogue appears when you have chosen to make a quick analysis of your responses.

Select the questions whose answers are to be plotted - All selects all the questions; All but text 
selects all those questions that do not have a textual answer.

Select the categorisation to be applied to date and text answer questions. Numeric answers are 
plotted using a suitable fixed size interval that divides the range of values into about 10 intervals.

Select the analysis required.
Select the Answer Sheets to include in the analysis.
Select a style for all of the graphs.
Click on Plot.

The Property dialogue for the chosen style is then displayed. Complete it as required, the click on OK.

See also:

Graphs and charts overview



Publish Forms dialogue box
This dialogue allows you to choose the specifications for publishing your Form electronically.

Enter the project's name in the Project title box.
If you wish to display some welcome text before the questionnaire is run click on Welcome Text...

then type the text in the Welcome text box.
Type in the maximum number of responses that you wish to receive on disk, from 1 to 20.
Select whether you want the Form to be auto-scaled to fit the screen vertically or horizontally.
Enter the name for the .exe file, together with the destination disk and directory.
Click on OK.

A window appears soon afterwards, confirming that the Form has been published.
Completed sheets will automatically be saved to the directory in which the .exe file was created as .ppq 
files. The data from these can be imported to PinPoint for analysis in the normal way.



Plot Graph from Question Table
This dialogue is used for analysing the answers to all the multiple choice questions written in the 
Question Table quickly, and works in exactly the same way as the normal Plot Graph Tool.

Plot Graphs



Question Routing
This dialogue is allows you to set the variables for Goto question(s) depending on answer(s) routing.

Enter the Reference Name of the question whose answer you want to test, to see if the next 
question should be asked. You can either type it in or select it from the list.

The Value box below displays the possible answers to this question. The mathematical operators 
can be used to modify or limit the answer range, as long as they are not greyed out ( and therefore 
unavailable ).

Select the result from the Value box which, when combined with the mathematical operators 
above, will give the answer which allows the current question to be asked, then click on <<Add. The 
criterion that you have just set up will now appear in the Criteria box at the bottom.

Enter the question you want to be asked next, if the criteria you have just set up are met. These 
can be chosen from the scrolling list of Reference Names. If you want no more questions to be asked 
next, select stop from this list

Click on OK.
If any of the criteria are incorrect, you can remove them by selecting them and clicking Delete.
More criteria can be added in the same way, and these can be combined with previous criteria by clicking 
on <<AND, or <<OR.
Other routes can be set up from the same question to other questions by clicking on Add route again. 
When all the required routes have been set up, click on OK.





Graphs, Charts and Tables: Overview
Click on a button to bypass this Overview and go to:

Crosstab generation

Graphs and charts

Overview
Many patterns may emerge from the 'raw' information displayed in a worksheet, but others may only 
become apparent when classified answer data is tabulated or presented graphically in some way. 
PinPoint incorporates a cross-tabulation generator and provides a wide choice of graphing options and
chart types with which to present information for maximum clarity and impact.

The Presentation page
Graphs and tables are plotted onto an electronic page. This may be 

A new piece of paper.
Or an existing page, allowing a presentation of several graphs and tables to be 'built up'.

Presentation pages are displayed in PinPoint's Presentation Editor windows, where tables and graphs 
can be edited and annotated and a finished presentation assembled.

Plotting a graph
You may chose to plot each set of results onto a new sheet of paper or, for comparison or to 'build up' 
a presentation, onto

A currently open presentation page, creating a new graph.
Or to a previously plotted graph, adding the new plot as a new series. In this way cumulative or 

comparative graphs may be assembled by plotting the results from different selections (which can be from
different stacks) to the same axes.

Layers of interactive dialogue boxes will guide you step-by-step through the production of even the 
most complex graphical presentation.

More Help
Click on either button at the top of this page for more Help.



Plot Graph
Using the Plot Graph dialogue you specify; the answers to analyse, any categorisation or intervals to 
apply, the analysis to perform, the sheets to include in the analysis and where to plot the results and in 
what style.

Question

Answer categories

Class interval

Analysis

Vary by

Take values from sheets

Plot on paper

Add to graph

Store

Plot

Export

Style gallery
Make your "Plot graph" selections and click on a chart style. Choose "Plot" and the chart's properties 
dialogue box will appear.

Click on any chart icon to see a description of its primary properties dialogue box.

See also:

Graphs and charts overview

Chart styles overview



Question
This panel lists the names of the question fields for which you may plot answer values.

Choose a question by clicking on its name or by typing its reference name into the box.

Click Show all to show all the questions in the project or only those currently displayed on the Worksheet.



 
Answer categories
The responses to any type of answer may be categorised in some way during the analysis. Rather than 
accumulating values ( for example frequency counts ), for each answer value, the values are accumulated 
according to the answer category. By categorising answer values, a summary analysis is performed. This is a 
useful technique, for example if you are interested in the frequency of occurrences of a particular event each 
month, rather than the days on which they occurred.

This panel becomes available when you select a textual, Yes/No, ordered choice or multiple choice question for
which to plot or tabulate an analysis of answer values. For cross-tabulations, answers may be categorised in 
both the row and column questions/fields.

'Choice-based' Answers
 Combine
 Exclude (not Crosstabs)

Textual Answers

Answers may be categorised by considering only the first few characters of the answer. For example, by 
evaluating only the first character of a response, you can produce an alphabetical analysis of the answers. This
may be useful if you have an answer containing people's surnames. 

Check the option 'Leading characters' and type the number of leading characters to consider into the box.

If the option is not checked, or zero is entered, the entire answer is considered for the analysis.



 
Class interval
Analyses of numeric or date information can often be interpreted more easily when results are shown 
accumulated into ranges or 'bins' of answer values.

This panel becomes available when you choose to plot or cross-tabulate answer values for a question of either 
type. 

For cross-tabulations, answer values may be accumulated into class intervals in both the primary and column 
questions/fields.
 Numeric answers
 Date answers



Analysis
The production of a graph is an analysis exercise in itself. The graph may be plotted of an analysis of:

The frequency of answer values.
The answer values against the answer values of a different (numeric) question.
For ordered choice questions only, of popularity.



 
Take values from sheets
Click on a radio button to select the answer sheets containing the data you wish to include in the analysis.

You may take values from
All the answer sheets in a stack.
Or all those sheets which you have 

 chosen to analyse and which are displayed in the current Worksheet window.
For graphs

Or those sheets matching a 
 set of conditions.

For Crosstabs
Or only those sheets which you 

 select from the current worksheet. 



Plot on paper
Every graph is plotted on a piece of PinPoints "electronic" paper. The new graph may be plotted on a new 
piece of paper, or on a piece of paper already open. 

When a new piece of paper is created, it is attached to the project from which the graph was plotted and may 
be saved with that project. 

When adding a graph to a piece of paper, the paper may be from any of the open projects. In this way, 
comparisons between plots from different projects can be made. In combination with the "Add to graph" 
command you may:

Create a new graph. OR
Add a further series to an existing graph on the same axes.

Open the "Plot on paper" drop-down list and select "new", or highlight the name of an open page.
 Add to graph



Font
By default graph labels will be written in the font and font size that you have attributed to the Pen tool for 
Graphics Presentations. The currently-selected font and font size are shown in the panel below the "Font" 
button.

To change a graph's default text style click on "Font'" and select your chosen new attributes from the Pen style 
dialogue box.



Store
Use "Store" when plotting a  series of results onto the same graph axes.

Make your "Plot graph" selections and choose "Store". A list panel will open showing details of your stored selection. 
Make the selections for the next and subsequent plots in your series, choosing "Store" each time.
The series will be plotted and displayed in the order of their appearance in the "Store" list panel - the order in which 
they were stored.
Use the    << | >>    buttons to re-define the series listing order.

Choose "Delete" to remove a stored plot from the list panel.

Choose  "Plot" when your series is complete.



Draw on paper
When you have made all of your "Cross-tabulations" selections choose "Draw on paper". Your table will appear 
drawn in a Presentation Editor window.

Select from the "Draw on paper" drop-down list to draw your report onto a new page, or onto an existing 
presentation.



Print
Use "Print" to prepare a  crosstab report for printing.

Choose this command and the "Cross-tab titles" dialogue box will appear. Enter your report's Main and Sub headings
in the text entry panels and choose "OK" to open the "Print" dialogue box.



Font
By default crosstab text will be written in the font and font size that you have attributed to the Pen tool for 
Graphics Presentations. The currently-selected font and font size are shown in the panel below the "Font" 
button.

To change a table's default text style click on "Font'" and select your chosen new attributes from the Pen style 
dialogue box.

See also:
 Fitting the Table to the Paper.



Add to graph
Use this command in combination with "Plot on paper" to plot a set of results

As a new graph, plotted onto the same page as an existing graph
Or as the next in a series on an existing graph.

Open the "Add to graph" drop-down list. Highlight the name of the graph to which you wish to add your new 
plot, or select NONE to plot it as a new graph on the same page.

Note: "Add to graph" is not available when "new" is selected in the  "Plot on paper" panel.



Plot
Choose "Plot" to open your selected chart type's style dialogue box. Make your style selections and choose 
"OK".

If you are plotting a "stored"  series, choose "Plot" to open the style dialogue box for the chart type selected 
for the first of your series.

Choose "OK" and the "Add chart" style dialogue boxes for the following series will then appear in succession for 
completion.
Choose "OK" in the last dialogue box and your graph will appear drawn in a new Presentation Editor window.



 
Combine
In certain cases you may wish to combine selected answer categories for multiple choice or ordered choice 
questions into a new category.

In a survey of car ownership, for example, further analyses of 'country of origin' might become possible if the 
results of car brand choices were combined into new 'national' categories.

Check "Combine" and choose "Define combinations". The  "Combine choices" dialogue box will appear.



 
Exclude
Once an initial graph of all responses to yes/no, multiple or ordered choice questions has been plotted, or 
cross-tabulation produced, you may decide that some answer categories have no meaning and may be usefully
excluded.

Check "Exclude" and choose "Define exclusions". The  "Exclude answers" dialogue box will appear.
Note that PinPoint will exclude values for the response 'not answered' by default.



 
Class intervals, date values
Date answers may be summarised into the following intervals:

None No summary is performed, the individual dates are used.

Months The analysis is performed, and results shown, for each month of the year.

Quarters The analysis is performed, and results shown, for each quarter of the year.

Halves The analysis is performed, and results shown, for each half of the year. 

Years The analysis is performed, and results shown, for each year spanned by the data.

Note: For month, quarter and halves intervals, even if the data analysed spans several years, a single set of 
interval results are shown; results for the same interval in different years are combined.



 
Class intervals, numeric values
Analyses for numeric question types can either be plotted or tabulated for the actual numerical value, or they 
can be accumulated across an interval. You may choose to define 

A Fixed class interval.
Variable class intervals.

or NONE.

Note that if a bar graph is plotted with a class interval defined as NONE, the bars will be displayed as lines.



 
Combine choices

This dialogue box appears when you choose to combine answer values in the  "Plot graph" and 
 "Cross tabulations" dialogue boxes.

1. Type the name of your new category into the Category Name box.

2. Choose the Add button

3. Click-select the answer categories you wish to combine.

Repeat the above steps for each new category.

To Change a Category

Type the category's name into the Category Name box, or choose it from the list. Then, click select the
new choices to combine.

To Remove a Category

Select its title and choose "Delete".



 Exclude choices
This dialogue box appears when you choose to exclude answer values in the  "Plot graph" and 
 "Cross tabulations" dialogue boxes.

Click-select the choices you wish to exclude, then choose "OK".
To include all the choices in the analysis, ensure that none of the choices are selected.



 
Setting intervals
Pick up an interval pointer with the mouse and drag it to a new position on the interval bar. Or, TAB to the 
interval to be moved and then use the LEFT and RIGHT ARROW keys to move the interval left or right.

To remove an interval pointer from the interval bar, drag it off the bar and drop it, or press UP ARROW.



 
New interval pointer
Pick up a new interval pointer from here with the mouse and drag it onto the interval bar.



 
Interval
Select an interval pointer to see its interval end point in this panel.

The readout will 'scroll' if an interval pointer is dragged directly over the interval bar.



Graphs and Charts Overview
Click on a button to go to:

Producing a graph

Chart styles

The Presentation Editor

Introduction to Graphs
PinPoint's worksheets provide the tools for performing complex analyses and displaying the results in 
tabular form. But the results of some analyses can be difficult to see from a plain list of answer sheets 
and values, and a pictorial representation of results can often be more readily understood and 
interpreted.

A powerful set of easy-to-use graphing tools is available from within PinPoint's worksheet environment.
With these you can plot and present graphic analyses from the information contained in a stack of 
answer sheets in many different ways.

The production of graphs is an analysis exercise in itself. Graphs may be plotted of:
A frequency analysis of the responses to a question. The frequencies can be shown as their 

absolute values or expressed as a percentage and accumulated from response to response.
The responses to a question against the responses to a (different) numeric question. Except 

when plotting scatter graphs of numerical data, the responses to the numerical question may be summed 
or averaged for each response to the primary question. The results may then be shown as their actual 
values or expressed as a percentage and accumulated from response to response.

For ordered choice questions only, the popularity of each response.

In other words, before plotting the graph, a frequency or summary analysis of the data is performed. 
The results of this analysis are then used to plot the graph. 

The graph plotting facilities of PinPoint should be sufficient for your needs. However, if you possess a 
suitable application also capable of plotting graphs, such as an advanced spreadsheet, you may like to
use that application to produce alternative presentations of the analysis. Rather than being plotted, the
results of the analysis can be copied to the Windows clipboard in a form readily understood by most 
other applications. You may then paste the contents of the clipboard into your desired application and 
use its facilities to produce your graph.

Class Intervals ( Bins )

Not only can the responses be analysed to give, for example, the frequency of each response, but this 
analysis can itself be summarised.

Analyses can be summarised into class intervals for any type of answer:
For date answers, several intervals are provided; months, quarters, halves and years.
For numeric answers, the class intervals may be of a fixed or variable size.
Textual answers may be categorised examining only the first few characters of the answer, 

answers with the same initial characters are then placed in the same bins.
Answers which provide a choice may be binned by combining choices together.



Producing a Graph
Any graph can be produced from an analysis of either all the Answer Sheets in the project, the 
currently chosen sheets or sheets matching some new set of conditions- most often, graphs are 
plotted from an analysis of the currently chosen set of Answer Sheets.

PinPoint offers a choice of three tools for producing graphs.

1. The  Quick Graphing option enables you to make a quick overview analysis of the responses to 
all, or a large number of the questions before undertaking in-depth analysis.

2, If you have included Question Tables in your Answer Sheets these may be analysed quickly using 
the  Plot Graph from Question Table option.

3. The Plot Graph tool allows you to undertake an in-depth analysis. Click on the Plot Graph Tool in the 
Tool Tidy, or, from the Tools menu, choose Plot Graph. 
 The Plot Graph dialogue will appear.

Choose the options required and then choose Plot. A dialogue, or dialogues, will appear in which you may
complete the style definition of the graph, the graph will then be plotted on your chosen paper.

Single series graphs

Multiple series graphs



Chart Styles Overview
Choosing the best presentation of results can be difficult, but it is essential, as presenting the same 
information in different styles can convey different meanings. 

Whatever your requirements, PinPoint provides easy to use plotting facilities and the ability to change 
the style of the presentation after it has been plotted. A comprehensive set of styles are provided from 
a simple tabular presentation of the results to mixed bar/line and area presentation in 3D.

Generally you will be plotting a single analysis. However, several analyses can be plotted on the same 
axes to build a  multi-series graph. These analyses may be from data in the same project or from 
similar data in different projects, allowing you to make comparisons and observe trends.

When a multi-series graph is plotted, the basic styles used for each series may be mixed in any 
combination. For example, the first series may be plotted using the bar style, the second using the line 
style, the third using the scatter style and the fourth using the bar style again.

Variations on the basic styles are available. For example, the use of 2D or 3D effects, rotation of axes 
to make the x-axis vertical and stacked rather than discrete values. These variations are chosen from 
a properties dialogue.

When the Plot button is chosen from the Graph dialogue, a properties dialogue will appear:

When plotting This will appear
A single series graph
or first graph of a 
multi-series graph 
being built.

The primary properties 
dialogue for the chosen 
basic style.

A multi-series graph 
using the Store.

The primary properties 
dialogue for the chosen 
basic style of the first 
series in the Store.
On completion of the 
dialogue, secondary 
properties dialogues will 
appear for each additional 
series.

An additional series 
for a multiseries 
graph being built.

The secondary properties 
dialogue for the chosen 
basic style.

Primary Properties Dialogue

The primary properties dialogue shows the overall properties for the plot; whether axes are to be 
rotated, grid lines shown, 2D/3D effects, legend added to the graph, etc., as well as the property 
options for the first series on the plot, such as colour and fill styles to use.

Secondary Style Dialogue

The secondary properties dialogues show the property options for the series for its basic style, such as
colour and fill styles.



Multiple Series Graphs
A multi-series graph shows the results from several analyses in a single table or on a single set of 
axes. Comparisons between analyses can then be seen more clearly than plotting to individual graphs 
for each series.

Note: By definition, a single Pie or Column chart cannot present information from several analyses or 
series: each chart must be plotted individually.

PinPoint is very flexible in the presentation style used for each series, the analysis shown for each 
series and the source of the information for each series:

Each series may be drawn from different sets of answer sheets in the project.
As long as the type of the response to each question is the same ( Date, Numeric, Multiple 

Choice, etc.), each series may be drawn from different questions. For choice based answers, even the 
descriptions of the responses may be different.

Each series may be drawn from a different project.

Depending upon the source of the information, you may be able to plot the graph in a single operation,
or have to build the graph step by step.

"One-shot" plotting

Building step by step

Note: If your Answer Sheets include Question Tables you may use the     Plot Graph From Table 
Tool to analyse all the answers in the Question Tables quickly. This tool provides a short cut to a multi-
series graph.
Click the button to open the  "Plot Graph From Table of Questions" dialogue. This dialogue will allow you to 
analyse all the answers in the Question Tables quickly.    It works in the same way as the normal Graph tool.



Fitting the Table to the Paper

When either printing or drawing on paper, PinPoint will attempts the best fit possible on the paper 
described as the default for the active printer, rotating the orientation of the paper if necessary. If the 
table still will not fit the paper, a smaller font size is used until the table will fit, or the font size is too 
small. PinPoint will try font sizes down to 4 point. If the table cannot be fitted to the paper, an error will 
be reported, you should then try one of the following:

If you were generating a table with many column questions, generate several tables instead with 
only one or two column questions per table.

Use Categories or Class Intervals to reduce the number of response columns and/or rows.
Select a different printer    which has larger paper by selecting Printer Setup from the File menu.



Crosstab generation
Click on a button to go to:

Producing a cross-tabulation

Notes on Crosstab tables

The Presentation Editor

Cross-tabulations

Graphical illustrations of frequency analysis results provides the clearest presentation; it is easy to see
comparisons and trends. However, when initially investigating information, producing graphs can 
become cumbersome. Cross-tabulation provides a useful means of performing frequency analyses 
quickly.

With cross-tabulations, these analyses can be performed in a single operation resulting in a table that 
can be inspected for interesting results. You may then decide to produce a graphical presentation for 
inclusion in a report.

A crosstab table shows the frequency of occurrence of each answer to a question for each answer to 
another question(s).



Producing a Cross-tabulation
Cross-tabulations may be produced for answers to any type of question against the answers to any 
other type of question. For example, a Multiple Choice question against a numeric question or date 
responses against textual responses. Just like graphs, the responses to any question can be 
categorised and binned as required.

The question whose responses are being tabulated is known as the row question, since its responses 
create the rows of the table. The question against which responses are tabulated is known as the 
column question, since its responses create the columns of the table.

In a single table, you may tabulate    as many column questions as desired, so long as they can be 
fitted on a reasonably-sized table, may be tabulated. For example you may wish to inspect how 
responses varied between men and women for several Multiple Choice questions.

The table can show the count of occurrences as its actual value, expressed as a percentage, or both. 
When the percentage is shown, it may be calculated as the percentage of the total occurrences of 
either row or column responses, or both,

Finally, statistical values which express the significance and strength of association between the 
responses can be included in the table. 

The generated table may be printed directly to the active printer, which is useful when you wish to 
produce a set of tables to be inspected "at leisure". Alternatively, the table may be drawn on PinPoints 
"electronic" paper and viewed through a Graphics Presentation Editor; where captions and headings 
may be added, further tables drawn, or graphs added, to produce a complete presentation of results.

To produce a crosstab table:

Before producing the table choose the sheets to include in the analysis (if required) in the normal way 
by using the choose sheets facility. To generate a crosstab table:

Click on the Crosstab Tool in the Tool Tidy, or
Select Generate Cross-tabulation from the Tools menu 

The Crosstabs - Rows dialogue will appear. This is the first in a sequence of three dialogues, you may 
move back and forth through the dialogues as required.

Crosstab - Rows
1. Select the question whose answers are to be the rows of the table, and any categories or class 

intervals to be used.

2. If you do not wish to include answers which have not been given, select Suppress rows with 
zero total. Using this option can reduce the size of the table and eliminate redundant 
information.

3. Click on OK to move on to the next dialogue.

Crosstab - Columns
Use the following procedure for each question against which you wish to tabulate responses. The 

responses to these questions make up the columns of the table.

1. Select the question and any categories or class intervals to be used.

2. If you do not wish to include answers which have not been given, select Suppress rows with 
zero total. Using this option can reduce the size of the table and eliminate redundant 
information.

3. Click on Add.

Note: If you don't need to change the category, class interval or suppress status just double click on



the question to add it to the table.

To remove a column question, select the Columns list and click on Remove.

To modify your choices for a question, select it in the columns list, make the required changes, then
click on Add. Click OK to move on to the next dialogue, or <prev to return to the Crosstab-Rows 
dialogue,

Crosstab - Options
1. Select the display of counts/percentages, with percentages calculated on a row or column basis 

or both.

2. Select any statistical values to be included in the table.

3. Select which, if any, additional statistics expressing association between the tabulated answers 
you wish to be displayed.

4. Select the Answer Sheets to be included in the analysis.

5. To print the table, click on Print. Alternatively, you could draw the table on PinPoint's paper by 
selecting the paper to use and clicking on Draw on Paper, or, you may choose to copy your 
table to the clipboard by selecting Export.

The table is then generated and fitted to the paper specified or exported to the clipboard.



Frequency Analysis
Frequency analysis shows the frequency distribution of your sample, i.e. the number of occurrences of each 
answer value in the series. It may be displayed as the absolute number of occurrences, or expressed as the 
percentage of the total number of answers analysed in the series.

The frequency of occurrence may be accumulated from response value to response value to show the 
cumulative frequency up to any response. Again, the value may be shown as its absolute value or expressed 
as a percentage. The section of the Plot Graph dialogue that is concerned with analysis is shown below

To plot Check these options

Frequency Absolute

Percentage Percentage

Cumulative 
Frequency

Absolute and Accumulate

Cumulative 
Percentage

Percentage and Accumulate

 Analysis



Second Question Analysis
Second Question analysis provides the summed or averaged values of a numeric answer for each response to 
the primary question, except when both answers are numeric and a scatter (XY) graph is plotted. The summed 
or averaged values may be expressed as percentages of the total and accumulated from response to response
of the primary question.

1. Choose the second Question.

2. Choose whether the summed or averaged values should be shown.

3. Choose whether to show the values, or the values expressed as a percentage of the total, and whether to 
accumulate the shown values from response to response of the primary question.

 Analysis



Plot for popularity
For ordered choice questions, the frequency of occurrence of each choice may expressed as the popularity of 
the choice - a measure of how often the choice was ranked first, second, third, etc..

Please see the PinPoint User's Guide for a full discussion of popularity analysis.
 Analysis



 
Fixed class interval
Choose a fixed interval to accumulate information into ranges or 'bins' of equal size.

Select "Fixed" and type an interval size into the text entry panel.
 Class intervals, numeric values



 
Variable class interval
Define variable intervals when the information you are plotting may be more clearly interpreted if accumulated 
into different sized 'bins'.

In a population survey, for example, it might be more revealing or appropriate to plot information for those aged 
(say) 0-5, 5-7, 7-13, 13-18, 18-21, 21-25, 25-35, and 35 and over.

Select "Variable" and choose "Define". The  "Class interval" dialogue box will appear.
 Class intervals, numeric values



Exporting Analysis Results
While the styles provided by PinPoint for presenting analysis results are comprehensive and should be
sufficient, there may be occasions where you wish to take advantage of the graphing capabilities of 
other applications you possess. For these cases, the results of the analysis may be copied to the 
clipboard rather than being plotted. The results are copied in a form readily understood by applications 
such as spreadsheets and can simply be pasted into the application.

1. Proceed as if plotting a single series graph, or One-Shot Plotting a multi-series graph. However, the
paper to plot on and plot style may be ignored.

2. Choose the Export button.

3. Switch to your other application and paste the contents of the clipboard.

Multi-series Analysis

Due to the nature in which information must be copied to the clipboard so that it is readily understood 
and usable by other applications, there are some limitations to this technique when placing multi-series
information on the clipboard:

The values, and range of values being analysed must be the same in each series. For example, 
analyses of numeric information in the range 10-50 in the first series and 100-200 in the second series 
cannot be copied.

The descriptions of responses analysed in each series must be the same. For example, each series 
should analyse the same multiple choice question, analysis of questions with different responses 
cannot be copied.

Tip: If a multi-series analysis cannot be performed using the Store, proceed as usual by plotting the 
graph and building step by step. Then, copy the graph to the clipboard. This will place a copy of the 
data used to display the graph, as well as the graph itself, onto the clipboard. To paste the data, rather 
than the graph, into another application, you may have to use its Paste Special command.



Single Series Graphs
The simplest graph is of a single analysis, resulting in a single series of data being plotted.

1. From the list, choose the question whose responses are to be analysed. Click on Show all if you 
have removed some questions from the worksheet by dropping them off the column bar and 
want to display all the questions.

2. If available, choose any  categorisation or 
 class intervalling of the answers required.

3. Choose the  analysis to be performed.
4. Choose the answer sheets to  include in the analysis.

5. Choose the  paper on which to plot the graph.
6. Choose the  style in which to present the results.
7. Choose the Plot button.

A dialogue will appear to allow you to make choices about the presentation of the graph in your chosen
style. After completing the properties dialogue, the answers will be analysed and the graph plotted on 
the chosen paper. The paper will be shown in a Graphics Presentation Editor through which the graph 
may be modified as required and headings and captions added.

Note: The graph will be drawn on an unoccupied portion of the chosen paper. When the chosen paper 
already has graphs and other objects drawn on it, the new graph may not be immediately visible in the 
Graphics Presentation Editor window. Either scroll the window or Zoom the view to Fit Window to see 
the new graph. Also, adding the graph may require new sheets to be added to the paper if there is no 
free space on the available sheets - this occurs automatically.



One-Shot Plotting
If each series is to be drawn from the same set of sheets, from the same project, then the graph can 
be plotted in a single operation.

Vary By Plotting

Vary by plotting is a quick way to produce comparitive analyses, where you want to compare the 
responses to one question for each response to another question. For example, how the responses to 
a question vary according to whether the respondent is male or female.

PinPoint will automatically generate a series for the graph for each response to the 'Vary by' question, 
it will also automatically create suitable legend text for the graph.

Tip: Using Vary by, you can create a graphical representation of a Cross-tabulation.

1. Choose the question to be analysed.

2. Choose Vary by and choose the question whose answers are to be used to generate each of the
series.

4. Click on ... to define any combinations, exclusions or class intervals for the Vary by question.

3. Choose Plot.

Using the Store

With this method; the set of sheets is first chosen in the normal way, then the requirements for each 
series chosen and stored ( saved ) before plotting the graph.

Repeat the following steps for each series to be plotted:

1. From the list, choose the question whose responses are to be analysed. Click on Show all if you 
have removed some questions from the worksheet by dropping them off the column bar and 
want to display all the questions.

2. If available, choose any  categorisation or 
 class intervalling of the answers required.

3. Choose the  analysis to be performed.
4. Choose the answer sheets to  include in the analysis.

5. Choose the  style in which to present the results. Note that the styles available will depend upon
any previous contents of the store.

6. Choose the Store>>> button.

The Graph dialogue will expand to show the store of each series on the graph. 

Note that different questions, class intervals, analysis, sheets to include and presentation style can be 
chosen for each series.

When all the series required have been defined, complete the plot graph dialogue:

7. Choose the  paper on which to plot the graph.
8. Choose Use question on x-axis to label the x-axis with the reference names of the questions 
analysed, the various answers will then make up each series of the graph.



9. Click the Plot button.

A sequence of property dialogues will appear, one for each series to be plotted, to allow you to make 
choices about the presentation of the graph. After completing the style dialogues, the answers will be 
analysed and the graph plotted on the chosen paper. The paper will be shown in a Graphics 
Presentation Editor through which the graph may be modified as required and headings and captions 
added.



Building a Multi-series Graph Step by Step
You might sometimes wish to plot a graph that draws on data from different projects, different sets of 
sheets or even different questions. Whilst this would be time consuming in other applications, PinPoint 
provides the facility to build a up a graph series by series.

In this process, a new graph is plotted for the first series, and subsequent series added to the first 
graph. For example, to compare the responses made to a particular question by men and women, you 
can use either of the following procedures:

Choosing sheets before plotting
1. Choose the Answer Sheets for those respondents in the first group using the Worksheet's Add 

Condition option.

2. Plot a graph of the frequency analysis of responses to the required question as if you were 
plotting a single series graph.

3. Remove the previous condition, then choose the Answer Sheets for those respondents in the 
second group using the Worksheet's Add Condition option.

4. Use the Graph Tool and dialogue to plot a frequency analysis of responses to the required 
question. However, before you do:

Make sure that the paper on which the graph was    plotted is shown in the Plot on paper 
box. ( It will be shown by default. )

Select the first graph in the Add to graph box. ( The box will show all the graphs on the 
selected paper.)

The new analysis will then be plotted on the same axis as the previous analysis.

Follow the same procedure to plot any multi-series graph. Steps 3 and 4 ( to add a series ) may be 
repeated as often as necessary. Moreover, you may use the store at any stage to add several series to
a graph in one go.

Remember that the series do not have to be drawn from the same project, the same set of sheets or 
even the same question. Only the type of answers being analysed in each series must be the same. 
And PinPoint even allows you to plot each series in a different style.

Choosing sheets during plotting

Rather than choosing the sheets required for the plot with the Choose Sheets Tool, they can be 
chosen when you are ready to plot. Select Matching and the Choose Sheets dialogue appears.



Notes on Cross-Tabulations
The Totals row and column always shows the number of answer sheets on which the answer value 
appeared. In other words, the number of times the answer appeared. The body of the table shows the 
number of times each column answer value appeared for each row value.

Percentages, when shown, are given to the nearest integer, consequently, they may not add up to 
100% - instead maybe 99% or 101%. For example, if the total number of times a column answer 
appears is 3 and it appears once for each of three row question answers, the percentages will be each
shown as 33% giving a total of 99%.



Plot Graph From Table
If you have created any  Question Tables in your form, the contents can be plotted quickly and simply 
using the Question Table Graph Tool.

Click the 
 Question Table Graph Tool in the Tool Tidy, or

Select the Plot Graph from Question Table from the Tools menu.
The Plot Graph from Question Table dialogue then appears.
This dialogue is used for analysing the answers to all the multiple choice questions written in the Question
Table quickly, and works in exactly the same way as the normal Plot Graph Tool.



Quick Graphing
After collecting all your information, you may desire a quick overview analysis of the responses to all, 
or a large number of, the questions before undertaking in-depth analysis.

Quick Graphing allows you to do this - a graph will be produced for each question analysed, 8 graphs 
will be fitted per page, and as many presentations as required will be created to show all the graphs. 
The resultant presentations can then be printed for examination at leisure or browsed through on the 
screen. This allows you to use a single dialogue only once to generate all the graphs, rather than using
the Plot Graph Tool for each graph required.

Click on the 
 Quick Graph Tool in the Tool Tidy, or

Select the Quick Analysis from the tools menu.
The Quick Graphs dialogue then appears.

1. Select the questions whose answers are to be plotted - All selects all the questions; All but text 
selects all those questions that do not have a textual answer.

2. Select the categorisation to be applied to date and text answer questions. Numeric answers are 
plotted using a suitable fixed size interval that divides the range of values into about 10 intervals.

3. Select the analysis required.

4. Select the Answer Sheets to include in the analysis.

5. Select a style for all of the graphs.

6. Click on Plot.

The Property dialogue for the chosen style is then displayed. Complete it as required, the click on OK.



Vary By
Use Vary by to automatically generate a multi-series graph where each series is an analysis of results for each 
answer to the 'Vary by' question.
1. Choose the question whose answers are to generate each series from the list.
2. Click the '...' button to describe categorisation or class intervalling.

See also:
 Multi-series graphs 





File menu: New
"New" begins a new project and opens a Form Editor window onto a blank form.



File menu: New Project
"New Project" begins a new project and opens a Form Editor window onto a blank form.



File menu: Open...
"Open" opens a new window onto an existing PinPoint project - locate your project file in the "File 
Open" dialogue box then choose "OK". You may also "open" a file created with another application - 
PinPoint will create a new project from the file and then open the project.

Opening an 'empty' project
An empty project (i.e. one that is still at the form design stage and contains no answer sheets) will be 
opened in a new Form Editor window.

Opening an active project
When you open an active project its worksheet will be displayed in a new Worksheet window with its 
last-saved sort and selection attributes in place. You may then choose to 

Continue with your analysis of the completed answer sheets.
Or plot a graph or create a table from the sorted and selected answer sheet data on display.
Or return to the stack to complete new answer sheets or edit existing ones.

Note that PinPoint's menu bar and the Tool Tidy will change to reflect the options available to you in 
the active document window.

Opening another file
Locate the file to open in the "File Open" dialogue box and then choose "OK". The same sequence of 
dialogues as if you were  importing the file will then appear. Complete the dialogues as required. A 
new project will then be created, with the same name as the file being opened and containing a form 
listing the fields found and to be imported.

See also:
 Worksheet tools
 Form Editor tools
 Work history
 The Stack tool



File menu: Open presentation...
"Open presentation..." appears in the Worksheet and Presentation Editor File menus. 

Choose this command to open a graphics presentation which has been stored previously in your 
current project. Locate the presentation's name in the dialogue list box then choose "OK".

Your selected presentation will appear displayed in a new Presentation Editor window. You may then 
choose to

Continue with the assembly of your graphics presentation
Or edit current graph styles and attributes
Or add further series to your graph from its originator stack(s), or from others.

Note that PinPoint's menu bar and the Tool Tidy will change to reflect the options available to you as 
you switch between Worksheet and Presentation Editor windows.

See also:
 Analysis Worksheets: How to...



File menu: Save
"Save" works slightly differently in each of the three File menus in which the command appears.

From a Form Editor window
Choose "Save Form" to store your form in the current project file.

If the form has not been saved before, PinPoint will prompt you for a new project name and your 
choice of destination disc and directory.

If the form has been saved before, PinPoint may ask you to confirm, twice, that you wish to save 
your changes and 
 update all the answer sheets in the project's stack accordingly.

See also:
 Altering the Form

From a Worksheet window
Choose "Save Setup as Default" to store your current worksheet together with all its  attributes in the 
current project file.

From a Presentation window
Choose "Save Presentation" to store your graphics presentation in the current project file. PinPoint will 
prompt you to name your presentation if it has not been saved previously.

Note that if you "Save" frequently you will always have a recent version of your work on disc.

See also:
 Save as...
 The Stack tool



File menu: Save Form
Choose "Save Form" to store your form in the current project file.

If the form has not been saved before, PinPoint will prompt you for a new project name and your 
choice of destination disc and directory.

If the form has been saved before, PinPoint may ask you to confirm, twice, that you wish to save 
your changes and 
 update all the answer sheets in the project's stack accordingly.

See also:
 Altering the Form

Note that if you "Save" frequently you will always have a recent version of your work on disc.

See also:
 Save Form As...
 The Stack tool



File menu: Save Presentation
Choose "Save Presentation" to store your graphics presentation in the current project file. PinPoint will 
prompt you to name your presentation if it has not been saved previously.

Note that if you "Save" frequently you will always have a recent version of your work on disc.

See also:
 Save Presentation As...



File menu: Save as...
"Save as..." works differently in each of the three File menus in which the command appears.

From a Form Editor window
Choose "Save Form As New Project..." to store the form you are working on in a new project file 
without disturbing your original project.

PinPoint will prompt you for a new project name and your choice of destination disc and directory.

From a Worksheet window
Choose "Save Sheets As..." to save some or all of your current project's answer sheets to a new 
project file, together with their form, or to save selected answer sheet data to a file as CSV or TSV text 
for importing into other applications. You can save

All the answer sheets in a stack.
Or all those sheets which you have 

 chosen to analyse and which are displayed in the current Worksheet window.
Or only those sheets which you 

 select from the current worksheet.

From a Presentation Editor window
Choose "Save Presentation As..." to open the    "Save presentation as" dialogue box and store the 
presentation you are working in the current project file, but under a new name.

Note that in every case, use of the "Save as..." command will leave your original work undisturbed.

See also:
 Save
 Exporting Information
 New form



File menu: Save Form As New Project...
Choose "Save Form As New Project..." to store the form you are working on in a new project file 
without disturbing your original project.

PinPoint will prompt you for a new project name and your choice of destination disc and directory.

Note that in every case, use of the "Save as..." command will leave your original work undisturbed.

See also:
 Save Form
 New form



File menu: Save Sheets As...
Choose "Save Sheets As..." to save some or all of your current project's answer sheets to a new 
project file, together with their form, or to save selected answer sheet data to a file as CSV or TSV text 
for importing into other applications. You can save

All the answer sheets in a stack.
Or all those sheets which you have 

 chosen to analyse and which are displayed in the current Worksheet window.
Or only those sheets which you 

 select from the current worksheet.

Note that in every case, use of the "Save Sheets As..." command will leave your original work 
undisturbed.

See also:
 Save Setup as Default
 Exporting Information



File menu: Save Presentation As...
From a Presentation Editor window
Choose "Save as..." to open the    "Save presentation as" dialogue box and store the presentation you 
are working in the current project file, but under a new name.

Note that in every case, use of the "Save as..." command will leave your original work undisturbed.

See also:
 Save
 Exporting Information
 New form



File menu: Save Setup as Default
Choose "Save Setup as Default" to store your current worksheet  configuration in the current project 
file.



File menu: Import...
Choose "Import..." to bring results from  published forms or information from another project or 
application into a PinPoint project file. Data can be imported

Into a new form.
Or into a Worksheet or Sheet Editor window to be merged with an existing stack of answer 

sheets.

Click the command, locate your source file and define its data format in the dialogue box and then 
choose "OK".

The file formats understood by this release of PinPoint are described in the readme.txt file supplied 
with PinPoint.

Note that the source file need not contain the same questions/fields as your destination project file. 
PinPoint will prompt you to 'map' your new information before merging it.

See also:
 Importing data and merging projects overview
 Import (dialogue box)



File menu: Print Presentation...
"Print Presentation..." sets the parameters for the proofing and final printing of your presentation. In the
"Print" dialogue box you can choose to

Print to Windows' default 
 printer or to any printer whose driver is available on your system. Choose "Setup" to select a printer and

the options which reflect the 
 format of your presentation.

Print of all or part of a multi-page presentation.
Set the number of copies to be printed.
Select other options such as print quality and file output.

Note that you can print your work without having to save it first.

See also:
 Print form...
 Print sheet...
 Print sheets with form...
 Print worksheet...
 Printer setup...



File menu: Print Form...
"Print Form..." sets the parameters for the proofing and final printing of your form. In the "Print" 
dialogue box you can choose to

Print to Windows' default 
 printer or to any printer whose driver is available on your system. Choose "Setup" to select a printer and

the options which reflect the 
 format of your form.

Print of all or part of a multi-page form.
Set the number of copies to be printed.
Select other options such as print quality and file output.

Note that you can print your work without having to save it first.

See also:
 Print sheet...
 Print sheets with form...
 Print worksheet...
 Print presentation...
 Printer setup...



File menu: Print Sheets With Form
"Print Sheets With Form" appears in the Analysis Worksheets File menu. Choose this command to  
print

All the answer sheets in a stack.
Or all those sheets which you have chosen to analyse and which are displayed in the current 

Worksheet window. If you have sorted the sheets they will be printed in sort order.
Or only those sheets which you 

 select from the current worksheet. 

Note: If you are printing onto pre-printed copies of a project's form select the "Print data only" dialogue
box option. The printed answers will appear positioned correctly relative to their questions.

See also:
 Print form...
 Print sheet...
 Print worksheet...
 Print presentation...
 Printer setup...



File menu: Print sheet...
"Print sheet..." appears in the Sheet Editor File menu. Choose this command to  print the answer 
sheet currently displayed on screen. 

Note: If you are printing onto pre-printed copies of a project's form select the "Print data only" dialogue 
box option. The printed answers will appear positioned correctly relative to their questions.

See also:
 Print form...
 Print sheets with form...
 Print worksheet...
 Print presentation...
 Printer setup...



File menu: Print Worksheet...
Choose this command to print a formatted table or 'report' of answer sheet data from

All the answer sheets in a stack.
Or all those sheets which you have chosen to analyse and which are displayed in the current 

Worksheet window.
Or only those sheets which you 

 select from the current worksheet. 

A printed report is formatted as displayed on screen - listing only the columns currently shown on the 
worksheet. PinPoint adds a Worksheet title (the name of your project file), report date and page 
numbering.

If statistics are currently being displayed on the worksheet, they will also be printed. If you only wish to 
print the statistics and not the answer sheet data, choose the Print statistics only option in the Print 
Worksheet dialog.

Fitting the Worksheet to the Paper

Before attempting to print the worksheet, you should check that it will fit on the paper loaded in your 
active printer. To do this, from the View menu, choose Show Printable Area - the area of the worksheet
beyond the width of the paper will then be given a grey background. If there are columns that will not fit
on the paper, you have several choices:

Use a different or smaller font. From the View menu, choose 
 Font and choose a new font or size from the Font dialogue.

Reduce the 
 width of the columns on the worksheet.

If your printer is able, select a different, wider, orientation of the paper in the printer. From the File 
menu, choose Printer Setup.

Select a printer that uses wider paper. From the File menu, choose Printer Setup.
Remove some of the 

 columns on the worksheet.

Note: The display of the printable area is approximate, especially if you are using a font which is not 
available on the active printer. In such cases, the closest matching font available on the printer is used 
but this may vary in size slightly from the font used on screen.

See also:
 Worksheet configuration
 Print form...
 Print sheet...
 Print sheets with form...
 Print presentation...
 Printer setup...



File menu: Printer setup...
Choose "Printer Setup..." to specify the  printer you will use to print the proofs and final copies of your
work, and to set the printer 
 options that reflect the format of the work that you wish to print.

Note that the "Print setup" dialogue also appears when you choose "Setup" in the "Print" dialogue box.

See also:
 Print form...
 Print sheet...
 Print sheets with form...
 Print worksheet...
 Print presentation...



File menu: Exit
"Exit" ends your PinPoint session and returns you to the Windows desktop.

If you have made any changes to your work since you last saved it, PinPoint will prompt you to save or
abandon them before exiting.

See also:
 Save
 Save as...



File menu: Work history
If you have been working on and have recently saved a PinPoint project, then its title will appear in the 
"Work history" list under the File menu.

Click on a project's title to open it directly from the list box.

See also:
 Open



Edit menu: Undo
"Undo" cancels the last action you took and returns your work to its appearance immediately prior to 
taking that action.

Note that you must use the command immediately following an activity or you will lose the chance to 
undo it. "Undo" is only one action deep so if, for example, you use "Delete" twice you can only undo 
the last "Delete".

If there is nothing that can be undone then the command will be 'greyed out' and unavailable.

See also:
 Clear
 Cut
 Copy
 Paste



Edit menu: Cut
"Cut" removes selected items from the page and stores them in the Windows Clipboard. Cut elements 
can then be "pasted" back into your current work, or into another project or application.

To select an item to be cut, click on it with the Pointer Tool. To select multiple items, press and hold 
down SHIFT and click on each item in turn.

Note that each use of "Cut" will erase the previous contents of the Clipboard.

Tool Tidy button:

 

Keyboard shortcut:
Ctrl + X

See also:
 Clear
 Copy
 Paste
 Select all
 Undo



Edit menu: Copy
"Copy" copies duplicates of items onto the Windows Clipboard leaving the original elements intact. 
Copies can then be "pasted" back into your current work, or into another project or application.

Each use of "Copy" will erase the previous contents of the Clipboard.

To select an item to be copied, click on it with the Pointer Tool. To select multiple items, press and hold 
down SHIFT and click on each item in turn. 

Note that PinPoint also lets you select and copy complete questions to the Clipboard. This is a useful 
shortcut when designing a form which will contain questions with similar answer types

Quick Copy: Press and hold down CTRL and drag an item to create a copy of it. Release the mouse 
button to drop the duplicate item in place.

Tool Tidy button:

 

Keyboard shortcut:
Ctrl + C

See also:
 Clear
 Cut
 Paste
 Select all
 Undo



Edit menu: Paste
"Paste" places a copy of the last item that was cut or copied onto the Windows Clipboard into your 
current work. 

When you choose "Paste" the copied item will appear under the Pointer tool. Push (not drag) the item 
into place with the Pointer, and click the left mouse button to drop it into position.

The contents of the Clipboard can be pasted repeatedly until you erase them with a new "Cut or 
"Copy" command.

Pasting questions/fields
If you have copied complete questions to the Clipboard the  "Copy question" dialogue box will open 
when you choose "Paste".

Drag and drop
PinPoint supports Windows' drag and drop features to paste files onto a page. 

For example, to paste a graphic onto a page, select a file (say, a Windows .bmp, .pcx or .msp 
bitmapped graphic image) from File manager and drag its icon into any PinPoint Editor window. 
Release the mouse button to 'drop' the graphic object onto the page. The graphic file will be embedded
on the page. If you wish to link to the file, hold down the CTRL key while dragging and dropping the 
file.

Note that where possible PinPoint will always  embed an item when you paste it into your work from 
the Clipboard, and will attempt to render the source image rather than an icon for the data 'package'.

All supported files are pasted via OLE. See your Microsoft® Windows™ reference manual for current 
information on Object Linking and Embedding procedures.

Tool Tidy button:

 

Keyboard shortcut:
Ctrl + V

See also:
 Clear
 Cut
 Copy
 Select all
 Undo



Edit menu: Paste Link
"Paste Link" is an OLE (Object Linking and Embedding) command used to link an item already on the 
Clipboard to your current project.

Linking dynamically connects two files so that the information on one automatically updates when the 
information on the other changes.

When you choose "Paste Link" the linked item will appear under the Pointer tool. Push (not drag) the 
item into place with the Pointer, and click the left mouse button to drop it into position.

See your Microsoft® Windows™ reference manual for current information on Object Linking and 
Embedding procedures.

See also:
 Paste
 Links...
 Insert object...
 Object



Edit menu: Insert object...
"Insert object..." is an OLE (Object Linking and Embedding) command used to embed an element in 
your current project.

Embedding is similar to copying (i.e. simple "pasting") with one important difference. To make changes
to an embedded item, choose it by double-clicking on it with the Pointer tool. The application in which it
was created will open and you can make your changes.

Note that where possible PinPoint will always embed an item when you paste it into your work from 
the Clipboard, and will attempt to render the source image rather than an icon for the data 'package'.

Drag and drop
PinPoint supports Windows' drag and drop features. Select a file (say, a Windows .bmp, .pcx or .msp 
bitmapped graphic image) from File manager and drag its icon into any PinPoint Editor window. 
Release the mouse button to 'drop' the graphic object onto the page.

See your Microsoft® Windows™ reference manual for current information on Object Linking and 
Embedding procedures.

See also:
 Paste
 Paste Link
 Object
 Links...



Edit menu: Delete
"Delete" removes selected items from your work area without copying them to the Windows Clipboard 
and without affecting the Clipboard's current contents.

Be cautious in your use of "Delete". Items can only be retrieved with the "Undo" command immediately
after deletion.

Note that the Edit menu "Delete" command works differently to the Sheet menu "Delete" command 

Keyboard shortcut:
Shift + Del

Tool Tidy button:

 

See also:
 Undo



Edit menu: Select all
"Select all" selects every element on your current page. This command is the equivalent of Shift-
clicking with the Pointer tool on every item on the page.

Note that once all items have been selected you can cancel the selection of any one by holding down 
the SHIFT key and clicking on the item.

Keyboard shortcut:
Ctrl + A

See also:
 Clear
 Cut
 Copy
 Paste
 Undo



Edit menu: Clear
"Clear" cancels the selection of every previously-selected element on your current page. This 
command is the equivalent of clicking with the Pointer tool on a blank area of the page.

See also:
 Cut
 Copy
 Paste
 Select all
 Undo



Edit menu: Text Style...
Choose Text Style to open the "Font" dialogue box and edit the attributes of all currently selected text 
elements. This command is the equivalent of double-clicking on a text item with the  Pen or 
 Pointer tools but the new style is applied to all the selected items.

Note that if the whole of a question is selected, rather than component parts, the new text style will apply 
to all components of the question.



Arrange menu: Align
Choose "Align" to snap selected items into line with each other. Items may be aligned by any face - 
left, right, top or bottom - selected from the "Align" sub-menu.

This command is much easier to use than it is to describe, so experimentation with the primary effects 
of "Align" is recommended.

Precision alignment using a 'datum' element
Careful use of "Align" can achieve high precision in page layout through the use of 'datum' alignment 
elements.

For example, to align selected items with the left side of a datum object
Position the datum element on your page using the rulers, guidelines, and "snap to grid" layout 

guides as required. 
Move the other items away. The alignment face of the datum element's bounding box must be the

most extreme (in this case the furthest to the left) of all the items to be aligned.
Select (Shift-click) all items to be aligned.
Click "Align" to open the 

 list of alignment options. Choose "Lefts".

The left faces of the selected items will be snapped into line with the left side of the datum object.

See also:
 Clear
 Undo



Edit menu: Bring to front
"Bring to front" moves a selected question, text bock or graphic element in front or 'on top' of other 
overlapping items.

To select an element to bring to the front of several that are overlapping, double-click successively with
the Pointer tool at the point of overlap to 'cycle' through each item in turn.

This command is used most frequently to quickly re-arrange or 'layer' sets of objects on a page.  
Layering can look particularly effective when colour-filled (i.e. opaque) objects are 'stacked' behind 
text.

Keyboard shortcut:
Ctrl + =

See also:
 Send to back



Arrange menu: Bring to front
"Bring to front" moves a selected question, text bock or graphic element in front or 'on top' of other 
overlapping items.

To select an element to bring to the front of several that are overlapping, double-click successively with
the Pointer tool at the point of overlap to 'cycle' through each item in turn.

This command is used most frequently to quickly re-arrange or 'layer' sets of objects on a page.  
Layering can look particularly effective when colour-filled (i.e. opaque) objects are 'stacked' behind 
text.

Keyboard shortcut:
Ctrl + =

See also:
 Send to back



Edit menu: Send to back
"Send to back" pushes a selected question, text bock or graphic element 'behind' or 'to the bottom' of 
other overlapping items.

To select an element to send to the back of several that are overlapping, double-click successively with
the Pointer tool at the point of overlap to 'cycle' through each item in turn.

This command is used most frequently to quickly re-arrange or 'layer' sets of objects on a page.  
Layering can look particularly effective when colour-filled (i.e. opaque) objects are 'stacked' behind 
text.

Keyboard shortcut:
Ctrl + -

Tool Tidy :

 

See also:
 Bring to front



Arrange menu: Send to back
"Send to back" pushes a selected Question, text bock or graphic element 'behind' or 'to the bottom' of 
other overlapping items.

To select an element to send to the back of several that are overlapping, double-click successively with
the Pointer tool at the point of overlap to 'cycle' through each item in turn.

This command is used most frequently to quickly re-arrange or 'layer' sets of objects on a page.  
Layering can look particularly effective when colour-filled (i.e. opaque) objects are 'stacked' behind 
text.

Keyboard shortcut:
Ctrl + -

Tool Tidy button:

 

See also:
 Bring to front



Arrange menu: Group
"Group" combines a set of selected items. A group of elements can be cut, copied, pasted and re-sized
as one, and will move together when dragged. Two or more groups can be combined with further use 
of the "Group" command.

When a group is re-sized the border weights and type sizes originally assigned to grouped items will 
not be re-scaled. However each grouped element can be edited individually by double-clicking on it 
with the appropriate tool.

Note that the  "Copy Question" dialogue box will open when you copy/paste or Quick Copy (Ctrl-
drag) a group containing one or more questions/fields.

Keyboard shortcut:
Ctrl + G

See also:
 Ungroup
 Copy
 Paste



Arrange menu: Ungroup
"Ungroup" dissolves a group. You can then modify individual items without affecting the entire group. 
Use "Group" again to define your new set of elements.

Keyboard shortcut:
Ctrl + U

See also:
 Group



Edit menu: Links...
Choose the "Links..." command to display the name, type, location and status of all the linked 
elements in your current work area.

In the "Links" dialogue box you can
Update, change or cancel any link
Choose automatic or manual link updating of links. PinPoints' default update setting is 

"automatic".

See your Microsoft® Windows™ reference manual for current information on Object Linking and 
Embedding procedures.



Edit menu: Object
Choose this command to edit an object which has been embedded in your work.

Select the item to be amended.
Select the Edit menu.
Note that the wording of "Object" has now changed to identify the element you have selected.
In the case of an picture created in Windows Paintbrush, for example, the menu item will now 

read "Edit Paintbrush Picture Object".
Choose "Object" and the source application will open.
Edit the object as required and follow instructions to return to PinPoint. The embedded object will 

have changed to reflect the edits you have made.

Shortcut: Alt+double-click on the embedded object to be edited.

See your Microsoft® Windows™ reference manual for current information on Object Linking and 
Embedding procedures.



Arrange menu: Snap to grid
"Snap to grid" is a shortcut command which selects or clears the "Grid" dialogue's "Snap" option 
without opening the dialogue box.

When "Snap to grid" is checked (i.e. is in effect) the top left corner of an element's bounding box will 
automatically shift to the nearest grid point when the item is moved.

Note that a Question, line or rectangle created with"Snap" on will be sized to the nearest grid unit.

See also:
 Grid...
 Guidelines



Arrange menu: Show guidelines
The "Show guidelines" command hides or displays two pairs of on-screen design guidelines. The 
guidelines are displayed when the command is checked.

Guideline snap
When the guidelines are displayed and "Snap to grid" is off, an object moved close to either guideline 
will 'snap' to it. When "Snap to grid" is turned on the guidelines lose their 'magnetic' effect.

Positioning guidelines
Click on a guideline to select it, then drag it into position. If the on-screen rulers are displayed, the 
distance between the two guidelines in the same plane will be indicated in the ruler highlight areas as 
the guideline is being dragged.

Grid "Snap" also works on the guidelines. When "Snap" is on the guidelines will move in grid unit steps
when dragged.

Guidelines are part of PinPoint's suite of on-screen design guides. Judicious use of these aids will let 
you resize and position objects on your page with precision.

See also:
 Grid...
 Snap to grid
 Horizontal ruler
 Vertical ruler



View menu: Horizontal ruler
The "Horizontal ruler" command hides or displays the on-screen horizontal ruler. The ruler is displayed 
when the command is checked.

Ruler highlight areas
On-screen rulers are part of PinPoint's suite of page layout guides. Each ruler incorporates highlight 
areas which allow you to resize and position objects with precision.

Note: The rulers' unit of measure will correspond to the units specified in the "Grid" dialogue box. 
Choose the View menu "Grid..." command to open the box.

See also:
 Vertical ruler
 Grid...



View menu: Vertical ruler
The "Vertical ruler" command hides or displays the on-screen horizontal ruler. The ruler is displayed 
when the command is checked.

Ruler highlight areas
On-screen rulers are part of PinPoint's suite of page layout guides. Each ruler incorporates highlight 
areas which allow you to resize and position objects with precision.

Note: The rulers' unit of measure will correspond to the units specified in the "Grid" dialogue box. 
Choose the View menu "Grid..." command to open the box.

See also:
 Horizontal ruler
 Grid...



View menu: Grid...
Choose "Grid..." to hide or display an on-screen design guide of evenly spaced horizontal and vertical 
lines.

In the  "Grid" dialogue box you can choose to
Specify grid units and divisions in inches or centimetres, or in feint rules based on a specific font. 

Choose "Feint rules" to open the "Font" dialogue box.
Hide or show the on-screen grid.
Attribute a colour to the on-screen grid.
Turn on grid snap. When "Snap" is checked the top left corner of an element's bounding box will 

automatically shift to the nearest grid point when the item is moved.

See also:
 Snap to grid
 Guidelines
 Horizontal ruler
 Vertical ruler



View menu: Show printable area
Choose "Show printable area" to hide or display an on-screen design guide which shows the page 
margins beyond which your currently selected printer cannot print.

The 'non-printable' page border is displayed when the menu command is checked.

See also:
 Zoom...



View menu: Zoom...
Click "Zoom..." to scale the displayed view of a page within a document window.

In the  "Zoom" dialogue box you can choose to
Display a page at a fixed percentage of actual size.
Specify a "Custom" viewing scale.
Scale your work to the maximum possible full-page view with "Fit window".

Three "Zoom" options - Zoom 100% Zoom Fit Window and Zoom Fit Sideways - are duplicated in the 
Tool Tidy.

Tool Tidy buttons:



View menu: Font...
Choose this command to change the attributes assigned to display answer sheet text in a Worksheet 
window. The standard Font Style dialogue will appear; choose the font, size, style and colour you 
require and then choose "OK".

See also:
 Worksheet configuration



View menu: Put back
"Put back" appears in the Analysis Worksheets View menu.

Choose this command to 'put back' a Question which you have earlier removed (i.e. dragged to the 
Worksheet control panel) from a worksheet. Click "Put back" to open a list of available questions. 
Choose a question's title to put it back.

Shortcut: Click the right mouse button anywhere in the Worksheet's questions title bar to open the list.

Note that the command will be shown 'greyed' if there are no questions available to be put back.

See also:
 Removing questions



Paper menu: Paper setup...
New presentations are displayed on a single page of the size and orientation as described by the 
active printer. The active printer is the printer described as the Default Printer in Control Panel or the 
printer most recently selected in the current session with PinPoint using the Printer Setup command.

You may change any of these attributes at any time. Choose the "Paper setup..." command and 
specify your page formatting choices from the many options available in the  "Paper setup" dialogue 
box.

See also:
 Add page
 Delete last page



Paper menu: Add page
Choose "Add page" to append another page to your paper. Pages are laid out vertically on screen, 
with a horizontal line drawn between them to denote a 'page break'. 

Moving between pages
With the mouse, the vertical scroll bar can be used to scroll up and down through the pages. You may 
also use your keyboard's UP and DOWN cursor and PAGE UP and PAGE DOWN keys to move 
between pages.

Page layout
It is often important (and it is usually preferable) that page layout remains consistent throughout a 
multi-page presentation. Use a combination of PinPoint's design guides, 'Zoomed' views and 
copy/paste functions to achieve this.

See also:
 Delete last page



Paper menu: Delete last page
Choose "Delete last page" to remove the last page appended to the presentation.

Note that a deleted page and its contents can be retrieved by choosing "Add page" again at any time 
until you next save your presentation. The next use of "Save" will delete the page and its contents 
entirely.

See also:
 Add page



Sheet menu: Save
Choose "Save" from a Sheet Editor window to save the answer sheet you are currently completing or 
editing.

Saving an edited sheet
If the sheet you are working on has been saved previously, choose "Save" to re-save it together with 
any amendments you have made. The edited sheet will remain on display.

Saving a new sheet
Choose "Save" to append a newly-completed answer sheet to the project's stack as the  next-
numbered sheet. PinPoint will then 'tear off' another blank form and display it ready for completion.

Note: The "Save" command and its shortcuts make for very rapid compilation of data into a stack of 
answer sheets.

Keyboard shortcut:
Ctrl + S
Or press RETURN at the last field in the form

Tool Tidy button:

 

See also:
 New



Sheet menu: New
Choose "New" from a Sheet Editor window to 'tear off' and display a blank form ready for completion.

The new sheet will appear entitled:

"New answer sheet: [unique  reference number] for [current project].ppf".
When you save the completed sheet PinPoint will append it to your project's stack.
Note that if you choose to search for, or turn back to, other sheets before saving a completed or part-
completed new answer sheet, PinPoint will prompt you to save or abandon your new sheet.

Tool Tidy button:

 

See also:
 Save



Sheet menu: Copy
PinPoint's "Copy" command provides a shortcut to the repeated entry of information into answer 
sheets whose data is essentially the same.

To copy answer sheet data
Locate and display the 'source' sheet (i.e. the answer sheet to copy data from) and choose 

"Copy".
PinPoint will copy all the data from the source sheet into a new answer sheet.
The new sheet which will then be displayed and allocated an unique 

 reference number.
Edit the new sheet's answer data as required.

When you "Save" the new sheet, PinPoint will append it to the current stack.

See also:
 Save



Sheet menu: Delete
Choose "Delete" to delete the answer sheet currently on display in a Sheet editor window. PinPoint will
prompt you to confirm your choice.

If you choose "Yes", PinPoint will delete the sheet and display the next sheet in the current stack. If the
sheet which you deleted was the last in the stack, then the previous sheet will be displayed.

When every sheet in a project's stack has been deleted a blank form will be displayed ready for 
completion.

Note that even if its 'owner' sheet is deleted, the unique  reference number allocated to an answer 
sheet when it is first saved will no longer be available for re-allocation.

Tool Tidy button:

 



Sheet menu: Next
Choose "Next" to turn to the next sheet of a stack on display in a Sheet Editor window.

Keyboard shortcut:
Ctrl + N

Tool Tidy button:

 

See also:
 Previous
 First
 Last
 Turn to...
 Search...



Sheet menu: Previous
Choose "Previous" to turn to the previous sheet of a stack on display in a Sheet Editor window.

Keyboard shortcut:
Ctrl + P

Tool Tidy button:

 

See also:
 Next
 First
 Last
 Turn to...
 Search...



Sheet menu: First
Choose "First" to turn to the first sheet of a stack on display in a Sheet Editor window.

Keyboard shortcut:
Ctrl + F

See also:
 Last
 Next
 Previous
 Turn to...
 Search...



Sheet menu: Last
Choose "Last" to turn to the last sheet of a stack on display in a Sheet Editor window.

Keyboard shortcut:
Ctrl + L

See also:
 First
 Next
 Previous
 Turn to...
 Search...



Sheet menu: Turn to...
Choose "Turn to..." to go directly by  sheet number to a specific answer sheet in a project's stack. 
Click the command, type the sheet number at the dialogue box cursor and press RETURN.

Note that PinPoint numbers answer sheets sequentially as each is completed and saved. To use this 
command you must know the number of the sheet you wish to turn to. Alternatively choose "Search..." to 
locate a sheet by text, number or date answer.

See also:
 Search...



Sheet menu: Search...
Choose "Search..." to locate an answer sheet from a stack for review or amendment. Click the 
command to open the  "Search" dialogue box, then select

any text    OR
any number only    OR
any date only

as the answer type to search on. Type the value to be searched for at the cursor position and then 
choose "Find first" or press RETURN.

PinPoint will search the stack from the first sheet and will display the first match found. Click "Find 
next" or press RETURN repeatedly until you find the sheet you want to review.

Searches on text will find words which match your search word both in whole and in part. The wild-
card character    #    may also be used to extend the range of possible matches.

Note: Use "Search..." only to locate single sheets. This command is not intended to be used as a 
substitute for PinPoint's analysis worksheets.

Tool Tidy button:

 

See also:
 Turn to...



View Menu: Worksheet/Sheet menu: Analyse sheets
Choose either of these options to place the currently displayed stack of answer sheets onto the 
analysis worksheet for the project.

If the sheets have been analysed before (you may, for example, have been adding new sheets to 
the stack), then the project's worksheet will open with its previously-saved sort and selection attributes 
intact.

Choose the Tools menu "Remove selection conditions and sorting" command if you wish to view all the
sheets.

If the sheets have not been analysed previously then they will all be placed into the worksheet and 
displayed in order of  sheet number.

Tool Tidy button:

 

See also:
 Analysis worksheets



View menu: Form
Choose "Form" to return a project's form to the Form Editor for review and amendment.

Significant changes
If a form is to be edited substantially, that is if

Any questions/fields are deleted
Or any new questions/fields are added
Or the order of questions on the page is changed
Or the answer type of questions is changed
Or new choices are added to choice type questions

then the existing answer sheets in the project's stack may need to be updated. For this reason, you 
are recommended to take a backup copy of the project before making such changes.

Save changes and update sheets?
When you have completed your alterations to the form click the  Stack tool to return to the Sheet 
Editor window. 

PinPoint will prompt you to save your changes, and will ask you to confirm, twice, that you wish to  
update all the sheets in the current stack.

If you choose "Yes" then all the completed sheets will be updated accordingly. The information currently 
held in the sheets will be preserved wherever possible.
Note that if you have opened the Sheet Editor from a worksheet, PinPoint will prompt you to confirm that 
the worksheet may be closed before the form is changed.

Tool Tidy button:

 

See also:
 Save



Tools menu: Sort sheets...
When you first place a project's stack into a worksheet, its answer sheets are displayed in the order in 
which they were entered.

To sort the sheets
Click "Sort sheets..." to open the  "Sort sheets" dialogue box. Select a question on which to sort the 
sheets, in increasing or decreasing order, and choose "OK". The worksheet will be re-displayed with 
the answer sheets sorted as required.

To re-sort the sheets
Choose "Sort sheets..." again and proceed as described above.

To add a sort
To perform a further sort on previously sorted answer sheets, click "Sort sheets..." again. Proceed as 
described above, but this time select "Within current order". Choose "OK" to perform the sort.

Note that your chosen sort criteria will be saved in the project file only when you choose  "Save" from
the Analysis Worksheets File Menu.

Worksheet control panel:

Tool Tidy button:

 

See also:
 Remove selection conditions and sorting
 Sorting - Overview



Tools menu: Add condition...
When performing an analysis of answer sheet data in PinPoint's worksheets, conditions for choosing 
sheets may be entered sequentially or in one operation. As each set of conditions is made the 
matching answer sheets are displayed in the worksheet.

To apply conditions
Choose "Add condition...". to open the  "Choose sheets" dialogue box. In it you

Choose a Question by which to choose the sheets
Choose your required criterion
Select or type in appropriate criterion values
Specify whether to include or to exclude those answer sheets matching your chosen criterion.
Apply a new criterion to all sheets, or to only those matching previous criteria (i.e. those which are

currently on display).

Choose "OK" and the display will be updated to show only those answer sheets which match the 
criterion. A description of the criteria will be shown in the Worksheet control panel.

To add further criteria
Choose "Add condition..." again, select a further criteria and proceed as described above.

Worksheet control panel:

Tool Tidy button:

 

See also:
 Choosing and selecting sheets - Overview
 Selecting Individual Sheets
 Remove selection conditions and sorting



Tools menu: Remove conditions and sorting
Choose "Remove conditions and sorting" to remove all match conditions and sorting previously 
applied to a stack of answer sheets.

Use this command to re-display all the answer sheets in a project's stack in the order in which they 
were entered. 

Note that your previously-chosen sort and criteria will remain in the project file until you  save your 
worksheet's new attributes.

Hint: Use the Worksheet control panel buttons to remove only the last sort performed or the last match 
condition applied.

Tool Tidy button:

 



Tools menu: Statistics...
From within PinPoint's worksheets you can perform a number of standard statistical calculations upon 
the answers to numeric questions.

Choose "Statistics..." to open the  "Statistics" dialogue box. Select
One or more numeric questions upon which to perform the calculation(s).
Only those answer sheets currently displayed in the worksheet, or all the answer sheets in the 

current stack, or both sets, for inclusion in the analysis.
The statistical calculation(s) to be performed.

Choose "OK". The title "Statistics" will appear at the left end of the Question title bar. A window will 
open, between the Worksheet control panel and the first answer sheet row, in which the results of your
calculations will be displayed.

Hint: To modify or perform further statistical calculations, click on the "Statistics" column title to re-
open the "Statistics" dialogue box.

Tool Tidy button:

 



Tools menu: Add new column...
Choose "Add new column..." to add a new column to a worksheet.

Calculations can be performed on the answer sheets by writing a suitable question on the form. 
However, this may not be desirable if calculations are only required for analysis purposes - you may 
not wish to occupy valuable space on the form with information not actually required when viewing the 
individual sheets. Instead, calculations may be performed on the worksheet.

A calculation may use any answers from the answer sheet (except those from ordered choice, ranked, 
answers) and the results of other calculations on the worksheet. The calculation is performed for each 
answer sheet and the results shown in a new column on the worksheet.

Click the command to open the  New Column" dialogue box and
Type in your new column's unique reference name
Select the name of the question(s) to include.
Type in digits and arithmetical symbols, or use the calculator pad.
Select "Display style" to open the style dialogue box for the type of answer to the calculation.

Format your answer and choose "OK".

Modifying a Calculated Column

To edit a new column's reference name or calculation, double click on its column title to re-open the 
"New column" dialogue box.

Tool Tidy button:

 



Tools menu: Plot graph...
Choose "Plot graph..." to produce a graph from a stack's answer sheet data.

Click the command to open the  "Plot graph" dialogue. 
From there layers of interactive dialogue boxes will guide you step-by-step through the production of even
the most complex graphical presentation.

Tool Tidy button:

 

See also:
 Graphics Presentation: How to...



Tools menu: Generate crosstabs...
Choose "Generate cross-tabs..." to produce a cross-tabulation from a stack's answer sheet data.

Click the command to open the  "Cross tabulations" dialogue.

Tool Tidy button:

 

See also:
 Graphics Presentation: How to...



Tools menu: Plot Graph from Question Table
Choose this command to plot a graph of the responses in any Question Tables on your Form.

Click the command to open the  "Plot Graph From Table of Questions" dialogue.

Tool Tidy button:

 

See also:
 Graphics Presentation: How to...



Tools menu: Quick Analysis
Choose this command to undertake a quick analysis of the responses to all, or a large number of, 
questions before undertaking an in-depth analysis. 
Click the command to open the  "Quick Graphs" dialogue.

Tool Tidy button:

 



Tools menu: Load/Save Setups
Choose this command to open the  Load/Save Setups palette. 

This allows you to save and load different Worksheet configurations. If you have set up a sort or choosing
sheet criteria, you can also save these. The configurations are independent of the current Worksheet, and
can therefore be applied to any Worksheet which is opened.

Tool Tidy button:

 

Note: The Load/Save Setups Palette stays in the Worksheet foreground, and can be removed by 
clicking the Load/Save Setups button in the Tool Tidy again, or, by re-selecting Load/Save Setups from
the Tools menu.



Window menu: Tile
The number and type of document windows that you can have open or minimised to icons in 
PinPoint's application window is limited only by your computer's memory. To arrange windows and 
icons so that you can see them all, choose

"Tile" to scale open windows to fit next to each other    OR
"Cascade" to cause open windows to overlap so that each of their title bars is visible    AND
"Arrange Icons" to line up all icons along the lower edge of the desktop.

Hint: You can navigate quickly around a crowded application window from the keyboard. Press and 
hold down CTRL, then press TAB repeatedly to 'cycle' through each open document window and icon 
in turn.

See also:
 Work in progress



Window menu: Cascade
The number and type of document windows that you can have open or minimised to icons in 
PinPoint's application window is limited only by your computer's memory. To arrange windows and 
icons so that you can see them all, choose

"Tile" to scale open windows to fit next to each other    OR
"Cascade" to cause open windows to overlap so that each of their title bars is visible    AND
"Arrange Icons" to line up all icons along the lower edge of the desktop.

Hint: You can navigate quickly around a crowded application window from the keyboard. Press and 
hold down CTRL, then press TAB repeatedly to 'cycle' through each open document window and icon 
in turn.

See also:
 Work in progress



Window menu: Arrange Icons
The number and type of document windows that you can have open or minimised to icons in 
PinPoint's application window is limited only by your computer's memory. To arrange windows and 
icons so that you can see them all, choose

"Tile" to scale open windows to fit next to each other    OR
"Cascade" to cause open windows to overlap so that each of their title bars is visible    AND
"Arrange Icons" to line up all icons along the lower edge of the workplace.

Hint: You can navigate quickly around a crowded application window from the keyboard. Press and 
hold down CTRL, then press TAB repeatedly to 'cycle' through each open document window and icon 
in turn.

See also:
 Work in progress



Window menu: Close All
Choose "Close All" to close all open and minimised document windows. PinPoint will prompt you to 
save or abandon your work before closing a window.



Window menu: Work in progress
The titles of up to nine open or minimised document windows will appear in the "Work in progress" list 
under the Window menu. Click on a window's title to switch to it directly.

"More Windows..." appears if more than nine windows are open or minimised. Chose this command to 
open the "Select Window" dialogue box. Choose a window title to switch to from the list, then click 
"Ok".



File menu: Delete this Presentation
Choose "Delete this Presentation" from the File menu to remove a previously saved graphics 
presentation from a project. Open the presentation you wish to remove (choose "Open presentation..." 
from the File menu), and then choose "Delete this Presentation".

PinPoint will ask you to confirm or cancel your action. Choose "Yes" and the presentation will be 
removed from your project.

Note that you can "Save" a deleted presentation again (under the same or a different name) while its 
Presentation Editor window remains open. A deleted presentation is no longer recoverable once its 
window has been closed.



View Menu: Answer Sheets
Choose "Answer Sheets" to switch your view of your project to the individual answer sheets.

From a Worksheet window
The first sheet of the stack will be displayed, and the Worksheet will be closed.

From a Form Editor window
If you have been working on a new form a Sheet Editor will open onto the first (blank) sheet of a 

new stack    OR
If you have been working on the form of a project already containing answer sheets, a Sheet 

Editor will open onto the first sheet of the existing stack.

Significant changes
If a form has been edited substantially, that is if

Any questions/fields are deleted
Or any new questions/fields are added
Or the order of questions on the page is changed
Or the answer type of questions is changed
Or new choices are added to choice type questions

then the existing answer sheets in the project's stack may need to be updated.

Save changes and update sheets?

PinPoint will prompt you to save your changes, and will ask you to confirm, twice, that you wish 
to  update all the sheets in the current stack.

If you choose "Yes" then all the completed sheets will be updated accordingly. The information currently 
held in the sheets will be preserved wherever possible.

See also:
 Save



View Menu: Show Printable Area
Use this command before attempting to print the worksheet to check that the print will fit on the paper 
loaded in your active printer - the area of the worksheet beyond the width of the paper will be given a 
grey background. If there are columns that will not fit on the paper, you have several choices:

Use a different or smaller font. From the View menu, choose 
 Font and choose a new font or size from the Font dialogue.

Reduce the 
 width of the columns on the worksheet.

If your printer is able, select a different, wider, orientation of the paper in the printer. From the File 
menu, choose Printer Setup.

Select a printer that uses wider paper. From the File menu, choose Printer Setup.
Remove some of the 

 columns on the worksheet.

Note: The display of the printable area is approximate, especially if you are using a font which is not 
available on the active printer. In such cases, the closest matching font available on the printer is used 
but this may vary in size slightly from the font used on screen.

See also:
 Worksheet configuration



Analysis Worksheets: Edit Menu
The edit menu provides commands to delete many sheets in a single operation or to copy data to the 
Windows clipboard - copying data to the clipboard for transfer to another application can be quicker than 
saving the data to a file.
Answer sheets are copied to the clipboard in both Comma Separated Value (CSV) and Tab Separated 
Value (to a word processor, plain text) formats. Most word processors and spreadsheets are able to 
recognise these formats and paste the information from the clipboard intelligently.

1. Select the  individual sheets to copy or delete.
2. If only some of the answers are to be copied either:

Remove the columns for those answers which are not to be copied from the worksheet.
- or-

Choose the answers to be copied by selecting the required column titles by clicking on the 
column titles.
3. Choose:

Copy to copy the selected sheets and answers to the clipboard.

Cut to copy the selected sheets and answers to the clipboard and then deleted the selected 
sheets from the project.

Delete to delete the selected sheets from the project.

Deleting sheets cannot be undone - you will be given a single warning. 



Questionnaire Menu: Make Question Group

Use this command to group together a number of questions, such as 'Name and Address' or 
'Insurance Claim Details', which belong in the same category.    The resulting Question Group has the 
following features:

The questions are kept together on the Form and are grouped within a box.
All the questions in that group are asked before any other questions.
In the Worksheet view, all the questions in the Group are kept together.
The Group can contain some introductory text such as an explanation or heading.

To group the questions together use Shift clicking to select those you wish to include, then click the 
"Make a Question Group" command to open the  "Make Question Group" dialogue.

Note: Question Groups can be edited by choosing the  "Advanced..." option in the "Question Details" 
dialogue.



Questionnaire Menu: Number Questions
Choose "Number Questions" to automatically number all the questions on your Form.    PinPoint provides 
a variety of numbering schemes and styles of presentation for you choose from.
You may number or renumber questions at any time after they have been written.    It is often best to 
automatically number questions after they have all been written but before you make the final adjustments
to the presentation of the Form.
Questions which are in groups or tables may be numbered as part of the overall numbering sequence or 
within their own sequence.

To number the questions on your Form automatically, click on the "Number Questions" command to 
open the  "Number Questions" dialogue.

Note: Questions are not numbered automatically as they are written and are not automatically 
renumbered if they are moved around the form.



Questionnaire Menu: Show Routing
Use this command to display any routes which have been set up on the Form.    The routing is shown 
by coloured lines and a small circle is displayed at the destination.    There are four kinds of lines that 
correspond to the four types of routing:

Ask for answer if routing is shown by a blue dotted line.
Always goto question is shown by a solid green line.
Goto question(s) depending on answer(s) is shown by a solid blue line.
Ask no more questions is shown by a solid red line.



Sheet Menu: Show Routing
Use this command to test any routing you have defined - all possible routes which have been set up 
on the Form will be shown. The routing is shown by coloured lines and a small circle is displayed at the
destination. There are four kinds of lines that correspond to the four types of routing:

Ask for answer if - routing is shown by a blue dotted line.

Always goto question - is shown by a solid green line.

Goto question(s) depending on answer(s) - is shown by a solid blue line.

Ask no more questions - is shown by a solid red line.



Questionnaire menu: Paper setup...
A new form is created as a single page of the size and orientation as described by the active printer. 
The active printer is the printer described as the Default Printer in Control Panel or the printer most 
recently selected in the current session with PinPoint using the Printer Setup command.

You may change any of these attributes at any time. Choose the "Paper setup..." command and 
specify your page formatting choices from the many options available in the  "Paper setup" dialogue 
box.

See also:
 Add page
 Delete last page



 Questionnaire menu: Add page
Choose "Add page" to append another page to your form. Pages are laid out vertically on screen, with 
a horizontal line drawn between them to denote a 'page break'. 

Moving between pages
With the mouse, the vertical scroll bar can be used to scroll up and down through the pages. You may 
also use your keyboard's UP and DOWN cursor and PAGE UP and PAGE DOWN keys to move 
between pages.

Page layout
It is often important (and it is usually preferable) that page layout remains consistent throughout a 
multi-page form. Use a combination of PinPoint's design guides, 'Zoomed' views and copy/paste 
functions to achieve this.

See also:
 Delete last page



Questionnaire menu: Delete last page
Choose "Delete last page" to remove the last page that you appended to your paper.

Note that a deleted page and its contents can be retrieved by choosing "Add page" again at any time 
until you next save your form. The next use of "Save" will delete the page and its contents entirely.

See also:
 Add page




